Dragon NaturallySpeaking 13 Installation Guide and User Guide

For the latest Bluetooth microphone guide, please see the Nuance website.
Copyright


Dragon NaturallySpeaking 13.

This material may not include some last-minute technical changes and/or revisions to the software. Changes are periodically made to the information described here. Future versions of this material will incorporate these changes.

Nuance Communications, Inc. may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to such patents.

No part of this material or software may be reproduced in any form or by any means, including, without limitation, electronic or mechanical, such as photocopying or recording, or by any information storage and retrieval systems, without the express written consent of Nuance Communications, Inc. Specifications are subject to change without notice.

Copyright © 2014 Nuance Communications, Inc. All rights reserved.

Nuance, the Nuance logo, ScanSoft, Dragon, DragonBar, the Dragon logo, NaturallySpeaking, RealSpeak, Nothing But Speech (NBS), Natural Language Technology, Full Text Control, BestMatch, MouseGrid, and Vocabulary Editor are registered trademarks or trademarks of Nuance Communications, Inc. All other names and trademarks referenced herein are trademarks of Nuance Communications, Inc., or their respective owners. Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks, including the following:

Pentium is a registered trademark of Intel Corporation.

Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.

Corel and WordPerfect are registered trademarks of Corel Corporation.

Lotus and Lotus Notes are registered trademarks of Lotus Development Corporation.


Mozilla, Mozilla Firefox, and Mozilla Thunderbird are trademarks or registered trademarks of the Mozilla Foundation.

Google, Google+, Google Chrome, and Gmail are trademarks of Google, Inc.

VoiceIt, the VoiceIt logo, and VoiceIt Link are trademarks or registered trademarks of VXI Corporation.

AMD is a trademark of Advanced Micro Devices, Inc.

SoundBlaster is a registered trademark of Creative Technology Ltd.
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above license grant, this restriction and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative works of the Software, unless such copies or derivative works are solely in the form of machine-executable object code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Open Source Initiative OSI - The MIT License (MIT): Licensing
The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Open Source Initiative OSI - The BSD 3-Clause License. © Copyright 1998, Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the University of California, Berkeley nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Dave Barry in Cyberspace, © Copyright 1996 by Dave Barry. Published by Crown Publishers.


To Be a Man, © Copyright 1997 by Eugene and Miranda Pool.

The Captain of Battery Park, © Copyright 1978 by Eugene Pool. Published by Addison-Wesley.

QR code is trademarked by Denso Wave, inc.


Reed-Solomon code encoder - Copyright (C) 2002, 2003, 2004, 2006 Phil Karn, KA9Q.

Copyright © 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

TweetSharp

Copyright (c) 2009-2013 Daniel Crenna, Jason Diller, and contributors

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
## Contents

**Copyright** .................................................................................................................. ii

**Chapter 1: What's New in Dragon Version 13** ................................................................. 14
  - Web experience ............................................................................................................. 14
  - Enhancing Accuracy ..................................................................................................... 14
  - Compatibility Alerts ..................................................................................................... 14
  - New DragonBar ............................................................................................................ 15
  - Learning Center ........................................................................................................... 15
  - Interactive Tutorial enhancements ............................................................................. 15
  - Shorter Profile Creation Process ................................................................................ 15
  - Simplified Audio Setup ............................................................................................... 16
  - Open-ended custom commands (Professional and Legal editions only) .................. 16
  - Always replaces Ask Me as the default for deferred correction (Professional and Legal editions only) .................................................................................................................. 16
  - Operating System support ......................................................................................... 16

**Chapter 2: Installing Dragon** ......................................................................................... 17
  - Installation and User Profile Creation ....................................................................... 17
  - Dragon system requirements ...................................................................................... 18
  - What you should know before installing .................................................................... 18
  - Installing Dragon to a custom location ...................................................................... 18
  - Installation Prerequisites ............................................................................................ 19
  - Installing Software - Typical Installation .................................................................. 20
  - Installing Software - Custom Installation ................................................................... 21
  - Modifying application settings for all users .............................................................. 23
  - Modifying formatting options for all users .................................................................. 24
  - Creating your user profile .......................................................................................... 25
  - Setting up, positioning, and checking your microphone ........................................... 27
  - Training a user profile ............................................................................................... 27
  - Upgrading User Profiles ............................................................................................. 28
  - Default installation folders .......................................................................................... 30
  - Activating Dragon NaturallySpeaking ......................................................................... 31

**Chapter 3: Getting Started** ............................................................................................ 33
  - Welcome to Dragon NaturallySpeaking ....................................................................... 34
  - Working with Windows 8 and Windows 8.1 ................................................................ 36
  - About Dragon NaturallySpeaking ............................................................................... 39
  - How Dragon works ...................................................................................................... 40
  - Activating Dragon NaturallySpeaking ......................................................................... 41
  - Dragon system requirements ...................................................................................... 42
Chapter 4: Using the New DragonBar or Classic DragonBar ............................................. 53
  The DragonBar ..................................................... 53
  The Text Control Indicator ................................. 59
  Displaying the DragonBar ...................................... 60
  Working with the New DragonBar or Classic DragonBar .............................................. 63

Chapter 5: Using the Microphone ......................................................................................... 67
  Choose an audio device ........................................ 67
  Position your microphone properly ..................... 68

Chapter 6: Using the Dragon Learning Center .................................................................. 71
  Using the Dragon NaturallySpeaking Learning Center ...................................................... 71
  The Dragon NaturallySpeaking Learning Center ............................................................... 74

Chapter 7: Dictating Text ..................................................................................................... 77
  Dictation Basics ..................................................... 77
  Undoing actions ..................................................... 78
  Correcting text errors as you dictate ..................... 79
  Dictation commands ............................................. 80
  Typing or spelling text ........................................ 81
  Spelling words ..................................................... 82
  Dictating numbers ............................................... 84

Chapter 8: Using the Dictation Box ....................................................................................... 88
  Using the Dictation Box ........................................ 88
  Dictation Box Settings ........................................... 91

Chapter 9: Using DragonPad ............................................................................................... 94
  About DragonPad .................................................. 94
  Changing the way text wraps on your screen .......... 94

Chapter 10: Making Corrections ............................................................................................ 96
  Correcting dictation - workflow ........................... 96
  Correcting text - quick reference ......................... 100
  Choosing the correct text ..................................... 101
  Correcting misrecognized commands ................... 102

Chapter 11: Revising Text .................................................................................................... 104
Using Direct Editing commands ................................................................. 104
Handling multiple text matches ................................................................. 106
Revising text - quick reference ................................................................. 110

Chapter 12: Moving around in a document ........................................... 114
Moving the insertion point ........................................................................ 114
Moving to specific words .......................................................................... 117
Moving to the beginning or end of a document or line .......................... 117
Using "Go Back" to move the cursor ......................................................... 118

Selecting text .............................................................................................. 120
Selecting text - quick reference ............................................................... 120
Selecting characters and words ............................................................... 120
Selecting specific words or phrases ....................................................... 121
Selecting lines and paragraphs .............................................................. 122
Selecting text again .................................................................................. 123
Changing an incorrect text selection ....................................................... 123

Deleting, Cutting, and Copying Text ....................................................... 125
Cutting, copying, and pasting .................................................................. 125
Deleting dictated text .............................................................................. 125
Deleting characters, words, lines, or paragraphs .................................. 126
Deleting by backspacing ......................................................................... 126

Formatting .................................................................................................. 128
Formatting text .......................................................................................... 128
Formatting numbers .................................................................................. 130
Setting font name, size, and style .......................................................... 131
Aligning text .............................................................................................. 131
Adding new lines and paragraphs .......................................................... 132
Hyphenating words ................................................................................... 132
Joining words ............................................................................................ 132
Setting Auto-Formatting Options ............................................................ 133
Creating Word Properties ....................................................................... 133

Chapter 13: Working in Programs ............................................................. 138
Scrolling in popular programs ................................................................. 139
Using the ribbon interface in Microsoft applications ............................. 140

About spoken commands in word processing programs ...................... 142
About spoken commands in word processing programs ...................... 142
Dictating in your word processor ........................................................... 142

Working with Microsoft Word ................................................................. 144
Basic document commands in Microsoft Word ...................................... 144
Creating, opening, and closing a document ......................................... 144
Saving a document .................................................................................... 145
Selecting text ............................................................................................ 152
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting text in Microsoft Word</td>
<td>152</td>
</tr>
<tr>
<td>Email Programs</td>
<td>155</td>
</tr>
<tr>
<td>Supported e-mail programs</td>
<td>155</td>
</tr>
<tr>
<td>Working in e-mail programs</td>
<td>155</td>
</tr>
<tr>
<td>Commands for working with e-mail messages</td>
<td>156</td>
</tr>
<tr>
<td>Commands for moving around in e-mail</td>
<td>156</td>
</tr>
<tr>
<td>Dictating e-mail and Web addresses</td>
<td>157</td>
</tr>
<tr>
<td>Dictating E-mail and Calendar commands</td>
<td>158</td>
</tr>
<tr>
<td>Commands for Windows Live Mail</td>
<td>160</td>
</tr>
<tr>
<td>Microsoft Outlook</td>
<td>162</td>
</tr>
<tr>
<td>Working with Microsoft Outlook</td>
<td>162</td>
</tr>
<tr>
<td>Reading and sending e-mail with Microsoft Outlook</td>
<td>162</td>
</tr>
<tr>
<td>Making appointments in Microsoft Outlook</td>
<td>163</td>
</tr>
<tr>
<td>Adding contacts in Microsoft Outlook</td>
<td>164</td>
</tr>
<tr>
<td>Writing notes in Microsoft Outlook</td>
<td>165</td>
</tr>
<tr>
<td>Using other Microsoft Outlook commands</td>
<td>165</td>
</tr>
<tr>
<td>Dialog box commands</td>
<td>166</td>
</tr>
<tr>
<td>Moving around in a message window</td>
<td>166</td>
</tr>
<tr>
<td>Microsoft Outlook 2010 commands</td>
<td>167</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>168</td>
</tr>
<tr>
<td>Working with Microsoft Excel</td>
<td>168</td>
</tr>
<tr>
<td>Dictating in Microsoft Excel with Full Text Control</td>
<td>168</td>
</tr>
<tr>
<td>Basic commands for Microsoft Excel</td>
<td>169</td>
</tr>
<tr>
<td>Creating, opening, and closing a spreadsheet</td>
<td>170</td>
</tr>
<tr>
<td>Editing in a spreadsheet</td>
<td>170</td>
</tr>
<tr>
<td>Saving, renaming, and moving to another a spreadsheet</td>
<td>170</td>
</tr>
<tr>
<td>Setting up a spreadsheet</td>
<td>171</td>
</tr>
<tr>
<td>Viewing the spreadsheet</td>
<td>171</td>
</tr>
<tr>
<td>Printing</td>
<td>171</td>
</tr>
<tr>
<td>Moving around a spreadsheet</td>
<td>171</td>
</tr>
<tr>
<td>Switching between open spreadsheets</td>
<td>172</td>
</tr>
<tr>
<td>Formatting a Microsoft Excel spreadsheet</td>
<td>173</td>
</tr>
<tr>
<td>Working with cell contents in Microsoft Excel</td>
<td>173</td>
</tr>
<tr>
<td>Chapter 14: Working with Web applications</td>
<td>176</td>
</tr>
<tr>
<td>About the Dragon Web Extension</td>
<td>176</td>
</tr>
<tr>
<td>Browser requirements for the Dragon Web Extension</td>
<td>176</td>
</tr>
<tr>
<td>Installing and enabling the Dragon Web Extension</td>
<td>177</td>
</tr>
<tr>
<td>How to tell if the Dragon Web Extension is Enabled</td>
<td>182</td>
</tr>
<tr>
<td>Using Web-based Email</td>
<td>183</td>
</tr>
<tr>
<td>Editing text in a supported Web application</td>
<td>186</td>
</tr>
<tr>
<td>Using Dragon’s Web capabilities without the Dragon Web Extension</td>
<td>189</td>
</tr>
</tbody>
</table>
If you have problems using Web application support ............................................ 190

Chapter 15: Working with Web browsers ............................................................... 194
  Working with a Web browser ........................................................................... 194
  Searching the Web by voice ........................................................................... 195
  Web browser commands ............................................................................... 199
  Internet Explorer commands ......................................................................... 204

Chapter 16: Working on Your Desktop ................................................................. 208
  Starting and exiting programs ...................................................................... 208
  Using Windows Desktop commands ............................................................. 210
  Controlling menus ......................................................................................... 213
  Selecting buttons and dialog box options ..................................................... 213
  Selecting tabs in a dialog box ....................................................................... 214
  Resizing and closing windows ...................................................................... 214
  Selecting and opening icons ........................................................................ 215
  Scrolling in windows and lists ...................................................................... 215
  Searching your Desktop by voice .................................................................. 216
  Switching between programs and windows ................................................ 217

Chapter 17: Controlling the Mouse and Keyboard .............................................. 222
  Controlling the keyboard ............................................................................ 222
  Moving the mouse pointer .......................................................................... 224
  Move commands ......................................................................................... 224
  Optional move commands ........................................................................... 224
  Stopping mouse movement ......................................................................... 225
  Positioning the mouse pointer with MouseGrid ......................................... 225
  Clicking and dragging the mouse ............................................................... 226
  Clicking the mouse ..................................................................................... 227
  Dragging the mouse .................................................................................... 227
  Stopping mouse movement ........................................................................ 228

Chapter 18: Improving recognition accuracy ..................................................... 230
  Top 10 ways to improve accuracy ............................................................... 230
  Using Smart Format Rules .......................................................................... 232
  Adjusting Speed vs. Accuracy ..................................................................... 238

The Dragon Accuracy Center ........................................................................... 240
  Using the Accuracy Center ......................................................................... 240
  Running the Acoustic and Language Model Optimizer .................................. 240

Recognition Modes ......................................................................................... 243
  Using Recognition Modes .......................................................................... 243
  Switching recognition modes ..................................................................... 245

Teaching Dragon to Understand You Better .................................................... 247
  Training misrecognized commands ............................................................. 247
  Training individual words and phrases ......................................................... 248
Chapter 1: What's New in Dragon Version 13

Web experience

The Dragon Web extension now gives Full Text Control in Chrome and Firefox as well as in Internet Explorer, in most websites. In order to use Dragon in the supported browsers, you must enable this add-on.

There are some differences in functionality between browsers.

When you are in Internet Explorer, Firefox, or Chrome, see the Learning Center for commands you might want to say, as well as tips.

For more information, see Installing and enabling the Dragon Web Extension.

Enhancing Accuracy

In addition to higher out-of-the-box accuracy, Dragon 13 introduces enhancements to what you can do to increase your accuracy:

The Learn From Sent Email tool now also works with Web-based email such as Gmail and Yahoo Mail, so you have more potential sources from which to let Dragon familiarize itself with the words and phrases you might write.

The Vocabulary Editor now has a Search field and lets you search on more than just written forms. Also, it makes it easy to add a custom Dictation Command.

Note: the Word Properties dialog box (which is accessed through the Vocabulary Editor) now uses the term “printed form” instead of “alternate written form.”

For Canadian customers: when creating a profile, you can now pick Canada as your region so that Dragon’s vocabulary will contain spellings such as “honour” instead of “honor.”

Compatibility Alerts

If its add-in for a supported application (such as Microsoft Word) becomes disabled, Dragon now alerts you of this disconnection. (These add-ins enable Full Text Control; they are known as “compatibility modules.”)

This can be turned off on the Miscellaneous tab of the Options dialog.
For details, see The Options dialog box Miscellaneous tab.

**New DragonBar**

Dragon now includes a redesigned DragonBar. The New DragonBar can be dragged to a different location as well as expanded or collapsed by clicking on its left edge. To take up less space on your screen, it automatically collapses when you’re not using it. You can use its DragonBar menu to turn off the auto-collapse, if you wish, or to exit Dragon.

The DragonBar from version 12 is still available. If desired, you can easily switch between the New DragonBar and the Classic DragonBar.

For details, see The DragonBar.

**Learning Center**

The Learning Center is the new name of the Help menu item previously called the Dragon Sidebar (a narrow window listing commands and advice, so you can refer to it as you work). In Dragon 13, it has been redesigned and enhanced. It now contains panels you can open or close by clicking on their heading; the top panel, open by default, contains essential commands and advice.

By default, this window is set to Floating but in a shorter height, to cover less of any window that may be under it.

For important details on how to control the Learning Center and how to change its behavior and appearance (font size, docking, width, etc.), be sure to read Using the Dragon Learning Center.

**Interactive Tutorial enhancements**

The Interactive Tutorial has been redesigned and augmented. Its short, progressive simulations now also introduce the DragonBar, the Learning Center, the Vocabulary Editor, and important options, as well as basic Web navigation and use of Web-based email.

It is automatically presented at the end of the profile upgrade process as well as after a new profile is created.

Note: In the simulations that contain the punctuation “period” one can use the pronunciation “full stop” instead.

**Shorter Profile Creation Process**

For the first profile, the profile creation wizard simply assigns the profile a name rather than asking you to enter a name (if you want to rename the profile later, use the Manage Profiles dialog).

The step where Dragon proposed reading a text aloud is now omitted. (As before, you can read a training text after creating your profile; see “Read text to train Dragon to your voice” in the Accuracy Center.)

The step where Dragon offered to adapt its vocabulary based on documents and sent emails is now omitted, and you can launch the analysis of documents and emails once your profile is created.
Simplified Audio Setup

Dragon now detects audio devices better. In most cases, when Dragon presents the list of detected devices, you can just pick the device it shows as recommended and continue.

In addition, the Microphone Check is now just one screen and its text is easier to read.

Important: Using more than one input device is now done by picking Manage Dictation Sources on the DragonBar’s Profile menu. If you add multiple audio sources in your profile, you benefit from your profile’s refinements (such as changing an option, correcting an error, or analyzing emails to personalize the vocabulary) whenever you use Dragon, regardless of what audio device you’re speaking into (for instance, you could create your profile with a built-in microphone and later add a Bluetooth headset microphone as a source in that same profile). For details, see Using Multiple Dictation Sources with a Single User Profile.

Open-ended custom commands (Professional and Legal editions only)

In the Professional and Legal editions, Dragon now offers new flexibility for custom command types that support variable names: the ability to end the command’s name with any word or phrase in the vocabulary, as opposed to a word or phrase from a defined list of command variables.

This can allow users to have, for instance, commands that search for given words within their company’s intranet (similar to the built-in search commands like “search Wikipedia for…”). For details, see Creating open-ended custom commands.

Always replaces Ask Me as the default for deferred correction (Professional and Legal editions only)

The option to automatically create a recording (DRA file) along with your dictated document (available in the Professional and Legal editions only) is now set to Always, by default.

If you wish, you can change it to Never or Ask Me on the Data tab of the Options dialog. DRA files can be large, so once you no longer need them you may want to delete them.

For details, see Correcting dictation later.

Note: The option ‘Always preserve wave data’ has been removed from the Options dialog (it was on the Data tab, under Advanced).

Operating System support

Support for Windows 8 is enhanced. The New DragonBar can be used in both of Windows 8’s interfaces (the modern interface formerly known as Metro, as well as the desktop interface).
Chapter 2: Installing Dragon

This section contains the following topics:

- Installation and User Profile Creation ................................................................. 17
- Dragon system requirements ............................................................................... 18
- What you should know before installing .............................................................. 18
- Installing Dragon to a custom location ............................................................... 18
- Installation Prerequisites ..................................................................................... 19
- Installing Software - Typical Installation ............................................................ 20
- Installing Software - Custom Installation ............................................................ 21
- Modifying application settings for all users ......................................................... 23
- Modifying formatting options for all users ......................................................... 24
- Creating your user profile .................................................................................... 25
- Setting up, positioning, and checking your microphone ....................................... 27
- Training a user profile ........................................................................................ 27
- Upgrading User Profiles ..................................................................................... 28
- Default installation folders .................................................................................... 30
- Activating Dragon NaturallySpeaking ................................................................... 31

Installation and User Profile Creation

Introduction

This chapter presents how to install and set up Dragon, and then how to train Dragon to understand your voice.

The installation process checks to make sure your system meets the minimum system requirements needed for Dragon. These system requirements are listed in the information that came with your copy of Dragon. If your system does not meet these requirements, Dragon will not be installed.

Plugging in the microphone

To use Dragon, you will need to plug in your microphone.

If you are not sure how to plug in your microphone, consult the documentation that came with your microphone.
Note:
If you already have speakers for your computer, you can also use these to playback recorded speech instead of your headphones.

Dragon system requirements
The install process checks that your system meets the minimum requirements; if they are not met, Dragon NaturallySpeaking will not be installed.

Note:
Supports Microsoft Office 2010 & 2013. Does not support dictation directly into Electronic Medical Record (EMR) systems. For EMR support, please use Dragon Medical Edition.

- **CPU**: Minimum: 2.2 GHz Intel® dual core or equivalent AMD processor. Faster processors yield faster performance.
- **Free hard disk space**: 4GB
- **Supported Operating Systems**: Windows 7 32-bit and 64-bit; Windows 8 & 8.1, 32-bit and 64-bit; Windows Server 2008 R2; Windows Server 2012.
- **Internet Explorer** 9 or higher or the current version of Chrome or Firefox for Online Help.
- A sound card supporting 16-bit recording.
- A DVD-ROM drive for installation.
- A Nuance-approved microphone. See support.nuance.com/compatibility for more information.
- An Internet connection for automatic product activation (a quick anonymous process).

What you should know before installing

**Installing Dragon to a custom location**

The default installation directory for Dragon is:

C:\Program Files\Nuance\NaturallySpeaking13

During the installation procedure, you can choose to install Dragon to a different directory or drive on your machine.

Choosing a different directory during installation only installs the Dragon program files to that location.

Regardless of where you install the Dragon program files, Dragon always installs the languages and vocabularies that you selected during the installation to the C: drive, as well as
creating the location where user profiles will be created. These profiles can consume a large amount of disk space on your C: drive.

You can customize your installation to reduce the amount of disk space used on your C: drive by not installing unwanted languages and vocabularies. For more information, see Installing software — Custom Installation.

Upgrading the operating system to Windows 7 or Windows 8

If you upgrade a machine from a previous version of Windows to Windows 7 or Windows 8 and that machine has Version 11.x or 12.x of Dragon installed, that version of Dragon will not work after upgrading. All your user profiles from these previous versions remain intact and can be upgraded when you install Dragon Version 13.

Coexistence with other Dragon products
Coexistence with previous versions of Dragon

You can have only one version of Dragon installed on your system.

Note:
Running a previous version of Dragon concurrently with Version 13 is not supported.

Coexistence with the Dragon SDK Client Edition

You can install Dragon SDK Client Edition 13 on the same machine where Dragon 13 is installed. In addition, Dragon 13 and Dragon SDK Client Edition 13 can share user profiles and vocabularies.

You can only run one product at a time. For example, if you are running Dragon, you cannot run any of the SDK Client tools or samples.

Note:
Coexistence of Version 13 with Dragon SDK Client Edition Version 11.x, or 12.x is not supported.

Installation Prerequisites

Before installing the software (or modifying or upgrading it)

1. Close all open applications.
2. Turn off or disable antivirus software; the installation process can sometimes trigger a false virus report.

Note: You must have Administrator rights to install or uninstall Dragon on Windows 7 or Windows 8. Administrator rights are not required to create a Dragon user profile or use the software after installation.

On Windows 7 and Windows 8 systems, if as an administrator you want to create a Dragon user profile for a Windows limited user (user with restricted privileges), you must log on using that Windows limited user account before creating the Dragon profile.

If you create a Dragon profile for a limited Windows user while logged in as a Windows administrator, the limited user will not be able to access that Dragon profile. These
restrictions also apply to an upgrade installation.

3. Choose the type of installation to carry out.

Choose whether to install the entire product or only particular features of the product, as explained in the next section.

You can also carry out an MSI installation. Refer to the online Dragon System Administrator Guide PDF or Help file for details.

Choosing type of installation

When you install Dragon, you can either do a complete (typical) installation or a custom installation. Nuance recommends you do a complete installation unless you are experienced with the product. The table below tells more about each installation type.

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical/Complete</td>
<td>Installs all components (including all vocabularies and languages available in your edition of the software). Requires the maximum disk space.</td>
</tr>
<tr>
<td>Custom</td>
<td>Lets you select particular components to install (including, depending of your edition of Dragon, languages, vocabularies, and the Text-to-Speech function). Can greatly reduce the disk space required. During a custom installation, in the Professional and Medical editions, you can modify settings that are then applied to all user profiles created with this installation, including Windows limited account users.</td>
</tr>
</tbody>
</table>

Note

If you decide not to install some Dragon components by selecting Custom installation, you can install them later by running the Setup program again and choosing Modify.

If you are installing the product for multiple users, you should choose a Custom installation rather than a Typical/Complete installation. To carry out a custom installation, proceed to Installing software — Custom Installation. Otherwise, see Installing software — Typical Installation.

Installing Software - Typical Installation

To install all features of Dragon:

1. Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows Explorer to find and double-click setup.exe on the DVD.

2. After the Windows Installer begins, it installs:
   - Visual C++ Version 9.0 Runtime

3. After the Wizard begins, click Next to proceed to the License Agreement page. Read the text and select I accept the terms..., then click Next.
4. Enter your User Name and Organization, and the Serial Number supplied to your installation.

5. (Optional) When the Setup Type page appears, click the Change button and choose where to install the product.

If no earlier versions of Dragon are installed on your system, the default directory is:

C:\Program Files\Nuance\NaturallySpeaking13

For a list of directories created by installation, see Version 13 File Structure.

6. While you are still on the Setup Type page, select Typical.

7. Click Install to start the installation.

8. When prompted, click Finish to complete the installation. (If you are prompted to restart your computer, restart it now.)

9. Select Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking. The New DragonBar appears on your desktop.

10. (optional) If you have user profiles that you would like to upgrade before proceeding, see Upgrading User Profiles.

11. If you have no upgradable profiles, the Profile Creation wizard starts immediately after you run the product. Proceed to Creating your User Profile to set up a User Profile, continue as instructed.

You are now ready to create a User Profile, as explained under Creating your User Profile.

Installing Software - Custom Installation

To install portions of Dragon or to install it for multiple user profiles:

1. Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows Explorer to find and double-click setup.exe on the DVD.

2. After the Windows Installer begins, it installs:
   - Visual C++ Version 9.0 Runtime

3. After the Wizard begins, click Next to proceed to the License Agreement page. Read the text and select I accept the terms..., then click Next.

4. Enter your User Name and Organization, and the Serial Number supplied to your installation.

5. (Optional) When the Setup Type page appears, click the Change button and choose where to install the product.

If no earlier versions of Dragon are installed on your system, the default directory is:

C:\Program Files\Nuance\NaturallySpeaking13
For a list of directories created by installation, see Version 13 File Structure.

6. While you are still on the Setup Type page, select Custom for the type of installation.

![Custom]

Choose which program features you want installed and where they will be installed. Recommended for advanced users.

**Note:** If you decide not to install some Dragon components by selecting Custom installation, you can install them later by running the Setup program again and choosing Modify.

7. Click Next and you see a tree where you can select any particular feature of the product and click the down arrow to its left to choose where/when to install it:

- Install now, on local hard drive
- Install now, with all subfeatures on local hard drive
- Install when it is needed on a just-in-time basis

These options are particularly useful for installing multiple languages and/or multiple vocabularies.

Installing other languages, dialects, and specialized vocabularies To install user files for the other languages or dialects supplied with your edition, choose Custom on the Setup Type page. The user files for each language or dialect contain both spellings and pronunciations specific to that region. For example, users who wish to dictate US English spellings—including users with accents—should install the US (American) English user files.

8. Click Next again and, if you do not have the Professional edition, skip to the next step. Otherwise, choose any check boxes under Additional options to have additional dialog boxes pop up at the end of the installation, where you can make changes that affect all users dictating on this computer.

<table>
<thead>
<tr>
<th>Modify the application’s settings for all users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the <strong>Options</strong> dialog box at the end of the installation; here you set several options for all user profiles at once (see online Help for details). Useful for an installation in a shared area; for example, in a conference room or in an examining room where multiple healthcare professionals could dictate.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify the administrative settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the <strong>Administrative Settings</strong> dialog box at the end of the installation, where you set up the Roaming User feature, where to backup your files, and who can modify commands/vocabularies.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify the formatting options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays <strong>Auto-Formatting</strong> dialog box at end of installation, where you apply uniform formatting to all documents dictated at this installation; for example, formats for dates, times, and phone numbers. You also set whether to expand contractions, apply abbreviations, and insert commas automatically. See online Help for more details.</td>
</tr>
</tbody>
</table>

9. Click Next.
10. Click Install to start the installation.
11. When the installation completes, proceed with any of the following sections that apply to your custom installation:
   - Modifying application settings for all users
   - Modifying administrative settings
   - Modifying formatting options for all users
12. When you are prompted to register the product, select one of the registration options.
13. Click OK to register the product and click it again to proceed.
14. Check Yes, check for program updates after the setup completes to download any updates after the setup completes and click Finish to complete the installation.
15. If you chose to upgrade user profiles earlier, when the message about upgrading your user profiles pops up, click OK. (The message might tell you that the installation will not be complete until after your system is restarted.)
16. If you were told you need to reboot in order to complete the installation, reboot your computer now.
17. Select Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking. The New DragonBar appears on your desktop.
18. (optional) If you have user profiles that you would like to upgrade before proceeding, refer to Upgrading User Profiles. Otherwise, if you have no upgradable existing profiles, the Profile Creation wizard starts immediately and you can create a profile as explained in Creating your User Profile.

**Modifying application settings for all users**

If you checked off Modify the application’s settings for all users during a custom installation, the Options dialog box opens immediately after the installation completes.

Note

*If you did a typical installation, open the Options dialog box by opening Dragon and selecting Options from the DragonBar's Tools menu.*

In the Options dialog box, you see several tabs you can use to configure various aspects of the product:

For more information on each tab, see the online Help (start with the topic **The Options dialog box**).
Modifying administrative settings

Note

If you performed a typical installation, open the Administrative Settings dialog box by running Dragon without opening a profile and selecting Administrative Settings from the Tools menu.

In the Administrative Settings dialog box, you see the following tabs:

- Roaming—To set up roaming users.
- Miscellaneous—To create backup/distribution directories and control who can modify custom commands (or vocabularies).
- Scheduled Tasks—To schedule accuracy optimization and Data Collection (to improve future releases), and to let users modify the schedule of tasks.

For details, refer to the Help by clicking the Help button.

Modifying formatting options for all users

If you chose to modify formatting options on the Custom Setup page during a custom installation, the Auto-Formatting dialog box opens after the installation completes.

Note:

If you did not do a custom installation and you want to view or change the Auto-Formatting options: launch Dragon, open a user profile, and select Auto-Formatting Options from the Tools menu on the DragonBar.

The Auto-Formatting dialog box appears as shown below.
Chapter 2: Installing Dragon

For details about these options, click the Help button on this dialog box or see the Help topic *The Auto-Formatting dialog box*.

**Creating your user profile**

Each person who uses Dragon must have his or her own user profile.

Your user profile stores acoustic information about your voice that Dragon uses to recognize what you say. It also stores changes you make to the standard options and vocabulary—any special words, names, acronyms, and abbreviations you add.

When you launch the software for the first time, the Profile Creation wizard starts and leads you through creating your profile:
Note: If you upgraded a single profile from an earlier version, Dragon opens that profile. If you upgraded multiple profiles, it displays all upgraded profiles in the Open User Profile dialog box.

To create a user profile
Proceed through the wizard, filling in the information it requests and clicking Next to proceed.

Note:
The wizard asks for region of the world you live in to help Dragon transcribe your speech in accordance with regional differences.

Dragon lets you have profiles in multiple languages. If your edition supports more than one language, you can install additional languages by choosing *Custom* during the installation and having the Dragon DVD available to install the language files during the profile creation process.

Dragon automatically chooses a speech model to use as the foundation for your profile and a vocabulary it uses to recognize words based not only on their sound but also on their context. If you want to select a particular speech model and vocabulary, you can click the Advanced button.

When the Choose an audio device page appears, Dragon scans your system and presents a list from which you select your type of audio device. Next, Dragon has you position and check your microphone. When Dragon asks you to read a short text aloud so that it can check your audio input and make some adjustments, click the Start button and read the text as if you were dictating to the software (this takes about 30 seconds).
Setting up, positioning, and checking your microphone

Positioning the microphone correctly is important. If the microphone is out of place, Dragon might not be able to hear you clearly and make mistakes.

Consistent positioning is also important. Make sure that you position the microphone the same way each time you dictate.

Here are some tips on using particular types of microphones:

Using a headset microphone

- Position the microphone about a half-inch (approximately the width of your thumb) from your mouth and a little off to the side. The microphone should not touch your mouth, but it can be almost touching your lips.
- If you need to move the microphone out of the way, lift the “boom” up and over your head, rather than bending it out of position or removing the headset.

Using a hand-held microphone

- Hold the microphone one to three inches from your mouth and a little off to the side.
- When dictating to Dragon, if the sound level is unacceptable or volume check fails, a notification page pops-up, try holding the microphone slightly farther from your mouth.

Using an array microphone

- Position the array 18 to 30 inches from/pointed at your mouth.
- Avoid blocking the path between your mouth and the array, for example by holding a book or paper in front of your face.
- Avoid having any source of noise or signal other than your voice directly facing the array within at least 15 feet.

Microphone Check

After you have positioned the microphone and clicked Next, you see a screen containing text for you to read out loud.

Click that screen’s Start button and then read aloud the text displayed in the box. When the program has heard enough, it displays Audio quality is acceptable. Click Next to continue. If it displays “The audio quality is unacceptable”, make sure your microphone is positioned properly and that you are speaking loudly enough. Then try the Microphone Check again.

Training a user profile

Performing training after creating a user profile is one of the ways you can personalize your profile and obtain higher accuracy. It is done by reading aloud for several minutes from one of the available texts Dragon offers.

Note:

For information on acoustic training the transcription of recordings, see http://www.nuance.com/dragon/transcription-solutions/index.htm
From the DragonBar’s Profile menu, select Open User Profile and select your profile in the list then click Open. From the Audio menu, select Read text to improve accuracy.

To train a profile

1. In the Read Training Text page, under Choosing text to read, choose a text to read aloud and click Next.
2. When the Text Display page appears, choose how you want to read the text, from the screen or from a printed page. If you choose to read from a printed page, click Print to print the text.
3. If you chose to read the text from the screen, the Speaking to the computer page appears and advises you to position your microphone.
4. After you position your microphone, click Train to begin.
5. In the Speaking to the Computer pop-up, click Begin Training and read the text in the box.
6. Click Next and proceed with the reading.

Notes:

You need to read for only about 5 minutes.

You can take breaks during your reading by clicking Pause.

Try to read the text exactly as it is, but it’s okay if you read something incorrectly.

When you read training text, you don’t have to dictating punctuation but consider reading at least the periods or the commas (this is an opportunity for you to practice saying punctuation and also helps you speak with a tone and speed that’s more similar to how you will dictate than how you speak when simply reading something out loud).

When you’ve read enough, Dragon displays a congratulations message. Click OK and Dragon starts adapting to your voice.

Upgrading User Profiles

If you chose to upgrade existing user profiles during the installation, the User Upgrade Wizard appears the first time you run Version 13.

Note:

If you do not want to upgrade user profiles right now, you can exit from the wizard and do it later.

Otherwise, you can start the User Upgrade Wizard from the Windows Start menu at any time.
To upgrade existing user profiles:

1. To start the User Upgrade Wizard, select Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Upgrade Users. The User Upgrade Wizard appears.

2. On the Select Users to Upgrade page, modify the list to include only the user profiles that you want to upgrade now. The wizard starts by including all user profiles in the current folder as candidates to upgrade. You add to the list by clicking the Add button and browsing for additional user profiles in other locations. You remove user profiles from the list by selecting them and clicking the Remove button. After the list contains only the user profiles you want to upgrade, click Next.

3. Click Next and choose the location for the upgraded user profiles. As the User Upgrade Wizard modifies your user files to work with the newest version, it can place the upgraded user in another location while keeping the old files untouched, in case you need them again.

4. Click the Browse button in the Choose Destination page of the wizard to select the location for the upgraded user profiles. If you do not set a location, Dragon places the profiles in the default location (see Version 13 File Structure).

5. (Optional) If you want to make changes to the user locations, base vocabularies, and/or acoustic models, click the Advanced button and the Advanced Options dialog box opens.

   In this dialog box, you can make finer adjustments to how the wizard upgrades particular users. You see a list of the users being upgraded. For each user profile, you see the
profile name, old location, vocabulary, and one or more acoustic models.

When you click on the location line of a user profile in the list, the *New Location* text box below the list becomes available. You can click Browse and select a new location.

When you click on the vocabulary line of a user profile in the list, the *New Base Vocabulary* text box below the list becomes available. You can choose a new base vocabulary from the drop-down list.

When you click on the acoustic model line of a user profile in the list, the *New Acoustic Model* text box below the list becomes available. You can choose a new combination language, language model, and accent from the drop-down list.

6. Click OK to return to the wizard.

7. Click Next to proceed to the *Upgrade Users* page where you click Begin to begin the upgrade process. Expect to wait approximately 5 minutes for each user profile being upgraded.

8. When the upgrade process is complete, click Finish.

**Default installation folders**

Dragon sets up the following default folders and file locations for application and data file storage during installation:

**Windows 7/WINDOWS 8**

*Main Dragon log*

C:\ProgramData\Nuance\NaturallySpeaking13\logs\<user name>

**Note**: After one of Dragon’s periodic tasks runs, there is also a log in the subfolder

C:\ProgramData\Nuance\NaturallySpeaking13\logs\System\Upgrade log

C:\Users\All Users\Nuance\NaturallySpeaking13\logs\<user name>  

*User Profiles*

C:\ProgramData\Nuance\NaturallySpeaking13\Users  

*Roaming User Profiles (local folder)*

C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers  

*Vocabularies and Acoustic Models*

C:\ProgramData\Nuance\NaturallySpeaking13\Data  

*Custom words and commands*

C:\ProgramData\Nuance\NaturallySpeaking13\Custom
Program files

For 32-bit systems
C:\Program Files\Nuance\NaturallySpeaking13\Program

For 64-bit systems
C:\Program Files (x86)\Nuance\NaturallySpeaking13\Program

Help

For 32-bit systems
C:\Program Files\Nuance\NaturallySpeaking13\Help

For 64-bit systems
C:\Program Files (x86)\Nuance\NaturallySpeaking13\Help

Interactive Tutorial files

For 32-bit systems
C:\Program Files\Nuance\NaturallySpeaking13\tutorial

For 64-bit systems
C:\Program Files (x86)\Nuance\NaturallySpeaking13\tutorial

Activating Dragon NaturallySpeaking

The first time you start Dragon NaturallySpeaking, you will be prompted to activate your copy of the program.

If you do not activate the program, you will be able to start Dragon NaturallySpeaking several times. Without activation, when you start Dragon NaturallySpeaking for the sixth time, it will no longer open and you won't be able to use the program until you activate it.

Nuance strongly recommends that you activate automatically.

To automatically activate Dragon NaturallySpeaking

1. Start Dragon NaturallySpeaking. This displays the Activation dialog box.
2. Click "Activate Now." This displays the Activation Screen.

You can also choose "Activate Later," which will prompt you to activate each time you start Dragon NaturallySpeaking. If you start the program five times without activating, Dragon NaturallySpeaking will be disabled.

3. Click "Activate Automatically." This automatically activates Dragon NaturallySpeaking and requires no further action from you.

To manually activate Dragon NaturallySpeaking

1. Start Dragon NaturallySpeaking. This displays the Activation dialog box.
2. Click "Activate Now." This displays the Activation Screen.
3. Click "Activate Manually." This displays the Enter Key dialog box.
4. To complete the manual activation, click on the URL listed at the top of the dialog box. This URL opens the Nuance activation page.
5. On the Nuance activation page, click "Generate Activation Key" to create an Activation Key.

6. Once activation key appears, select the entire number and copy it (CTRL+C). Click the first field of the Enter Key dialog box and paste (CTRL+V). This pastes the entire number into the Activate Key field.

7. Click OK to complete the activation.

Notes

- You must be connected to the Internet to activate Dragon NaturallySpeaking. The activation process sends only your product serial number and a number that uniquely identifies the machine where Dragon NaturallySpeaking is being installed. No personal information is transmitted to Nuance.

- If you make any hardware changes on a machine where Dragon NaturallySpeaking is installed, you may be prompted to activate again. To preserve your activation status you can uninstall Dragon NaturallySpeaking, making sure to keep your User Profiles when prompted, before you make your hardware changes. After making changes to your hardware, then re-install Dragon NaturallySpeaking.
Chapter 3: Getting Started

This section contains the following topics:

Welcome to Dragon NaturallySpeaking ........................................ 34
Working with Windows 8 and Windows 8.1 .................................. 36
About Dragon NaturallySpeaking .............................................. 39
How Dragon works ..................................................................... 40
Activating Dragon NaturallySpeaking ......................................... 41
Dragon system requirements .......................................................... 42
Top Ways to use Dragon ............................................................... 43
Using Dragon NaturallySpeaking Help ........................................... 44
Hot keys .................................................................................. 45
Using the Dragon NaturallySpeaking Learning Center ..................... 45
Using the Interactive Tutorial ....................................................... 49
Starting to dictate ..................................................................... 49
Using the Command line interface ............................................... 49
Electronic Medical Record (EMR) applications restrictions ............ 50
Auto Configuration Based on System Profile ................................. 51
Contacting Customer Service and Support .................................... 51
Welcome to Dragon NaturallySpeaking
Chapter 3: Getting Started

What's New
Visit this help topic to read about the most newsworthy features of Dragon NaturallySpeaking.

Dragon NaturallySpeaking on the Web
The Nuance Web site gives you access to latest information on Dragon NaturallySpeaking.

Top ways to use Dragon
Follow this link for a bird's eye view of all things Dragon.

Dictation: Our Top 5
Start here for our top 5 tips about how to dictate to Dragon NaturallySpeaking.

How to make corrections
You can correct misrecognitions or rewrite dictation in many ways. This topic gets you started with the leading methods, such as by selecting and redictating and using the Correction menu.

Our best ways to improve accuracy
Visit our top 10 list to learn strategies to maximize dictation accuracy.

Making revisions
Revising text goes beyond correction and includes deleting, undoing, and corrections, along with many ways you can use Dragon to format your content.

"What can I say?"
You can ask Dragon NaturallySpeaking to list commands for your current Windows task at any time. When you say "What can I say?," Dragon NaturallySpeaking opens the Dragon Learning Center, showing lists of applicable commands.

Using Dragon with E-mail
Dragon voice recognition gives special focus to supporting dictating and managing e-mail, in programs from Microsoft Outlook to Outlook.com and Gmail.

Using Dragon with your Word Processor
Dragon supports countless commands with the leading word processing programs, from
<table>
<thead>
<tr>
<th>Searching by voice</th>
<th>Using Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon NaturallySpeaking Voice Shortcuts collapse common multi-step tasks into direct voice commands that you can say at anytime, no matter what is active on your screen. Voice Shortcuts speed up searching the Internet, searching your computer, starting e-mails, and more.</td>
<td>The DragonBar’s Help menu provides access to many Help tools, including the Accuracy Center, the Performance Assistant, Dragon’s Help, the Learning Center, and the interactive tutorial. You’ll also find Web links for software updates, the main Dragon page on the Web, Technical Support pages, and for online registration.</td>
</tr>
</tbody>
</table>

**Working with Windows 8 and Windows 8.1**

With Windows 8, Microsoft introduced major changes for end-users compared to previous operating systems: it added a second interface (known as “Modern” and formerly as “Metro”) and removed the Start button from the familiar desktop interface. With the release of its free update, Windows 8.1 (October 2013), Microsoft introduced new capabilities (and reintroduced the Start button on the desktop interface).

The Classic DragonBar cannot display on the Modern interface, but Dragon 13 introduces the New DragonBar, which can.

**Note:** For the latest details on using Dragon in Windows 8, please see the Dragon support page and Knowledgebase on the Nuance website: [http://www.nuance.com/support/dragon-naturallyspeaking/index.htm](http://www.nuance.com/support/dragon-naturallyspeaking/index.htm)

**Starting Dragon from the Windows desktop:**

Make sure your microphone is connected, then start Dragon by double-clicking its desktop icon.
Starting Dragon from the Windows Start Screen:

When using Windows 8, click the Dragon NaturallySpeaking tile to start Dragon. In Windows 8.1, you start Dragon from the Apps View. You can start Dragon from the Start Screen on Windows 8.1 if you have a Dragon tile on the Start Screen. By default, the Dragon tile will not be on the Start Screen, and unless you pin it, you will not be able to start it from that screen.

Command and control

- In Windows 8, there is no Start menu on the desktop interface, but equivalent functionality is provided by the Charms bar and the Start screen. To access those by voice, you can use the commands “open Charms bar” and “open Start screen.” To see the expanded view of the Start screen, you use the command “show all applications.” (Note: in Windows 8.1 there is a Start button on the desktop).

- To perform actions in Windows 8, you can also take advantage of Dragon’s ability to press keys. For example, you can say the commands “press Windows h” (this accesses Windows 8’s Share feature) and “press Windows key .”

- You can dictate in the Search field. (After entering your search term or terms, you could use the command “press Enter.”) Note that, from the Start screen, dictating does not automatically bring up Search. This is supported in the "All Apps" screen only.

- The following are commands for Windows 8 and include commands added for Windows 8.1:
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows 8 Commands</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Display the Start Screen | "start screen"
"Show me start screen"
"Show start screen"
"Open start screen"
"Click start screen"
| |
| Change Account Picture | "Change account picture"
"Change my account picture"
| |
| Go to All Applications | "Switch to all applications"
"Open all applications"
"Show all applications"
"View all applications"
| |
| Display the Charms Bar | "charms bar"
"Show me charms bar"
"Click charms bar"
| |
| Pin an Internet Explorer 10 site to the Start Screen | "Pin this location to start screen"
"Add location to start screen"
"Pin location to start screen"
"Add this location to start screen"
"Add page to the start screen"
"Pin site to start screen"
"Add this page to start screen"
"Add this site to start screen"
"Pin this location to the start screen"
"Pin location to the start screen"
"Pin web page to start screen"
"Add location to the start screen"
"Add this site to the start screen"
"Add this page to start screen"
### Windows 8.1 Commands

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize the Start Screen</td>
<td>&quot;Customize start screen&quot;</td>
</tr>
</tbody>
</table>
| Pin an Internet Explorer 11 site to Applications | "Pin this location to start screen applications"  
|                                          | "Add this web page to applications"              
|                                          | "Pin this web site to apps"                      |
| Display a Charm                         | "Go to 'charm name' charm"                      |
|                                          | "Open 'charm name' charm"                       |
|                                          | "Show 'charm name' charm"                       |
|                                          | Charm names: Start | Search | Share | Devices | Settings |

### Windows 8 restrictions

- Dragon’s windows can only open in the desktop environment. Examples of Dragon windows are the Open User Profiles dialog, the Vocabulary Editor, the Accuracy Center, the list of open windows, and the Edit Keywords window triggered by commands such as “search maps for…”. If, while outside the desktop environment, you perform an action that causes one of these windows to open, that window will be open on the desktop.
- Dragon’s Results indicator does not appear when you use Dragon outside of the desktop environment.
- Dragon’s capabilities for Internet Explorer only apply to the desktop environment; they do not apply to the Internet Explorer full-screen app.
- Dragon does not have Full Text Control in full-screen applications. The Dictation Box is not supported for Metro apps.

### About Dragon NaturallySpeaking

Dragon NaturallySpeaking software is the premier product for large-Vocabulary continuous recognition of natural speech. With Dragon NaturallySpeaking, you can create documents quickly and easily with your voice, without being slowed by typing on your keyboard.

#### Dictate your documents

You can dictate, rather than type, into any program that accepts text. Dragon NaturallySpeaking recognizes natural and continuous speech and converts it to text on the screen.
Format and edit by voice

You can use voice commands to format text and make corrections and to activate the buttons and menus in supported word processors, such as Corel WordPerfect, Microsoft Word, DragonPad, WordPad, and other supported programs.

Say What You See™ to control programs

You can use voice commands to start and switch among programs and to control program windows, menus, and dialog boxes. Say "File," for example, to open the File menu.

Personalize Dragon NaturallySpeaking for your voice and Vocabulary

You can train Dragon NaturallySpeaking to recognize the way you speak and personalize the Vocabulary with words you typically use.

You can increase accuracy by creating different Vocabularies, personalized for the different subject areas in which you dictate.

- Dragon NaturallySpeaking system requirements
- Copyright

How Dragon works

The goal of Dragon NaturallySpeaking is to make it easier to interact with a computer without using a keyboard or mouse. To succeed at this goal, the program must be able to analyze an incoming stream of sounds and interpret those sounds as commands and dictation. This process of interpretation is called speech recognition, and its success is measured by the percentage of correct interpretations, or recognition accuracy.

To achieve high recognition accuracy, Dragon NaturallySpeaking relies on several sources of information:

- Acoustic model—a mathematical model of the sound patterns used by the speaker's language.
- Vocabulary—a list of words that the program can recognize. Each word in the Vocabulary has a text representation and a pronunciation.
- Language model—statistical information associated with a Vocabulary that describes the likelihood of words and sequences of words occurring in the user's speech.

When you create and train a User Profile, you start with a standard set of models and then customize them for the way you speak (acoustic model) and the way you use words (Vocabulary and associated language model). When you use Dragon NaturallySpeaking, the program uses your customized User Profile to guess the words that you said.

Why does the program make mistakes?

For various reasons, Dragon NaturallySpeaking does not always type the word you want. Some of the reasons include:

- The correct word was not in the Vocabulary.
- The word or phrase you spoke sounded very similar to the word or phrase the program typed.
- The sound of your breath or other random noises were interpreted as small words like "in" that appeared where they didn't belong.
There are solutions to these and most of the other errors that the program might make in the Help topics.

**Customizing Dragon NaturallySpeaking**

Before you first use Dragon NaturallySpeaking, you provide it with information about your pronunciation. You do this by reading a passage from a prepared text. The program then adds this data to the information it already knows about the way you speak.

As you subsequently use Dragon NaturallySpeaking, you may still encounter occasional misrecognitions, though these misrecognitions will decrease over time.

- If the program misrecognizes a common word, you can correct the misrecognition in a way that further refines the program's understanding of your pronunciation of specific words or phrases.

- If the program misrecognizes an uncommon word, such as a technical term or a proper name, you can add that word to the program's Vocabulary so that it will understand the word or term the next time you say it.

You can also tell Dragon NaturallySpeaking something about the frequency with which you use different words when you compose documents and e-mail.

- A tool called Learn from Specific Documents lets Dragon NaturallySpeaking analyze your documents and therefore enables the program to better recognize your language and writing style.

- Another tool called Learn From Sent E-mails tool can add the names of your e-mail contacts and analyze the language and style of your sent e-mail.

There's more

This is just a short description of how Dragon NaturallySpeaking can help you get more from your computer through speech recognition. As you look through additional topics in the Help, you will learn in greater detail how to better use the power of speech recognition with Dragon NaturallySpeaking.

**Activating Dragon NaturallySpeaking**

The first time you start Dragon NaturallySpeaking, you will be prompted to activate your copy of the program.

If you do not activate the program, you will be able to start Dragon NaturallySpeaking several times. Without activation, when you start Dragon NaturallySpeaking for the sixth time, it will no longer open and you won’t be able to use the program until you activate it.

Nuance strongly recommends that you activate automatically.

To automatically activate Dragon NaturallySpeaking

1. Start Dragon NaturallySpeaking. This displays the Activation dialog box.
2. Click "Activate Now." This displays the Activation Screen.

You can also choose "Activate Later," which will prompt you to activate each time you start Dragon NaturallySpeaking. If you start the program five times without activating, Dragon NaturallySpeaking will be disabled.
3. Click "Activate Automatically." This automatically activates Dragon NaturallySpeaking and requires no further action from you.

To manually activate Dragon NaturallySpeaking

1. Start Dragon NaturallySpeaking. This displays the Activation dialog box.
2. Click "Activate Now." This displays the Activation Screen.
3. Click "Activate Manually." This displays the Enter Key dialog box.
4. To complete the manual activation, click on the URL listed at the top of the dialog box. This URL opens the Nuance activation page.
5. On the Nuance activation page, click "Generate Activation Key" to create an Activation Key.
6. Once activation key appears, select the entire number and copy it (CTRL+C). Click the first field of the Enter Key dialog box and paste (CTRL+V). This pastes the entire number into the Activate Key field.
7. Click OK to complete the activation.

Notes

- You must be connected to the Internet to activate Dragon NaturallySpeaking. The activation process sends only your product serial number and a number that uniquely identifies the machine where Dragon NaturallySpeaking is being installed. No personal information is transmitted to Nuance.
- If you make any hardware changes on a machine where Dragon NaturallySpeaking is installed, you may be prompted to activate again. To preserve your activation status you can uninstall Dragon NaturallySpeaking, making sure to keep your User Profiles when prompted, before you make your hardware changes. After making changes to your hardware, then re-install Dragon NaturallySpeaking.

Dragon system requirements

The install process checks that your system meets the minimum requirements; if they are not met, Dragon NaturallySpeaking will not be installed.

Note:

Supports Microsoft Office 2010 & 2013. Does not support dictation directly into Electronic Medical Record (EMR) systems. For EMR support, please use Dragon Medical Edition.

- **CPU**: Minimum: **2.2 GHz Intel® dual core or equivalent AMD processor. Faster processors yield faster performance**.
- **Free hard disk space**: 4GB
- **Supported Operating Systems**: Windows 7 32-bit and 64-bit; Windows 8 & 8.1, 32-bit and 64-bit; Windows Server 2008 R2; Windows Server 2012.
- Internet Explorer 9 or higher or the current version of Chrome or Firefox for Online Help.
- A sound card supporting 16-bit recording.
- A DVD-ROM drive for installation.
- A Nuance-approved microphone. See support.nuance.com/compatibility for more information.
- An Internet connection for automatic product activation (a quick anonymous process).

**Top Ways to use Dragon**

If you want to get started quickly, check out the topics listed here. They explain the top things you need to know about common tasks and concepts.

Click a heading to open that topic.

**Getting Started**
Descriptions of key concepts and components.

**Microphones**
Requirements and tips for different microphone types.

**Dictation**
Steps and tips for dictating text.

**Accuracy**
Tips to maximize dictation accuracy.

**Correcting text**
Commands for correcting your dictated text.

**Revising text**
Commands for revising and formatting your dictated text.

**Mouse and keyboard**
Commands for controlling your mouse and keyboard.

**Word Processors**
Commands for working in common word processing applications, including Microsoft Word.

**E-mail**
Commands for writing and managing e-mail.

**User profiles**
Creating and managing user profiles.

**The Dragon Learning Center**
Description of Learning Center features, plus related tips and commands.

**Digital Recorders**
Recording and transcribing with an external recorder.
Using Dragon NaturallySpeaking Help

In addition to using the Help menu, you can access Help and navigate through topics by hand (keyboard or mouse) as well as by using voice commands. The following table summarizes these commands.

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch a keyword search in the Help</td>
<td>At any time, even if the Help is not open, you can launch a search</td>
</tr>
<tr>
<td></td>
<td>by saying the command &quot;Search Dragon Help for &lt;dictation&gt;,&quot; where</td>
</tr>
<tr>
<td></td>
<td>&lt;dictation&gt; can be any word(s) you want to look for. The word &quot;</td>
</tr>
<tr>
<td></td>
<td>Dragon&quot; can be omitted. An example of this command is &quot;search Help</td>
</tr>
<tr>
<td></td>
<td>for symbols.&quot;</td>
</tr>
<tr>
<td></td>
<td>If you want to search for a phrase, as opposed to individual words,</td>
</tr>
<tr>
<td></td>
<td>use quotation marks around the phrase. For example, you can say</td>
</tr>
<tr>
<td></td>
<td>&quot;Search Help for open quote spoken form close quote&quot; to find only</td>
</tr>
<tr>
<td></td>
<td>topics that contain that phrase.</td>
</tr>
<tr>
<td>Open the Help window</td>
<td>&quot;Give Me Help&quot;</td>
</tr>
<tr>
<td>Display topics</td>
<td>&quot;Move Forward&quot; or &quot;Go Backward&quot;</td>
</tr>
<tr>
<td>Select the Contents, Index, or Search tab</td>
<td>Say &quot;Click Contents,&quot; &quot;Click Index,&quot; or &quot;Click Search&quot;</td>
</tr>
<tr>
<td>Move in the Contents, Index list, Search list,</td>
<td>&quot;Move Down &lt;1 to 20&gt;&quot;</td>
</tr>
<tr>
<td>or Select Topic list</td>
<td>&quot;Move Up &lt;1 to 20&gt;&quot;</td>
</tr>
<tr>
<td>Open a topic from the Contents, Index list,</td>
<td>Move to the topic or book you want and say &quot;Press Enter.&quot; (In the</td>
</tr>
<tr>
<td>Search list, or Select Topic list</td>
<td>Index and Search tabs, you can also say &quot;click Display.&quot;.) You can</td>
</tr>
<tr>
<td></td>
<td>also dictate an index entry or a search string.</td>
</tr>
<tr>
<td>Close the Help window</td>
<td>&quot;Close Help&quot; or &quot;Quit Help&quot;</td>
</tr>
<tr>
<td>Highlight a topic in the Search tab after a</td>
<td>Say &quot;Tab four time&quot; or say &quot;Tab Key&quot; or &quot;Press Tab&quot; four times</td>
</tr>
<tr>
<td>search</td>
<td></td>
</tr>
</tbody>
</table>

Note

Not all voice commands work in the Help window. For example, you can select the tabs by saying "Click Contents," "Click Index," or "Click Search," but you cannot use voice commands...
to select from the toolbar and you cannot click buttons by saying their name. You can use "Press Tab Key" to select buttons and "Press Enter Key" to press buttons. On the Search tab of Dragon's Help window, three checkboxes enable you to search only previous search results, match similar words, and search topic titles only. Open the Help Search tab for details.

**Hot keys**

Use hot keys to perform the described actions.

The keys listed here are the default settings; you or someone else might have changed the key assignments to different keys.

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn the microphone on or off</td>
<td>Press +(Plus key) on the numeric keypad</td>
</tr>
<tr>
<td>Open the Correction menu</td>
<td>Press -(Minus key) on the numeric keypad</td>
</tr>
<tr>
<td>Force words to be recognized as commands</td>
<td>Press and hold <strong>CTRL</strong></td>
</tr>
<tr>
<td>Force words to be recognized as dictation</td>
<td>Press and hold <strong>SHIFT</strong></td>
</tr>
<tr>
<td>Open the Dragon menu</td>
<td>Press *(Asterisk key) on the numeric keypad</td>
</tr>
<tr>
<td>Put the microphone to sleep or wake it up</td>
<td>Press / (forward slash key) on the numeric keypad</td>
</tr>
<tr>
<td>Press-to-talk</td>
<td>There is no default key for Press-to-talk</td>
</tr>
<tr>
<td>Open the Dictation Box</td>
<td>Press <strong>CTRL + SHIFT + D</strong></td>
</tr>
<tr>
<td>Move to Next field</td>
<td>Press <strong>CTRL + SHIFT + N</strong></td>
</tr>
<tr>
<td>Playback</td>
<td>Press <strong>SHIFT + -</strong> (Minus key (-) on the numeric keypad)</td>
</tr>
<tr>
<td>Fast Playback</td>
<td>Press <strong>SHIFT + * (Asterisk key)</strong> on the numeric keypad</td>
</tr>
</tbody>
</table>

**Note**

You can view or change the current assignments for hot keys on the Options dialog box Hot keys tab.

**Using the Dragon NaturallySpeaking Learning Center**

Use the Learning Center to see on the side of your screen sample commands and tips related to the program you are currently using. Its content changes as you switch between programs and windows. (See Learning Center contexts.)

The Learning Center appears automatically when you open a Profile (you can change this from the Miscellaneous tab of the Options dialog box). If the Learning Center is closed, you
can open it through the Help menu or by saying a command such as "What can I say" or "Show Dragon Learning Center."

You can change the Learning Center's font size, either by voice or through its right-click menu.

By default, the Learning Center is set to Floating; you can resize it and move it. If you prefer to not cover any window under it, you can choose to dock it to the side of the screen, in which case you can also choose to set it to Auto-hide.

**Caution:** if the area of the desktop below the Learning Center contains icons, docking the Learning Center will cause those icons to move, which could disrupt your desktop arrangement.

**Controlling the Learning Center**

You can use the following voice commands with the Learning Center, whether or not it's the active window (that is to say, whether or not it has focus).

Most commands require that the Learning Center be open.

To open one of Learning Center's panels or tabs, say “click” and its label.
### Show the Learning Center

- "What can I say?"
- "Dragon Learning Center" or "Dragon Sidebar" (you can also precede this with "Open", "Launch", "Start", "Show", or "Show Me")
- "Sample Commands" or "Command list" (you can precede this with "Open", "Launch", "Start", "Show", or "Show Me")
- "Switch to Learning Center"

**To**: Select Learning Center from the DragonBar's Help menu.

**Say this**: "What can I say?"

**Or do this**: Select Learning Center from the DragonBar's Help menu.

**Do this**:
- "Dragon Learning Center" or "Dragon Sidebar"
- "Sample Commands" or "Command list"
- "Switch to Learning Center"

### Show the MyCommands tab

- "Click My Commands"

**To**: Select the MyCommands tab on the Learning Center.

**Say this**: "Click My Commands"

**Or do this**: Select the MyCommands tab on the Learning Center.

### Dock the Learning Center to the right

- "Learning Center dock right"

**To**: Right-click on the Learning Center and select Dock right.

**Say this**: "Learning Center dock right"

**Or do this**: Right-click on the Learning Center and select Dock right.

### Dock the Learning Center to the left

- "Learning Center dock left"

**To**: Right-click on the Learning Center and select Dock left.

**Say this**: "Learning Center dock left"

**Or do this**: Right-click on the Learning Center and select Dock left.

### Change the font size of the Learning Center

- "Learning Center Font [Small | Medium | Large]"

**To**: Right-click on the Learning Center and select Font Size > Small, Medium or Large.

**Say this**: "Learning Center Font [Small | Medium | Large]"

**Or do this**: Right-click on the Learning Center and select Font Size > Small, Medium or Large.

### Float the Learning Center

- "Learning Center float"
- "Learning Center undock"

**To**: Right-click on the Learning Center and select Floating.

**Say this**: "Learning Center float"

**Or do this**: Right-click on the Learning Center and select Floating.

### Auto-hide the Learning Center (not available in Floating)

- "Learning Center auto-hide"

**To**: Right-click on the Learning Center and select Auto-hide.

**Say this**: "Learning Center auto-hide"

**Or do this**: Right-click on the Learning Center and select Auto-hide.

### Disable auto-hide (not available in Floating)

- "Learning Center stop hiding"

**To**: Right-click on the Learning Center and deselect Auto-hide.

**Say this**: "Learning Center stop hiding"

**Or do this**: Right-click on the Learning Center and deselect Auto-hide.
<table>
<thead>
<tr>
<th>To</th>
<th>Say this</th>
<th>Or do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the Learning Center to Always on Top</td>
<td>With the Learning Center active, right-click it and say &quot;Always on Top&quot;</td>
<td>Right-click on the Learning Center and select Always on Top</td>
</tr>
<tr>
<td>Turn off Always on Top</td>
<td>With the Learning Center active, right-click it and say &quot;Always on Top&quot;</td>
<td>Right-click on the Learning Center and deselect Always on Top.</td>
</tr>
<tr>
<td>Increase the Learning Center width by 5 per cent</td>
<td>&quot;Learning Center wider&quot;</td>
<td>With the Learning Center active, press the key combination &lt;ALT+W&gt;. (You can also click and drag the left border.)</td>
</tr>
<tr>
<td>Decrease the Learning Center width by 5 per cent</td>
<td>&quot;Learning Center thinner&quot;</td>
<td>With the Learning Center active, press the key combination &lt;ALT+T&gt;. (You can also click and drag the left border.)</td>
</tr>
<tr>
<td>Print Learning Center commands</td>
<td>N/A</td>
<td>Right-click on the Learning Center and select Print.</td>
</tr>
<tr>
<td>Show the Learning Center Help</td>
<td>&quot;Learning Center Help&quot;</td>
<td>Click the question mark icon at the top right of the Learning Center.</td>
</tr>
<tr>
<td>Close the Learning Center</td>
<td>With the Learning Center active, say ↑&quot;Learning Center close&quot; or ↑&quot;Close window&quot;</td>
<td>Right-click on the Learning Center and select Close. ↑Click the x at its top right corner.</td>
</tr>
</tbody>
</table>

**Learning Center contexts**

Here is the list of programs and windows for which the Learning Center has specific content:

- Desktop and Windows Explorer
- Dragon windows: DragonBar, DragonPad, Dictation Box, Spelling window (see Dragon Help), Command Browser, Vocabulary Editor
- Microsoft Word, Microsoft Excel, Microsoft Outlook, .. Please see the Dragon Help for Microsoft PowerPoint, and Microsoft InfoPath
- WordPad
- .Corel WordPerfect (see Dragon Help)
- .Lotus Notes (see Dragon Help)
- OpenOffice.org Writer (see Dragon Help)
- Internet Explorer, Google Chrome, and Mozilla Firefox
- Global
If you click in an application for which Dragon does not have specific commands (for example, Notepad, Skype, or iTunes), the Learning Center displays general tips, plus commands available at all times (these are called “global commands”) and commands for controlling the Learning Center itself.

**Using the Interactive Tutorial**

The Interactive Tutorial teaches you Dragon commands and skills in a simulated environment. The lessons are short and introduce important interface elements like the DragonBar and Learning Center.

At any time, you can exit the Interactive Tutorial by clicking the X in the top right corner. You can also return to it through the DragonBar Help menu.

Note: Like the profile creation process, you cannot use the Interactive Tutorial hands-free.

**Starting to dictate**

Follow these steps when you want to dictate.

To start to dictate

1. Make sure the program you want to dictate into is running.
2. **Put on the microphone and position it correctly.**
3. Click in the program you want to dictate into to make that window active.
4. **Turn on the microphone.**
5. Start talking and watch your words appear on the screen.

**Using the Command line interface**

You can use command line options to modify the way in which Dragon NaturallySpeaking starts up. These switches are used in the following syntax:

```
natspeak /switch
```

Where `/switch` is the switch from the following table:
<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/diagnose</td>
<td>Runs Dragon NaturallySpeaking in diagnostic mode. Outputs information into the Dragon.log file and exits.</td>
</tr>
<tr>
<td>/FindCustom</td>
<td>Brings up the custom directory</td>
</tr>
<tr>
<td>/finddragonlog</td>
<td>Brings up a Windows Explorer window with the dragon.log highlighted</td>
</tr>
<tr>
<td>/findsetuplog</td>
<td>Brings up a Windows Explorer window with the dgnsetup.log highlighted</td>
</tr>
<tr>
<td>/findappdataallusers</td>
<td>Brings up a Windows Explorer window in our &quot;all users&quot; application data directory (nssystem.ini, nsapps.ini, models.ini, Users\ directory, etc.)</td>
</tr>
<tr>
<td>/findappdata</td>
<td>Brings up a Windows Explorer window in our &quot;this user&quot; application data directory (dragon.log, upgrade.log, nsuser.ini, etc.)</td>
</tr>
<tr>
<td>/findupgradelog</td>
<td>Brings up a Windows Explorer window with the upgrade.log highlighted</td>
</tr>
<tr>
<td>/user &lt;User Profile&gt;</td>
<td>Automatically loads the profile specified by &lt;User Profile&gt;</td>
</tr>
<tr>
<td>/topic &lt;topic&gt;</td>
<td>Automatically loads the topic specified by &lt;topic&gt; (Professional, Legal, and Medical editions only)</td>
</tr>
<tr>
<td>/quick</td>
<td>Runs Dragon NaturallySpeaking in quick mode. QuickStart mode starts Dragon NaturallySpeaking without loading a User Profile or any speech models when you start your computer. Only the Dragon NaturallySpeaking tray icon is visible. When you click on the Dragon NaturallySpeaking Desktop icon, the Open User Profile dialog box immediately appears. When you exit Dragon NaturallySpeaking the program returns to the QuickStart mode and remains in memory with a reduced footprint (approximately 10 MB).</td>
</tr>
<tr>
<td>/SetDefaultOptions</td>
<td>Displays the Options dialog box at the end of the installation. The Options dialog box lets you change Dragon NaturallySpeaking’s standard behavior, including specifying hot keys, customizing how text is formatted, initial microphone settings, and setting how often User Profiles are backed up.</td>
</tr>
<tr>
<td>/SetDefaultAdministrativeOptions</td>
<td>Displays the Administrative settings dialog box at the end of the installation. The Administrative settings dialog box lets you set up the Roaming feature as well as set the backup location of your Profile and prevent users from modifying commands and Vocabularies.</td>
</tr>
<tr>
<td>/SetDefaultFormattingOptions</td>
<td>Brings up the default Formatting options dialog</td>
</tr>
</tbody>
</table>

**Electronic Medical Record (EMR) applications restrictions**

Dragon Basics, Home, Premium, Professional, and Legal do not support dictation into Electronic Medical Record applications (EMRs) or other medical applications (RIS and LIMS for example).
This functionality is only available in the medical editions. A full description of the other extra features of the medical versions and upgrade possibilities are available on:

http://www.nuance.com/for-healthcare/index.htm

Auto Configuration Based on System Profile

At installation time, Dragon NaturallySpeaking analyzed your computer’s processor and memory resources and may have disabled some of Dragon NaturallySpeaking’s Natural Language commands to optimize performance your system.

You can change these settings to suit your preferences using Dragon’s Options dialog box (Tools>Options from the New DragonBar or Classic DragonBar). You can change:

- Adjusting the “Speed vs. Accuracy” slider to favor speed. For more information, see Adjusting Speed vs. Accuracy.
- Deactivating the “Natural Language Commands” for some or all of the following applications:
  - Microsoft Word
  - Microsoft Excel
  - Microsoft PowerPoint
  - Corel WordPerfect

“Natural Language Commands” provide alternate ways to perform specific tasks by voice. If they are deactivated, you can still perform all actions by voice although it may take a few extra steps, including navigating menus and dialogs. You can still use commands such as “bold that”, “delete line”, “select all”, “backspace 5”, etc. You can re-enable each of these command sets individually, using the “Natural Language Commands” button on the Commands tab of the Options dialog. You may wish to do so if speed of response is not your priority. If you re-enable the Microsoft Word set, for instance, Dragon’s speed within Microsoft Word (or Microsoft Outlook using Word as its editor) may decrease.

For more information, see Enabling Natural Language Commands.

Note

Dragon’s Performance Assistant, available from the Help menu, provides tips and techniques for increasing the speed with which Dragon recognizes what you say.

Contacting Customer Service and Support

Before requesting Support, you may find that shutting down and restarting your computer resolves your issue. If you have done this and still need support, please read below.

First, collect some information

If you can’t find some of the information listed below, a Support agent can help you access it.
Your product **serial number**
(the serial is printed on the DVD sleeve and is also on the splashscreen accessible by clicking About NaturallySpeaking in the DragonBar's Help menu)

What you were doing when the problem happened
(for instance: reading text for the Microphone Check, reading a text to train Dragon, entering text in a table in Microsoft Word 2013...)

Any error message text (before requesting support, consider searching the web by inputting the text of the error into a search engine)

Operating system

Processor type and speed

Amount of memory (RAM)

Amount of free hard-disk space

Sound card name and model

Microphone name and model

Program log file (Dragon.log).

To find the Dragon.log, select Start > All Programs > Dragon NaturallySpeaking > Show Dragon Log

Attach the log file if you send e-mail to technical support.

Then, contact Support

- If you purchased your product from a certified Nuance Applications Solutions Partner, contact your provider for technical support directly.
- You can find the answers to many Dragon NaturallySpeaking support questions on
  - [http://support.nuance.com/](http://support.nuance.com/)

If you require more technical assistance, contact Support at:

- [http://support.nuance.com/](http://support.nuance.com/)

Note: Nuance does not provide technical support for hardware issues. If you are using a digital recorder and you encounter hardware issues, please contact your hardware manufacturer for assistance.
Chapter 4: Using the New DragonBar or Classic DragonBar

This section contains the following topics:

The DragonBar ............................................................... 53
The Text Control Indicator .................................................. 59
Displaying the DragonBar .................................................... 60
Working with the New DragonBar or Classic DragonBar .............. 63

The DragonBar

The DragonBar is the toolbar you use to control the Dragon software. You can choose to use the New DragonBar or switch to the Classic DragonBar from previous versions. (If you switch between DragonBars, the last DragonBar you chose appears the next time you open Dragon.) By default, when you start Dragon, the New DragonBar appears at the top of your screen and is set to Auto-collapse.

You can change the appearance and behavior of the New DragonBar or Classic DragonBar to suit your preferences and hardware. (See Minimize/Maximize buttons and Displaying the DragonBar.)

Note: if you use a touchscreen computer, we recommend you turn off the Auto-collapse (see Displaying the DragonBar for more information).

The New DragonBar and Classic DragonBar contain the following controls.

Dragon icon

Appears on the Classic DragonBar only. Click the Dragon icon ( ) or right-click anywhere on the Classic DragonBar to display a menu that controls how the Classic DragonBar looks and acts on your screen.

To change how the New DragonBar looks and acts, select an option from the DragonBar menu.

For more information on the options that control the New DragonBar or Classic DragonBar, see Displaying the New DragonBar or Classic DragonBar.
Grabber bar

Appears on the New DragonBar only. Click and hold the grabber bar (■) to move the New DragonBar around your screen when it's maximized. It's located to the left of the DragonBar menu.

Minimize/Maximize icons

These appear only on the New DragonBar. Click the Minimize icon (■) or say "Collapse DragonBar" to collapse the New DragonBar, or shrink it down to a smaller size. Click the Maximize icon (■) or say "Expand DragonBar" to return the New DragonBar to its default size.

By default, the New DragonBar is automatically collapsed. To expand it, move your mouse over it. To keep the New DragonBar at its expanded size, deselect the Auto-collapse option from the DragonBar menu.

Microphone icon

The microphone icon displays on the New DragonBar and Classic DragonBar and in the Windows taskbar. Click the microphone icon to turn the microphone on and off. The following table shows the microphone states you'll see:
## Chapter 4: Using the New DragonBar or Classic DragonBar

<table>
<thead>
<tr>
<th>New DragonBar</th>
<th>Classic DragonBar</th>
<th>What you can do</th>
</tr>
</thead>
</table>
| ![Microphone](image) | ![Microphone](image) | The microphone is on and Dragon is listening. Dictate or say commands as needed. When you are finished or want to pause from dictating:  
  ▶ Say "Go to Sleep" or click the forward slash key (/) to put the microphone to sleep.  
  ▶ Say "Microphone Off" or click the plus key (+) to turn off voice recognition. |
| ![Microphone](image) | ![Microphone](image) | The microphone is on and Dragon is ready to act on anything you dictate. |
| ![Microphone](image) | ![Microphone](image) | The microphone is asleep and Dragon is listening to anything except the commands that wake it up. When you want to resume dictating:  
  ▶ Say "Wake Up" or click the plus key (+) to resume voice recognition. |
| ![Microphone](image) | ![Microphone](image) | The microphone is turned off. When you want to resume dictating, do one of the following:  
  Press the plus key (+) on the numeric keypad.  
  Click the microphone button on the DragonBar.  
  Click the microphone icon in the Windows taskbar. |
| ![Microphone](image) | ![Microphone](image) | No User Profile is loaded and the microphone is off. To load a User Profile, select the Profile menu on the New DragonBar or Classic DragonBar. |

See Controlling the Microphone in the Dragon Help for more information.

**Volume Display**

When Dragon hears you well, the volume display on the New DragonBar (▃) or the Classic DragonBar (▃) turns green and expands and contracts as
you speak. No color displays when the microphone is turned off or is not responding. The display turns gray when the microphone is asleep.

**Text Control Indicator**

There is a Text Control Indicator on the New DragonBar (☐) or the Classic DragonBar (✔️) that changes to indicate whether Dragon currently has Full Text Control. See [The Text Control Indicator](#) for more information.

**Recognition Mode Indicator**

The Recognition Mode Indicator shows you Dragon’s current mode. On the New DragonBar, you select modes from the Recognition Mode drop-down list. On the Classic DragonBar, you select modes from the Modes menu. The Recognition Mode Indicator then changes depending on the recognition mode that you select. The default mode is Normal mode.

The following table describes the Recognition modes. Click the links for more information on [using the Recognition modes](#).
<table>
<thead>
<tr>
<th>New DragonBar</th>
<th>Classic DragonBar</th>
<th>Recognition mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now listening for...</td>
<td></td>
<td>Normal Mode</td>
<td>Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from words, numbers, and commands by analyzing what you say between pauses. Say &quot;Start Normal Mode&quot; or &quot;Normal Mode On.&quot;</td>
</tr>
<tr>
<td>Dictation &amp; Commands</td>
<td></td>
<td></td>
<td>A restricted recognition mode that causes Dragon to interpret everything you say as dictation and nothing is interpreted as a command. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate without looking at the words Dragon transcribes. Say &quot;Start Dictation Mode&quot; or &quot;Dictation Mode On.&quot;</td>
</tr>
<tr>
<td>Now listening for...</td>
<td></td>
<td>Command Mode</td>
<td>A restricted recognition mode that causes Dragon to interpret everything you say as a command and nothing is interpreted as dictated text. Say &quot;Start Command Mode&quot; or &quot;Command Mode On.&quot;</td>
</tr>
<tr>
<td>Commands</td>
<td></td>
<td></td>
<td>A restricted recognition mode that causes Dragon to recognize only numbers. If you are dictating only numbers (including currencies), working in this mode increases recognition accuracy. Say &quot;Start Numbers Mode&quot; or &quot;Numbers Mode On.&quot;</td>
</tr>
<tr>
<td>Now listening for...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numbers</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Spell Mode

A restricted recognition mode that causes Dragon to recognize only letters, numbers, commands, and punctuation. Spell mode is useful for dictating unpronounceable alphanumeric strings, such as part numbers and license plate numbers, and other terms you anticipate Dragon won't know, such as Web addresses, words in a foreign language, or unusual product names. Say "Start Spell Mode" or "Spell Mode On." You can still use commands while in Spell Mode.

Message area

The message area shows Dragon NaturallySpeaking’s current status, such as whether the microphone is on or off. The following table shows examples of the message area.

<table>
<thead>
<tr>
<th>New DragonBar</th>
<th>Classic DragonBar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now listening for... Spell</td>
<td>abc</td>
</tr>
</tbody>
</table>

Extras toolbar icon

Click the icon or say "Show Extras Bar" to display the Extras toolbar. The Extras toolbar is available only on the Classic DragonBar. The Extras toolbar has the following features:

Display Correction menu

Click the Correction button to stop playback and correct a mistake.

Playback controls

Use the controls to hear audio files of dictation:

- Begin Playback
- Stop Playback or Text-to-speech
- Begin Rewind
- Begin Fast Forward
Chapter 4: Using the New DragonBar or Classic DragonBar

Read That button
Click the Read That button to have Dragon read back a recording of your dictation.

Transcribe button
Click the Transcribe button to open the , which you use to transcribe recordings of dictation made on portable recorders.

Open User Profiles button
Displays the name of the current User Profile to the right of the Transcribe button. Click on the User Profile name to open the . Note that this button appears only when Dragon is docked to the top or bottom of your screen.

Notes
- Unless your computer is equipped with a full-duplex sound card, it's not possible to stop playback by voice, because the computer can't hear speech when it's playing back dictation.
- Playback is available for documents dictated with Microsoft Word, Corel WordPerfect, and DragonPad. only until you close a document. After you close a document, Dragon NaturallySpeaking deletes the recorded dictation for that document.
- The "Show Extras Bar" voice commands toggle the state of the Extras toolbar. In other words, if you use this command to show the Extras toolbar, saying the command again hides the Extras toolbar.

The Text Control Indicator
The New DragonBar and Classic DragonBar both include a Text Control Indicator to show whether Dragon has Full Text Control for the selected text field.

Full Text Control includes Dragon applying spacing between words and capitalization at the beginning of sentences, as well as executing commands that quote text from your document (select <xyz>, correct <xyz>, insert after <xyz>, etc.). This functionality depends on Dragon's ability to constantly obtain from the text field information about its content—for instance, where words and sentences begin and end.

The Text Control Indicator is green (as shown) when the cursor is in a field for which Dragon has Full Text Control. Most standard text fields allow Full Text Control.

<table>
<thead>
<tr>
<th>New DragonBar</th>
<th>Classic DragonBar</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="New DragonBar" /></td>
<td><img src="image2.png" alt="Classic DragonBar" /></td>
</tr>
</tbody>
</table>

When Dragon doesn't have Full Text Control, the Indicator turns gray (as shown).
Without Full Text Control, the first word you dictate may not be capitalized, Dragon may not add spacing automatically when you insert a word, and commands that quote words from your text might not work. In these situations, you can say "cap" before the word you want capitalized, and you can say "space" when you want a space inserted. You also might want to use the keyboard and mouse to perform edits and corrections. Alternatively, you might want to use the Dictation Box.

For more information

For more information, see:

- Using the Dictation Box

### Displaying the DragonBar

There are different ways to display the New DragonBar and the Classic DragonBar. The options are different for each DragonBar.

#### The New DragonBar

To open the New DragonBar

1. On the Classic DragonBar, click the Dragon icon.

To open a menu

1. Say "Switch to DragonBar" to make the New DragonBar active.
2. Say the name of the menu and menu item that you want to open.

For example, say "Switch to DragonBar" then "Tools" then "Auto-Formatting Options."

Note for touchscreen users: if a DragonBar menu is open and you want to open another DragonBar menu by touch, touch and hold the menu you want to open.

To change the display mode

1. Say "Switch to DragonBar" to make the New DragonBar active.
2. Say "DragonBar" then the mode that you want:
Chapter 4: Using the New DragonBar or Classic DragonBar

**Classic DragonBar**
The New DragonBar closes, and the Classic DragonBar opens.

**Tray Icon only**
The New DragonBar is not visible on the screen. Only the microphone icon in the Windows system tray indicates that Dragon is running.

**Auto-collapse**
The New DragonBar shrinks to a smaller size automatically when you move the cursor away from it. This feature is helpful when you find that the New DragonBar covers too much of your screen. This option is selected by default.

Note: if you use a touchscreen computer, we recommend you turn off the Auto-collapse because it could cause you to inadvertently touch the microphone icon.

**To collapse the New DragonBar**
Click the Minimize icon (●), or say "Collapse DragonBar". Collapsing the New DragonBar shrinks it down to a smaller size, taking up less space on your screen.

**To expand the New DragonBar**
Click the Maximize icon (□), or say "Expand DragonBar". Expanding the New DragonBar reverts it to its normal size.

**The Classic DragonBar**

**To open the Classic DragonBar**
1. Say "Switch to DragonBar" to make the New DragonBar active.
2. Say "DragonBar" then "Classic DragonBar". The Classic DragonBar opens.

**To open a menu**
1. Say "Switch to DragonBar" to make the Classic DragonBar active.
2. Say the name of the menu and menu item that you want to open.

   For example, say "Switch to DragonBar" then "Tools" then "Auto-Formatting Options."

**To change the display mode**
1. Click the Dragon icon on the left side of the DragonBar or right-click anywhere on the DragonBar to open the DragonBar shortcut menu.
2. Select a display mode:

**DragonBar Docked to Top**

The DragonBar always stays at the top of the screen. This is the mode in which the DragonBar appears the first time you start Dragon NaturallySpeaking. Applies only to the Classic DragonBar.

**DragonBar Docked to Bottom**

The DragonBar always stays at the bottom of the screen. If the Windows taskbar is visible at the bottom of the screen, the DragonBar appears just above it. Applies only to the Classic DragonBar.

**Floating DragonBar**

The DragonBar appears in a window you can drag around the screen. Applies only to the Classic DragonBar.

**Clinging DragonBar**

The DragonBar "clings" to the top left of the active window. When you drag the active window to a new location on your screen, the DragonBar moves with it. In Cling mode, you do not see the Extras toolbar icon. Applies only to the Classic DragonBar.

**New DragonBar**

The Classic DragonBar closes, and the New DragonBar opens.

**Tray Icon Only**

The DragonBar is not visible on the screen. Only the microphone icon in the Windows system tray indicates that Dragon NaturallySpeaking is running.

**Always on Top**

By default, Dragon always appears "on top," meaning it is in the foreground of your computer display. For the Floating DragonBar, you can change the setting so that the DragonBar drops into the background like other window when you maximize or open a new window large enough to hide the current one. Applies only to the Classic DragonBar.

**Note**

When you set the DragonBar to "Always on Top" it covers parts of other Dragon NaturallySpeaking windows, such as the DragonPad and Help screens. If necessary, you can deselect "Always on Top" or move the windows around so that they are not obscured.

To return to the last DragonBar mode, right-click on the microphone icon and click Restore Previous DragonBar Mode.

**To switch between displays**

You can say "Switch To," "Change To," or "Select" and the name of the mode. For example, if the DragonBar is set to Docked to Top, you could say "Switch To Docked to Bottom" or "Change To Floating DragonBar" and so on.
Working with the New DragonBar or Classic DragonBar

You can use the New DragonBar or Classic DragonBar and get help with Dragon NaturallySpeaking using the following voice commands:
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Select a New DragonBar or Classic DragonBar menu item | 1. "Switch to DragonBar" to make the New DragonBar or Classic DragonBar active.  
2. The name of the menu you want to open. |
| Start the DragonPad word processor      | "Start DragonPad"                                                                                                                                 |
| Display Dragon NaturallySpeaking Help   | "Give Me Help"                                                                                                                                 |
| Display common voice commands for your current program, window, or text field | "What Can I Say"                                                                                                                                 |
| Switch the DragonBar mode               | "Switch DragonBar To" or "Select DragonBar" and the mode name ("Floating Mode," "Docked to Top Mode," "Docked to Bottom Mode," "Cling Mode," or "Tray Icon Only Mode")  
**Note:** Only the "Tray Icon Only Mode" command applies to the New DragonBar. All other mode commands apply to the Classic DragonBar. If you use these commands while the New DragonBar is open, the Classic DragonBar opens automatically. |
| Expand or collapse the New DragonBar    | "Expand DragonBar"  
"Collapse DragonBar" |
| Display the New DragonBar or Classic DragonBar when it is in Tray Icon only mode | "Open Dragon's tray menu" |
| Change the Classic DragonBar Always on Top setting | "Set DragonBar to Always On Top" or "Make DragonBar Always on Top"  
These commands toggle the state of the Classic DragonBar. In other words, if you use one of these commands to make the Classic DragonBar appear always on top and you then say the command again, the Classic DragonBar will be put into a state where it can be covered by other windows. |
### Chapter 4: Using the New DragonBar or Classic DragonBar

#### To | Say
---|---
**Note:** When you set the Classic DragonBar to "Always on top" it will cover secondary Dragon NaturallySpeaking windows, such as the DragonPad and Help screens. In these cases, you will have to turn off the "Always on top" state or move the windows around so that they are not obscured.

#### Exit Dragon

1. "Exit Dragon"
   - If you also have your User Profile open and have made corrections, performed acoustic training, changed an option, or made modifications in the Vocabulary Editor, Dragon asks if you want to save the changes.
2. Say "Yes" to save the changes.
   - You can use the "Exit Dragon" command from:
     - The Classic DragonBar Control menu (click the Dragon icon at the left).
     - The Classic DragonBar Profile menu.
     - The New DragonBar DragonBar menu.
Chapter 5: Using the Microphone

This section contains the following topics:

Choose an audio device ................................................................. 67
Position your microphone properly ............................................... 68

Choose an audio device

Use this screen to tell Dragon which type of speech device you'll be using. To use a different device later on, you can to your profile.

Click here for the Dragon Top 5s: Microphones

Use the top section to choose the audio device that you want to use. Dragon highlights the audio device that it thinks is the most likely.

Other available audio devices

Dragon lists other audio devices that you can use. For example, if your computer has an onboard mic but you have an external USB mic plugged in, the onboard mic will be listed here.

Dragon also lists the following devices; you will need additional hardware to use them:

Dragon Remote Microphone Application

Use the Dragon Remote Microphone application if you want to use a mobile device as a wireless microphone.

If you chose the Dragon Remote Microphone application, you must also install the Dragon Remote Microphone application on the mobile device. For more information, see Using a mobile device as a wireless microphone in the Dragon Help.

The Dragon Remote Microphone application supports the following devices:

- Apple iPhone 3GS and higher, iPad 1, 2, and 3, and iPod touch 4 and higher using iOS 4.2 and higher. For iOS devices, the app is available from iTunes and the App Store.

- Mobile devices and tablets using Android OS 2.2 and higher. For Android-based devices, the app is available from Google Play (formerly called the Android Market).

For more information about downloading and installing the application and the latest list of supported devices on Nuance.com, click here.
Use this section for details about selecting handheld recording choices. If your Dragon installation is configured to use with commands only, you won’t see this section.

Handheld or smartphone with recording application

Select this option if you’ll be dictating with a mobile device capable of storing digital recordings and transferring them to your computer.

Digital audio recorder (includes .wav, .mp3, .wma, .dss, .ds2)

Select this option if you’ll be dictating from a digital recorder.

You can only use unencrypted .dss or .ds2 files when creating a Profile with a recorder.

Notes

- If you switch between microphones you must rerun the audio check.
- Some editions of Dragon NaturallySpeaking allow you to have multiple audio sources in a profile, so you can benefit from ongoing personalization of your profile no matter which of your devices you're using. For example, with the same profile, you can dictate with a digital recorder (if your edition of Dragon supports transcription of recordings), a regular headset microphone, or a wireless microphone. For more information, see .

Position your microphone properly

Use this screen to help you position your microphone for optimal speech recognition. Positioning the microphone correctly is one of the most important things you can do to enhance recognition accuracy. If the microphone moves even slightly away from the optimal position, your recognition accuracy may significantly deteriorate.

Use the pictures and descriptions on the wizard screen and in this topic as guides for microphone positioning.

To position a headset microphone

- Adjust the headset so that it fits comfortably.
- Move the microphone element to the side of your mouth to avoid noise from breathing.
- Make sure that the microphone element is close to your mouth, but not touching it (about an inch from the side of your mouth).
- Confirm that the front of the microphone points toward your mouth. The front may be indicated by a colored dot, the word “Talk,” or some other label.
- Position the headset consistently every time you use it.

To position a handheld microphone or recorder

- Point the microphone element to the side of or below your mouth to avoid noise from breathing. Do not hold the microphone directly in front of your mouth.
- Hold the microphone in a comfortable position. Make sure not to hold it in an awkward, tiring position.
- Make sure that the microphone element is about 1 to 3 inches away from your mouth. You should keep the microphone distance in this range, but you don’t have to always keep the microphone at exactly the same distance.
- Hold the microphone so that the front points toward your mouth. Don’t talk into the side of the microphone.
- Hold the microphone consistently every time you use it. Be careful not to move the microphone or your head suddenly.
- Do not use a microphone stand or holder because it will be harder to keep a consistent position and the stand may conduct noise.
Chapter 6: Using the Dragon Learning Center

This section contains the following topics:

Using the Dragon NaturallySpeaking Learning Center ........................................ 71
The Dragon NaturallySpeaking Learning Center .................................................. 74

Using the Dragon NaturallySpeaking Learning Center

Use the Learning Center to see on the side of your screen sample commands and tips related to the program you are currently using. Its content changes as you switch between programs and windows. (See Learning Center contexts.)

The Learning Center appears automatically when you open a Profile (you can change this from the Miscellaneous tab of the Options dialog box). If the Learning Center is closed, you can open it through the Help menu or by saying a command such as "What can I say" or "Show Dragon Learning Center."

You can change the Learning Center’s font size, either by voice or through its right-click menu.

By default, the Learning Center is set to Floating; you can resize it and move it. If you prefer to not cover any window under it, you can choose to dock it to the side of the screen, in which case you can also choose to set it to Auto-hide.

Caution: if the area of the desktop below the Learning Center contains icons, docking the Learning Center will cause those icons to move, which could disrupt your desktop arrangement.

Controlling the Learning Center

You can use the following voice commands with the Learning Center, whether or not it's the active window (that is to say, whether or not it has focus).

Most commands require that the Learning Center be open.

To open one of Learning Center's panels or tabs, say "click" and its label.
<table>
<thead>
<tr>
<th>To</th>
<th>Say this</th>
<th>Or do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show the Learning Center</td>
<td>◀&quot;What can I say?&quot;&lt;br&gt;&quot;Dragon Learning Center&quot; or &quot;Dragon Sidebar&quot; (you can also precede this with &quot;Open&quot;, &quot;Launch&quot;, &quot;Start&quot;, &quot;Show&quot;, or &quot;Show Me&quot;)&lt;br&gt;&quot;Sample Commands&quot; or &quot;Command list&quot; (you can precede this with &quot;Open&quot;, &quot;Launch&quot;, &quot;Start&quot;, &quot;Show&quot;, or &quot;Show Me&quot;)&lt;br&gt;&quot;Switch to Learning Center&quot;</td>
<td>Select Learning Center from the DragonBar's Help menu.</td>
</tr>
<tr>
<td>Show the MyCommands tab</td>
<td>&quot;Click My Commands&quot;</td>
<td>Select the MyCommands tab on the Learning Center.</td>
</tr>
<tr>
<td>Dock the Learning Center to the right</td>
<td>&quot;Learning Center dock right&quot;</td>
<td>Right-click on the Learning Center and select Dock right.</td>
</tr>
<tr>
<td>Dock the Learning Center to the left</td>
<td>&quot;Learning Center dock left&quot;</td>
<td>Right-click on the Learning Center and select Dock left.</td>
</tr>
<tr>
<td>Change the font size of the Learning Center</td>
<td>&quot;Learning Center Font [Small</td>
<td>Medium</td>
</tr>
<tr>
<td>Float the Learning Center</td>
<td>◀&quot;Learning Center float&quot;&lt;br&gt;or&lt;br&gt;&quot;Learning Center undock&quot;</td>
<td>Right-click on the Learning Center and select Floating.</td>
</tr>
<tr>
<td>Auto-hide the Learning Center (not available in Floating)</td>
<td>&quot;Learning Center auto-hide&quot;</td>
<td>Right-click on the Learning Center and select Auto-hide.</td>
</tr>
<tr>
<td>Disable auto-hide (not available in Floating)</td>
<td>&quot;Learning Center stop hiding&quot;</td>
<td>Right-click on the Learning Center and deselect Auto-hide.</td>
</tr>
<tr>
<td>To</td>
<td>Say this</td>
<td>Or do this</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set the Learning Center to Always on Top</td>
<td>With the Learning Center <strong>active</strong>, right-click it and say &quot;Always on Top&quot;</td>
<td>Right-click on the Learning Center and select Always on Top</td>
</tr>
<tr>
<td>Turn off Always on Top</td>
<td>With the Learning Center <strong>active</strong>, right-click it and say &quot;Always on Top&quot;</td>
<td>Right-click on the Learning Center and deselect Always on Top.</td>
</tr>
<tr>
<td>Increase the Learning Center width by 5 per cent</td>
<td>&quot;Learning Center wider&quot;</td>
<td>With the Learning Center <strong>active</strong>, press the key combination &lt;ALT+W&gt;. (You can also click and drag the left border.)</td>
</tr>
<tr>
<td>Decrease the Learning Center width by 5 per cent</td>
<td>&quot;Learning Center thinner&quot;</td>
<td>With the Learning Center <strong>active</strong>, press the key combination &lt;ALT+T&gt;. (You can also click and drag the left border.)</td>
</tr>
<tr>
<td>Print Learning Center commands</td>
<td>N/A</td>
<td>Right-click on the Learning Center and select Print.</td>
</tr>
<tr>
<td>Show the Learning Center Help</td>
<td>&quot;Learning Center Help&quot;</td>
<td>Click the question mark icon at the top right of the Learning Center.</td>
</tr>
<tr>
<td>Close the Learning Center</td>
<td>With the Learning Center <strong>active</strong>, say ▶ &quot;Learning Center close&quot; or ▶ &quot;Close window&quot;</td>
<td>▶ Right-click on the Learning Center and select Close. ▶ Click the x at its top right corner.</td>
</tr>
</tbody>
</table>

**Learning Center contexts**

Here is the list of programs and windows for which the Learning Center has specific content:

- **Desktop and Windows Explorer**
- Dragon windows: **DragonBar, DragonPad, Dictation Box**, Spelling window (see Dragon Help), **Command Browser, Vocabulary Editor**
- **Microsoft Word, Microsoft Excel, Microsoft Outlook**, .. Please see the Dragon Help for Microsoft PowerPoint, and Microsoft InfoPath
- **WordPad**
- .Corel WordPerfect (see Dragon Help)
- .Lotus Notes (see Dragon Help)
- OpenOffice.org Writer (see Dragon Help)
- **Internet Explorer, Google Chrome, and Mozilla Firefox**
- **Global**
If you click in an application for which Dragon does not have specific commands (for example, Notepad, Skype, or iTunes), the Learning Center displays general tips, plus commands available at all times (these are called “global commands”) and commands for controlling the Learning Center itself.

The Dragon NaturallySpeaking Learning Center

You can use the Learning Center to see advice and commands related to your active application. The contents of the Learning Center change when the focus changes to another window. For instance, if you click on the DragonBar, the Learning Center will show content relevant to the DragonBar, and if you click in Internet Explorer, the Learning Center will show content relevant to Internet Explorer. See Using the Learning Center.

The Learning Center has two tabs. The first tab displays an accordion system of expandable panels containing commands and advice (its top panel is open by default and contains essential advice). The second tab, labeled MyCommands, is for custom commands (if available in your edition of Dragon).

To open each panel in the Learning Center, say “click” and its label. Similarly, to click a tab, say "click" followed by its label.
Learning Center

Microsoft Mail    MyCommands

+ The basics
+ Shortcut commands
+ Navigating
  ~ Manage e-mail

Manage e-mail
Delete message
Copy this message to a folder
Mark the message as unread
Click Reply
Open message
Forward message

Using the selected email
Reply to this
Click Reply
Reply to all?
Forward this
Email the selection to...
Delete message
Mark it as unread
Move [this] to <name> folder
Move this to a folder
Print this

Tip: You can say “mail” or “email” instead of “message.”

+ Contacts and Calendar

Interactive Tutorial    Dragon on the web
Chapter 6: Using the Dragon Learning Center

Note

If you dock the Learning Center, the icons on the desktop may move, which could disrupt your desktop arrangement.
Chapter 7: Dictating Text

This section contains the following topics:

- Dictation Basics ................................................................. 77
- Undoing actions ................................................................. 78
- Correcting text errors as you dictate .................................. 79
- Dictation commands ......................................................... 80
- Typing or spelling text ....................................................... 81
- Spelling words ................................................................. 82
- Dictating numbers ............................................................ 84

Dictation Basics

Dictate to Dragon NaturallySpeaking much as you would dictate to a person transcribing your dictation. By default you must explicitly say most punctuation and capitalization other than for proper names or at the beginning of a sentence. You can have Dragon NaturallySpeaking automatically insert commas and periods in most situations by selecting the "Automatically add commas and periods" box on the Auto-formatting dialog box. For more information, see Dictating punctuation and symbols and Dictation commands.

Click here for Dragon's Top 5s: "Dictation"

The following table describes some basic dictation commands.

To start dictating, just say whatever you want to say, speaking normally in phrases. Then:

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start a new paragraph (press the Enter key twice)</td>
<td>&quot;New Paragraph&quot;</td>
</tr>
<tr>
<td>Start a new line (press the Enter key once)</td>
<td>&quot;New Line&quot;</td>
</tr>
<tr>
<td>Enter punctuation marks, such as &quot;!&quot;</td>
<td>The name of the punctuation mark, such as &quot;exclamation point&quot;</td>
</tr>
<tr>
<td>Dictate symbols or special characters such as &quot;®&quot;</td>
<td>The standard name of the symbol, such as &quot;registered sign&quot;</td>
</tr>
</tbody>
</table>

Complete listing of dictation commands
Click on the following links for more information about common dictation tasks:

- [Dictating e-mail and Web addresses](#)
- [Undoing actions](#)
- [Moving the cursor](#)

*Working in Programs* on page 138

In the Dragon Help, see:

- Dictating in programs
- Dictating punctuation and symbols
- Dictating proper and place names
- Dictating hyphenated and compound words
- Dictating acronyms and abbreviations
- Dictating a bulleted list
- Replacing what you last dictated

### Undone actions

You can reverse the result of a command or dictation in the following ways:

To undo most actions

- Say "Undo That," "Undo Last Action," or just "Undo."

**Example:**

To undo the command "Italicize That," say "Undo That."

To undo dictation

- Say "Scratch That."

**Example:**

To remove text just after you dictated it, say "Scratch That."

**Notes**

- You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.
- The "Undo That" and "Undo Last Action" commands send an undo (CTRL+z) command to the active program. The result of the command depends on which program is active and how it handles the undo command. For example, if you say "Undo That" twice in a row in the DragonPad window, the second Undo reverses the first command and restores the original dictation. Other programs may behave differently.
- The Accuracy Center provides a central location for taking advantage of all the Dragon NaturallySpeaking tools available to ensure excellent recognition. For more information, see [Using the Accuracy Center](#).
Correcting text errors as you dictate

Use the procedures in this topic if you notice that Dragon misrecognizes a word or words while you are dictating. When you correct errors, Dragon NaturallySpeaking learns not to make the same mistakes again.

To correct a word or phrase with the Correction menu

1. Say "Select <text>,” where text is the incorrect word or phrase. If the error is in the last thing you said, you can just say "Select That." (Also see Tips for selecting text). Dragon NaturallySpeaking highlights the word or phrase, and the Correction menu appears.

2. If the correct word or phrase is on the list, start spelling to choose it, or say "Choose" and the number of that choice. For example, say "Choose 2." Do not say "Choose Numeral Two" or Dragon NaturallySpeaking will transcribe the phrase as the text "Choose Numeral Two" or "Choose 2" depending on how you set the number formatting options on the Auto-formatting dialog box.

3. If the word or phrase you want is not on the list, spell the word, or say "Spell That" and spell the word letter by letter.

Dragon's Smart Format Rules box may appear when you correct auto-formatted alphanumeric text using the Correction command, the Spelling window, or the keyboard. For details, see Using Smart Format Rules and Setting Auto-Formatting Options.

The Spelling window appears. You can use this dialog box to spell or type the correct word.

Notes

- Dragon also learns from your typing – if you use the keyboard to correct a misrecognized word, Dragon learns from the correction and can use the word the next time you dictate it.

- The Accuracy Center provides a central location for taking advantage of all the Dragon NaturallySpeaking tools available to ensure excellent recognition. For more information, see Using the Accuracy Center.

- The Correction tab of the Options dialog box lets you control the behavior of the Correction menu, including the commands that make it appear.

- If you would rather not see the Correction menu every time you select text, you can turn it off. On the Correction tab of the Options dialog box, clear the box that says "Select' commands bring up Correction menu." Then click Apply.

- If you want to open the Spelling window when you start to correct a word or phrase, select "Correct commands bring up Spelling window" on the Correction tab of the Options dialog box.

- If you select a phrase to correct that includes punctuation added to the sentence automatically, the list of corrections that appears in the Correction menu will include a version without the automatically inserted punctuation.

- In some applications, you may have difficulty revising selected text. In this case, you may need to use the Dictation Box. Just select the text you want to revise and say "Show Dictation Box” or "Edit Selection.”
Dictation commands

When you are dictating, you can say the following dictation commands – also referred to as "in-line" commands – without pausing.

All the dictation commands and their pronunciation can be seen in the Vocabulary Editor.

<table>
<thead>
<tr>
<th>Say</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;new line&quot;</td>
<td>Press the Enter key once</td>
</tr>
<tr>
<td>&quot;new paragraph&quot;</td>
<td>Press the Enter key twice, capitalize next word.</td>
</tr>
<tr>
<td>&quot;cap &lt;word&gt;&quot;</td>
<td>Type &lt;word&gt; with an initial capital</td>
</tr>
<tr>
<td>or &quot;cap next &lt;word&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;caps on&quot;</td>
<td>Start typing words with initial capitals</td>
</tr>
<tr>
<td>&quot;caps off&quot;</td>
<td>Stop typing words with initial capitals</td>
</tr>
<tr>
<td>&quot;all caps &lt;word&gt;&quot;</td>
<td>Type &lt;word&gt; in all uppercase</td>
</tr>
<tr>
<td>&quot;all caps on&quot;</td>
<td>Start typing words in all uppercase</td>
</tr>
<tr>
<td>&quot;all caps off&quot;</td>
<td>Stop typing words in all uppercase</td>
</tr>
<tr>
<td>&quot;no caps &lt;word&gt;&quot;</td>
<td>Type &lt;word&gt; in all lowercase</td>
</tr>
<tr>
<td>&quot;no caps on&quot;</td>
<td>Start typing words in all lowercase</td>
</tr>
<tr>
<td>&quot;no caps off&quot;</td>
<td>Stop typing words in all lowercase</td>
</tr>
<tr>
<td>&quot;no space &lt;word&gt;&quot;</td>
<td>Do not put a space before &lt;word&gt;</td>
</tr>
<tr>
<td>&quot;no space on&quot;</td>
<td>Stop putting spaces between words</td>
</tr>
<tr>
<td>&quot;no space off&quot;</td>
<td>Start putting spaces between words</td>
</tr>
<tr>
<td>&quot;numeral&quot;</td>
<td>Enter the next numbers stated as Arabic numerals (1,2,3 ...)</td>
</tr>
<tr>
<td>&quot;Roman numeral&quot;</td>
<td>Enter the next numbers stated as Roman numerals (i, ii, iii ...)</td>
</tr>
</tbody>
</table>

Notes

- When you are in Dictation mode, Dragon NaturallySpeaking interprets everything you say as dictation and only Dictation Commands are recognized. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate without looking at the words Dragon transcribes. Say "Start Dictation Mode" or "Dictation Mode On."
- Dragon can confuse the command for capitalization (cap) with the word cap. In order to dictate the word "cap", as in "I bought myself a new baseball cap.", you must first delete the dictation command “cap” with the Vocabulary Editor.

To do this, open the Vocabulary Editor from the Vocabulary menu of the New DragonBar or Classic DragonBar, then select the "Words with spoken form only" in the
"Display" drop-down menu and choose the spoken form for "cap" then click "Delete", and click "Close."

Now try dictating "baseball cap" and you will see that Dragon recognizes both words and displays them properly.

- The capitalization and spacing modes are automatically canceled if you move around your document.
- If you move the cursor (insertion point) by mouse or keyboard, or change windows, the next word you say will not be capitalized. You may need to capitalize the word manually and insert a space.
- You can enable or disable some Dragon's capitalization commands by setting the "Caps Lock key overrides capitalization commands" option in the Auto-formatting dialog box.

**Typing or spelling text**

In the Spelling window, you can use the keyboard to enter words as well as say the letters of the words. You can spell continuously or you can pause between letters. As you type or say each letter, the list of alternatives changes. If the text you want appears before you finish, you can simply choose it.

**To type or spell text**

1. Type or say the letters of the word(s).
2. If the text you want appears in the list, choose it. For example, say "Choose 2."
3. If necessary, type or spell the word(s) completely.
4. Say "Click OK."

The Spelling window closes and the text is entered in your document. If you had selected text to correct, the new text now replaces the old text.

**Note**

The "Undo That" command is not available in the Spelling window. If you need to correct a dictation error by voice while you are using the Spelling window, you may use the "Scratch That," "Backspace," or "Delete" commands.
Voice commands that work in the Spelling window

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose &lt;1-9&gt;</td>
<td>Chooses a number from the list of alternative spellings</td>
</tr>
<tr>
<td>Select &lt;1-9&gt; Edit &lt;1-9&gt;</td>
<td>Selects a line from the list of choices in the Spelling window and puts it in the edit box. You can then change the text either by voice or typing.</td>
</tr>
<tr>
<td>Or Modify &lt;1-9&gt;</td>
<td></td>
</tr>
<tr>
<td>Select last/next &lt;number&gt; characters</td>
<td>Selects the specified number of characters</td>
</tr>
<tr>
<td>Move right/left &lt;number&gt; characters</td>
<td>Moves the text insertion point</td>
</tr>
<tr>
<td>Select That</td>
<td>Selects the last utterance (word or letter), or the whole line of text if there has been no previous selection</td>
</tr>
<tr>
<td>Delete/Scratch That</td>
<td>Deletes the selected text, or the whole line of text if there has been no previous selection</td>
</tr>
<tr>
<td>Go To End/Beginning of Line</td>
<td>Moves the text insertion point</td>
</tr>
</tbody>
</table>

Notes

- Typing letters into the Spelling window searches Dragon's Vocabulary for a matching word. If you must type the full word, it is because it is not in the active Vocabulary or the backup dictionary. When you save a User Profile, any words you add in the Spelling window are added as new words to the active Vocabulary.
- If one of the recognition alternatives is nearly correct, you can say "Select" and the number of the alternative. The alternative text appears in the text box where you can edit it.
- The voice command "Delete Next/Previous Word" does not work in the Spelling window.

Spelling words

If a word or phrase is not currently in Dragon's Vocabulary, you can spell it in the Spelling window, and add it to Dragon NaturallySpeaking's Vocabulary. Words you spell directly into the document, while the Spelling window is closed, are not added to the Vocabulary. In addition, you can teach (or "train") Dragon NaturallySpeaking to recognize how you pronounce the word or phrase you spell.
In some cases, you may not know that a word is not in the active Vocabulary until Dragon NaturallySpeaking fails to recognize it correctly. Whether you are spelling a word as part of your dictation or correcting a misrecognition, the process is the same.

To spell a word or phrase

- When you want to add a new word to the Vocabulary, say "Spell" or "Spell That" (immediately after a recognition error) and the characters of the word or words you want to spell. Say the characters continuously and quickly, not one at a time.

Note

The "Undo That" command is not available in the Spelling window. If you need to correct a dictation error by voice while you are using the Spelling window, you may use the “Scratch That,” “Backspace,” or “Delete” commands.

For a list of the characters you can spell with the "Spell" or "Spell That" commands, see Spelling characters.

If you use the "Spell That" command, saying the characters immediately is optional; you can simply wait for the Spelling window, to open before you begin spelling. Spelling words while the Spelling window is open allows you to confirm that the word is correct before it appears in your document and allows you to train the pronunciation of the word. For information on training a word that you have spelled, see the topic Training words from the Spelling window.

For previously dictated text, select the word or words you want to correct, then say "Spell That" followed immediately by letters.

Notes

- Normally, the Spelling window, does not appear when you use the "Spell" command. You can make it appear by selecting the "Spell commands bring up Spelling window" option on the Correction tab of the Options dialog box.
- While you are spelling words, you must say "cap" before each character you want to capitalize. Pause briefly after saying the capital letter and before you say the next letter.
- You can say "Double" before any alphabetic character to enter two of the same characters. For example, say "Double a" to enter "aa." You can also say "Double Zulu" to enter "zz." You cannot, however, say "Double u" to get two "u" characters (and not "w"). In this case, you can say "Double Letter u."
- You cannot say the normal forms of letters (for example "A") and their alpha-bravo forms (for example "Zulu") together in a single breath ("A Zulu"). You can mix them if you pause before you change the spelling format.
- In version 13.x, within normal dictation, Dragon no longer recognizes its built-in alternate pronunciations of letters (alpha, bravo, Charlie, delta, etc. which some people call “military alphabet” or “phonetic alphabet”) -- therefore, saying “bravo Charlie” will be transcribed as “bravo Charlie.” To avoid ambiguity with the corresponding words, these letter pronunciations are reserved for spelling out: this means when one is in the Spelling Window, when in Spell Mode, and when giving a Spell command – for example, the command “spell space Charlie alpha papa”.
- You can say nearly any character of the standard Windows character set. See the See Also below for a full list of the characters you can say.
If you are planning to do a large amount of spelling in a document, consider turning Spell Mode on (say “Spell Mode” or click Modes > Spell Mode). In Spell Mode, Dragon NaturallySpeaking tries to interpret everything you dictate as letters.

Dictating numbers

In most cases you can dictate numbers, including postal codes, as you normally say them. If you want to dictate only numbers, as, for example, when dictating in a spreadsheet program, you can turn on Numbers mode.
<table>
<thead>
<tr>
<th>To enter</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>&quot;four&quot; or &quot;numeral four&quot;</td>
</tr>
<tr>
<td>23</td>
<td>&quot;twenty three&quot;</td>
</tr>
<tr>
<td>179</td>
<td>&quot;one hundred seventy nine&quot;, &quot;one hundred and seventy nine,&quot; or &quot;one seventy nine&quot;</td>
</tr>
<tr>
<td>5423</td>
<td>&quot;five thousand four hundred twenty three&quot;</td>
</tr>
<tr>
<td>5.423</td>
<td>&quot;five point four twenty three&quot;</td>
</tr>
<tr>
<td>142,015</td>
<td>&quot;one hundred forty two thousand and fifteen&quot;</td>
</tr>
<tr>
<td>127,400,042</td>
<td>&quot;one hundred twenty seven million four-hundred thousand forty-two&quot;</td>
</tr>
<tr>
<td>127 billion</td>
<td>&quot;one hundred twenty seven billion&quot;</td>
</tr>
<tr>
<td>0.03</td>
<td>&quot;zero point zero three&quot; or &quot;oh point oh three&quot;</td>
</tr>
<tr>
<td>2 3/4</td>
<td>&quot;two and three fourths&quot;</td>
</tr>
<tr>
<td>11/32</td>
<td>&quot;eleven over thirty two&quot;</td>
</tr>
<tr>
<td>565-5000</td>
<td>&quot;five six five five thousand&quot;</td>
</tr>
<tr>
<td>781-565-5000</td>
<td>&quot;seven eight one five six five five thousand&quot;</td>
</tr>
<tr>
<td>$45</td>
<td>&quot;forty five dollars&quot;</td>
</tr>
<tr>
<td>$99.50</td>
<td>&quot;ninety nine dollars and fifty cents&quot;</td>
</tr>
<tr>
<td>€1.7 billion</td>
<td>&quot;One point seven billion Euros&quot;</td>
</tr>
<tr>
<td>8:30 p.m.</td>
<td>&quot;eight thirty pm&quot;</td>
</tr>
<tr>
<td>200 kg</td>
<td>&quot;200 kilograms&quot;</td>
</tr>
<tr>
<td>50 meters</td>
<td>&quot;50 meters&quot;</td>
</tr>
<tr>
<td>May 15, 2003</td>
<td>&quot;May fifteen comma two thousand three&quot;</td>
</tr>
<tr>
<td>MMIV</td>
<td>&quot;Roman numeral two thousand four&quot;</td>
</tr>
<tr>
<td>iii (lowercase Roman)</td>
<td>&quot;Roman numeral three&quot; &quot;no caps that&quot;</td>
</tr>
</tbody>
</table>
To enter | Say
--- | ---
Boston, MA 02460 | "Boston Massachusetts 02460"
Oakland, CA 99077 | "Oakland California 99077"

**Notes**

- Most of these examples only work as shown when the appropriate number formatting options are selected on the Auto-formatting dialog box.
- If you want a comma in a four-digit number, you must speak it explicitly. Numbers with five or more digits automatically include commas.
- To force recognition of digits as numerals instead of text without using the Numbers Mode, say "Numeral" before you say the digit, for example, say "Numeral Three" to get 3.
- You can use or omit the word "and" as part of a number. For example, say "one hundred fifty" instead of "one hundred and fifty" to get the number 150.
- You can use "oh" and "zero" interchangeably to get 0.
- The way Dragon NaturallySpeaking formats the currency symbol, the thousand separator, the decimal separator, the negative symbol, and the time separator depends on the configuration of the Regional Settings (or on some versions of Windows, Regional Options) in the Windows Control Panel. For these numbers to be formatted according to the conventions of the language you are dictating, you must make sure that the Windows Regional Settings match the language.
- You can set the currency symbol and format that Dragon NaturallySpeaking uses by selecting the "ISO currency codes" option on the Auto-formatting dialog box. Dragon NaturallySpeaking then uses the currency character and format specified on the Regional Options tab of the Regional and Languages Options tool in your Windows Control Panel. If you are using the Classic Start menu, you can open your Windows Control Panel by clicking Start on the Windows Taskbar, pointing to Settings, and then clicking Control Panel.
- You can change the way Dragon NaturallySpeaking formats numbers on the Auto-formatting dialog box by turning on or off the different formatting options available on the tab.
- You can change the way Dragon NaturallySpeaking formats Canadian and UK postal codes on the Auto-formatting dialog box by turning on or off the "Street addresses" option. For example, with the option on, format a postal code in London by saying "London Comma W Two Four R J" to enter London, W2 4RJ; and format a postal code in Toronto by saying "Toronto Comma Ontario M Five H Two L Two" to enter Toronto, Ontario M5H 2L2. You must reload your User Profile before a change to postal code formatting will take effect. To reload a User Profile, click Open User Profile on the Profile menu to open the Open User Profile dialog box. Make sure the correct User Profile is selected (the current User Profile is selected by default), and click Open.
- Dragon can auto-format text and numbers using standard writing conventions or apply Word Properties to words as you dictate. For information about these settings, see Auto-formatting dialog box and The Word Properties dialog box.
Dragon’s Smart Format Rules appear when you correct auto-formatted alphanumeric text or Word Properties using the Correction menu, the Spelling window, or the keyboard. For details, see Using Smart Format Rules and Setting Auto-Formatting Options.
Chapter 8: Using the Dictation Box

This section contains the following topics:

Using the Dictation Box ................................................................. 88
Dictation Box Settings ............................................................... 91

Using the Dictation Box

BEGIN_NONMED

Normally you can dictate and use Dragon NaturallySpeaking voice commands in any text window of any application. However, you may occasionally find an application or a specific window in an application where you cannot dictate and/or where some voice commands won’t work or won’t work consistently. These exceptions are called "unsupported applications" or unknown text fields.

Using Dictation Box in unsupported applications

The Dictation Box opens automatically if Dragon notices that you are trying to dictate in an unsupported application or window within an unsupported application.

Turning off the Dictation Box

If you don’t want Dragon to display the Dictation Box in unsupported applications

1. On the DragonBar, select Tools > Options > Miscellaneous.
2. Click or say "Use the Dictation Box for Unsupported Applications" to clear the checkmark from the box.
3. Click OK to apply your changes to the current session. When you save your user profile, the settings will be saved for future dictation sessions.

Unsupported applications

Some examples of unsupported applications would be presentation or page layout or graphics design software like Adobe Photoshop. Here are some examples of known issues in unsupported applications:

- Dictating into a complex Lotus Notes document sometimes makes Dragon NaturallySpeaking hang or exhibit other abnormal behavior.
Some Microsoft Outlook users may find that the Full Text Control editing capability does not always work.

Some applications, such as Netscape, are not supported for Full Text Control editing at all.

Transferring your text

When you are ready to move your dictation from the Dictation Box to the unsupported application, say "Transfer" or click the Transfer button to transfer the text into that application.

**Note:** The Dictation Box works for all applications that can accept standard keyboard shortcuts for Windows Clipboard operations. In some applications that do not accept these commands, your text may be lost or changed when you transfer text in and out of the Dictation Box. Test your application before you start and, if you lose text when you try to transfer text to the application, try different selections under the Copy and Paste options (see [Dictation Box Settings](#)).

The Dictation Box can transfer text in plain or Rich Text Format (RTF). For more information on using fonts in the Dictation Box, refer to Using Fonts in Dictation Box in the Dragon Help.

**Note:** You cannot transfer the audio that corresponds to the text from the Dictation Box to another application. The audio is available only while the Dictation Box is open and only before you dictate the "Transfer" voice command.

**The Full Text Control Indicator**

The Dragon bar includes a Full Text Control indicator that turns green when you are in an application or window where all of Dragon NaturallySpeaking's functionality is supported.

When you are in an unknown text field, the Full Text Control indicator goes out, indicating that you may have some difficulty selecting and editing dictated text. Also, when you start dictating into an unknown text field, the Dragon Bar will display a message saying "Unknown text field; consider using 'show Dictation Box' - See Help."

The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after <xyz>...) work thanks to a functionality called Full Text Control. This functionality depends on Dragon's ability to constantly obtain information from the text field about its content—for instance, in order to know where words and sentences begin and end, so Dragon can apply spacing between words and capitalization at the beginning of sentences. Most standard text fields allow full Full Text Control capabilities.

If you have difficulty in dictating or correcting in one of these unknown text fields, use the Dictation Box.

For more information, see [The Full Text Control Indicator](#).

**Dictating in unknown text fields**

1. Place your cursor where you want to put the text
2. Start the Dictation Box in one of several ways:
   - Say "Show Dictation Box"
   - Select Tools > Dictation Box from the Dragon Bar
   - Use CTRL + SHIFT + D. To change the default hot key(see the Dragon NaturallySpeaking Options dialog box).
3. When the Dictation Box displays, you can dictate and edit text inside the Dictation Box using all of Dragon NaturallySpeaking's commands.

4. Once you have finished dictating and editing the text, say or click "Transfer." The text you dictated in the Dictation Box is transferred to the application. The Dictation Box then closes.

Editing text in unknown text fields

To edit text already in the unknown text field:

1. Select the text in the unknown text field using voice commands or your keyboard and mouse.

2. Copy the text to the Dictation Box for editing in one of these ways:
   - Say "Edit Selection"
   - Say "Show Dictation Box"
     Note: To copy all the text in an application into the Dictation Box for editing say "Edit All"
   - Select Tools > Dictation Box from the Dragon Bar
   - Use CTRL + SHIFT + D. To change the default hot key, see The Options dialog box.

3. The selected text displays in the Dictation Box.

4. Once you have finished dictating and editing the text, say or click "Transfer." The text you dictated in the Dictation Box is transferred to the application.

Defining how the Dictation Box works in different applications

You can define how the Dictation Box copies and pastes text for each application where it's needed. For example, you can have different copy and paste settings for Microsoft PowerPoint and Corel WordPerfect.

To define how the Dictation Box works in a specific application:

1. Start the application or specific window and place your cursor in the application.

2. Start the Dictation Box

3. Click the "Settings..." button in the Dictation Box.
   The Dictation Box Settings dialog box displays a section named "Settings for application <application name>" where the <application name> is the name of the current application.

For more information, see Dictation Box Settings.

Unexpected behavior or text in the Dictation Box

Sometimes the Dictation Box misunderstands the context of what you're working on and it displays text you didn't dictate, and that you can't edit. This can happen when the focus of the application you're using is on a field you can't edit and:

- you intentionally open the Dictation Box, or
- you speak into your microphone, prompting the Dictation box to open automatically

For example, if you have your e-mail application open with an item in your message list selected, the Dictation Box may display the header text of that message.

If this happens, just go to the Dictation Box and say or click "Cancel" to close it.
Dictation Box Settings

You open the Dictation Box by selecting Tools > Dictation Box on the New DragonBar or Classic DragonBar.

When you are in Anchored mode, you can define your settings from the Dictation Box Settings window, where you can configure how the Dictation Box copies text from and pastes text into each application where you plan to use the Dictation Box. For example, you can have different copy and paste settings for Microsoft PowerPoint and Corel WordPerfect.

To open the Settings dialog box, click the Settings button inside the Dictation Box.

**Note:** If you are not in Anchored mode, you won't see the Settings button. Instead, you can configure the Dictation Box by selecting Tools > Options and then going to the Dictation Box tab.

**Note:** You can have multiple Dictation Boxes open at one time and can have different settings for using the Dictation Box with each application you use.

Font

The Font setting lets you change the font used for the contents of the Dictation Box. To change the font:

1. Click "Change Font..."
2. Set the font, style, and size under Font, Font style, and Size.
3. Under Effects, you can choose a color from the drop-down list and/or choose Strikeout or Underline.
4. Click OK to save the font change.

**Notes:**

- To set the font to the default, click "Default Font" and the font type and size change to Arial 10-point.
- When you copy text into the text box, it displays in the same font as the originating application.

Window Position

You can define where the Dictation Box appears:

- **Anchor:** Select this if you want the Dictation Box to appear at the location where it was last closed. If you drag the Dictation Box to a new location and then close it, it will display at that location when you restart the Dictation Box.

- **Automatically position the Dictation Box near the cursor:** This option causes the Dictation Box to appear as close to the cursor location as is practical.

Settings for application <application name>

You can define how the Dictation Box copies and pastes text in each application where it's used. For example, you can have different copy and paste settings for Microsoft PowerPoint and Corel WordPerfect.
The Dictation Box works for all applications that can accept standard keyboard shortcuts for Windows Clipboard operations. In some applications that do not accept these commands, your text may be lost or changed when you transfer text in and out of the Dictation Box.

The Copy options define what kind of copied text the Dictation Box can receive from an application.

Test your application before you start and, if you lose text when you try to transfer text to the application, try different selections under the Copy and Paste options, detailed below:

**Copy**

- **Do not copy**: Does not copy any text from the application when the Dictation Box is started.
- **Type keys <Ctrl+C>**: Uses Ctrl+C to copy text from the application.
- **Use Windows Copy Command**: Uses the Windows copy command to copy text from the application.

**Paste**

- **Type keys <Ctrl+V>**: Uses Ctrl+V to copy text from the Dictation Box to the application.
- **Use Windows Paste Command**: Uses the Windows Paste Command to copy text from the Dictation Box to the application.
- **Simulate keystrokes**: Sends keystrokes from the Dictation Box to the application. Use "Simulate keystrokes" if the other methods of pasting text do not work.

**Show character count**

Select this check box to have the character count display the number of characters in the Dictation Box.

**Keep transferred text in clipboard when the Dictation Box is closed**

Check this option to have Dragon NaturallySpeaking hold the text dictated into the Dictation Box in the Windows clipboard either after you transfer the text unsuccessfully (paste fails) or after you have closed the Dictation Box (should any text remain in the Dictation Box).

As long as you have chosen **Type Keys <Ctrl+V>** or **Use Windows Paste Command** under **Paste options**, checking this check box protects you from losing any text when:

- You've transferred with the Transfer voice command and it fails to paste into the application where you have placed the cursor
- Text still remains in the Dictation Box when you close it

If you do not select this option, the text dictated into the Dictation Box that has not been transferred will be lost when you close the Dictation Box.

When you have selected this check box, if the transfer fails, you do not lose the text, because the text is stored temporarily in the Windows clipboard. If the application you tried to transfer the text to fails to receive the text, you can open another application and try using the Windows paste command to paste the text from the clipboard.

**Restore Defaults**

This option restores all Dictation Box settings to their defaults.
For more information

For more information, see:

- Using the Dictation Box
- The Full Text Control Indicator
Chapter 9: Using DragonPad

This section contains the following topics:

- About DragonPad ................................................................. 94
- Changing the way text wraps on your screen ................................. 94

About DragonPad

DragonPad is Dragon NaturallySpeaking's built-in word processor, which is optimized for dictation. DragonPad includes basic text formatting features as well as the ability to save and print documents.

You can use DragonPad when you do not need the capability of a full-featured word processor. When you have finished dictating, you can say "Copy All To Clipboard" to copy your text to the Clipboard and "Paste That" to copy the text from the Clipboard into any other program.

Although it is similar to WordPad, DragonPad is customized for use with Dragon NaturallySpeaking and contains speech recognition features that are not available in WordPad.

Changing the way text wraps on your screen

As you are dictating in DragonPad, you may want to change the way text wraps in the DragonPad window.

To change the way text wraps on your screen

1. On the View menu, click Settings.
2. In the Word Wrap group of the Text or the Rich Text tab, select the wrapping option you want. You can select No wrap, Wrap to window, or Wrap to ruler.
3. Click OK.

Notes

- The wrapping options affect only how text appears on your screen. When printed, the document uses the margin settings specified in Page Setup.
You can set different word wrap options for the text format in which you save the document: text-only (TXT) or rich text format (RTF).
Chapter 10: Making Corrections

This section contains the following topics:

- Correcting dictation - workflow ................................................................. 96
- Correcting text - quick reference ................................................................. 100
- Choosing the correct text ............................................................................ 101
- Correcting misrecognized commands .......................................................... 102

Correcting dictation - workflow

There are a number of ways you can correct the misrecognitions in a document. The following techniques describe the most basic methods. You can combine these techniques in any manner that suits your working style.

Click here for Dragon’s Top 5s: "Correcting text"

Correcting using the Correction menu (easiest)

To correct text using the Correction menu

1. Do any of the following:
   - Say "Correct that" after the last thing you dictated.
   - Say "Correct <xyz>" or "Select <xyz>" to have Dragon select any editable text in the current document or e-mail message.
   - Say "Correct <abc> through <xyz>" to have Dragon select any editable range of text in the current document or e-mail message.
   - Press the correction hot key, normally the Minus key (-) on the numeric keypad.
The Correction menu opens.*

2. Choose one of the items from the Correction menu or dictate the replacement content.

If you choose one of the alternatives on the Correction menu, Dragon automatically returns the cursor to where it was before you opened the menu.

If you dictate something new to make a correction when the Correction menu is open, Dragon does not return the cursor to its last location. You can use the "Go Back" command or the mouse or keyboard to move it back to where it was.
Correcting text with the keyboard (fastest)

To correct text with the keyboard

1. Move the insertion point to the beginning of the dictation you want to correct.
2. Press the Correction hot key to display the Correction menu. (By default, this is the Minus key (-) on the numeric keypad. You can change the hot key assignment on the Hot keys tab of the Options dialog box.) You can also click the Correction button on the Extras toolbar. The Extras toolbar is available only on the Classic DragonBar; to use it, you must first switch to the Classic DragonBar.
3. The Correction menu displays a list of optional spellings.
   - If the selected alternative is correct, press the Right Arrow key.
   - If one of the other alternatives is correct, press the Down Arrow key until that alternative is highlighted and press the Right Arrow key.
   - If no alternative is correct, just type the correct text or say "Spell That" to open the Spelling window.
4. Continue until all the text is correct.

Correcting text while playing back dictation (most accurate)

Please note that when you dictate into a Web application, playback availability is limited. For more information on this, see If you have problems using Web application support.

To correct text while playing back dictation

1. Move the insertion point to the beginning of the dictation you want to correct.
2. Click Play That Back on the Audio menu of the New DragonBar or Classic DragonBar. (One could also, on the Classic DragonBar, click the Begin Playback button on the Extras toolbar. The Extras toolbar is available only on the Classic DragonBar; to use it, one must first switch to the Classic DragonBar.)
3. When the playback of your dictation reaches a recognition error, press the correction hot key. (By default, this is the Minus key (-) on the numeric keypad. You can change the hot key assignment on the Hot keys tab of the Options dialog box.) You can also click the Correction button on the Extras toolbar of the Classic DragonBar.
4. The Correction menu displays a list of alternatives for the misrecognition.
   - If one of the alternatives is correct, press the Down Arrow key to highlight that choice and then press Enter to accept it. Playback will continue automatically from the point where you stopped.
   - If no alternative is correct, just type or say the correct text and click the Begin Playback button. Playback will continue from the point where you stopped.
Correcting text using voice commands (hands-free)
To correct text using voice commands

1. Say "Go To Beginning of Document."
2. Look for the first misrecognition and say "Correct" and the text that is incorrect. The Correction menu appears, presenting alternatives.
   - If an alternative is correct, say "Choose" and the number of that alternative. For example, "Choose Two." (Do not say "Choose Numeral Two" or Dragon NaturallySpeaking will transcribe the phrase as the text "Choose Numeral Two" or "Choose 2" depending on how you set the automatic text formatting properties on the Auto-formatting dialog box.)
   - If none of the alternatives is correct, say "Spell That," spell the correct word or words into the Spelling window, and then say "click OK."
3. Verify that the correct text appears in the document in place of the misrecognized text and continue to the next misrecognition.

Using Smart Format Rules

You can also use the Smart Format Rules feature to have Dragon recognize when you correct dictated text that corresponds to an Auto-formatting option or supported by this feature. Dragon then displays a Smart Format Rules dialog box, offering one or more setting adjustments relevant to the change you just made. If you don’t wish to change any setting, you can just ignore the Smart Format Rules box and continue dictating (or say "Cancel" to dismiss the box).

The Smart Format Rules box may appear whether you make a correction using

- the Spelling window
  or
- the keyboard.

For details, see Using Smart Format Rules, the Auto-formatting dialog box and Creating Word Properties.

Notes

- If you select a phrase to correct that includes punctuation added by Dragon automatically, the list of alternatives in the Correction menu will include one without that punctuation.
- When you use the Correction menu with a selection of more than 70 characters, Dragon selects only the first sentence for correction.
- The Accuracy Center provides a central location for taking advantage of all the Dragon NaturallySpeaking tools available to ensure excellent recognition. For more information, see Using the Accuracy Center.
- When you use the "select" or "correct" command to select any part of a hyphenated word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphenated word "brother-in-law" if you say "correct brother" because you only need to change that, Dragon selects "brother-in-law."
Correcting text - quick reference

When you correct recognition errors, Dragon NaturallySpeaking adapts your User Profile, so errors are less likely to happen again.

See also

- Using Direct Editing

You can correct recognition errors in the following ways:

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct a word or phrase you specify</td>
<td>&quot;Correct &lt;wrong word or phrase&gt;&quot; (if there are multiple matches in the editable text, a number will appear next to each one; say the number of the desired one, or say &quot;choose all&quot;)</td>
</tr>
<tr>
<td>Correct the last thing you said</td>
<td>&quot;Correct That&quot; or &quot;Correct This&quot;</td>
</tr>
<tr>
<td>Correct the selected text</td>
<td>&quot;Correct That&quot; or &quot;Correct This&quot;</td>
</tr>
<tr>
<td>Correct a range of text</td>
<td>&quot;Correct dark through night&quot; where dark is the first word to correct and night is the last word to correct. You don’t have to include the entire phrase when you use this command. &quot;Correct from &lt;text&gt; to &lt;text&gt;&quot; (Outside US and Canada) &quot;Correct &lt;text&gt; through &lt;text&gt;&quot; (In the US and Canada)</td>
</tr>
<tr>
<td>Delete text you just dictated</td>
<td>&quot;Scratch That&quot;</td>
</tr>
<tr>
<td>Play back the recorded speech for the selected text</td>
<td>&quot;Play That Back&quot;</td>
</tr>
<tr>
<td></td>
<td>Note: Web applications have only limited playback.</td>
</tr>
<tr>
<td>Use the Extras toolbar (available only on the Classic DragonBar and in higher editions of Dragon)</td>
<td>&quot;Show extras&quot; if the Extras toolbar is not visible (or click the Extras button on the Classic DragonBar), then click the Correction button to bring up the correction interface. (If you click this button while Dragon is playing back text, this will stop playback.)</td>
</tr>
</tbody>
</table>

The Correction menu closes automatically after you pick an item from it. If you want to close the Correction menu without picking from it, say "Cancel" or just continue dictating.

You can enable and disable these Direct Editing commands from the Commands tab of the Options dialog box.

Workflow

You can experiment with Dragon NaturallySpeaking's various correction options, including both vocal and manual actions (Correction button, Correction hot key, double-click to Correct,
Smart Format Rules), to see what you prefer for a given situation. For a description of three
different methods for correcting text and how each fits into a particular workflow, click
Correction workflow.

Techniques
The following topics explain different aspects of correcting text:

Correcting text errors as you dictate
Choosing the correct text
Undoing actions
Correcting misrecognized commands

Notes

- Remember that letting Dragon NaturallySpeaking adapt its Vocabulary to your own
  words and phrases will prevent many recognition errors. If a word is not in Dragon
  NaturallySpeaking's active Vocabulary, Dragon NaturallySpeaking can't recognize it
  accurately. The Accuracy Center provides a central location for all the Dragon
  NaturallySpeaking tools available to ensure excellent recognition. For more
  information, see Using the Accuracy Center.

- If the New DragonBar or Classic DragonBar message area states that there is
  nothing to correct, select the text you want to correct and say "Correct That" again (or
  press the Correction hot key or click the Correction button).

- If you select a phrase to correct that includes a comma or period added to the
  sentence automatically, the list of corrections that appears in the Correction menu will
  include a version without the automatically inserted punctuation.

- To dictate the word "correct" at the beginning of an utterance (that is, as the first word
  after a pause), either say "correct" and then pause, or hold down the Shift key while
  you speak to force Dragon NaturallySpeaking to recognize the word as dictation and
  not as a command. You can change the key that you press to control this behavior on
  the Hot keys tab of the Options dialog box.

Choosing the correct text

In the Correction menu and the Spelling window, Dragon NaturallySpeaking offers a
selection of recognition alternatives. Use the following procedure to choose the alternative
you want.

To choose the correct text

- If the correct text is one of the alternatives listed, say "Choose" and then say the number of
  the alternative in the list. As an option, you can press the ALT key and type the number of the
  alternative from the keyboard (not the numeric keypad).

The text you choose replaces the text in your document.

Example:

If the correct text is the third alternative, say "Choose 3."
Notes

- Dragon’s Smart Format Rules dialog box may appear when you correct auto-formatted alphanumeric text using the Correction command, the Spelling window, or the keyboard. For details, see Using Smart Format Rules and Automatically Format Text.

- When selecting an alternative on the correction menu, say "Choose" and the number of that alternative. For example, "Choose Two." Do not say "Choose Numeral Two" or Dragon NaturallySpeaking will transcribe the phrase as the text "Choose Numeral Two" or "Choose 2" depending on how you set the number formatting options on the Auto-formatting dialog box.

- In the Spelling window, if one of the recognition alternatives is nearly correct, you can say "Select" and the number of the alternative. The alternative text is moved into the text box, so you can edit it. As an option, you can press the SHIFT and ALT keys and type the number of the alternative from the keyboard (not the numeric keypad).

- If you select a phrase to correct that includes punctuation added to the sentence automatically, the list of corrections that appears in the Correction menu will include a version without the automatically inserted punctuation.

- The Accuracy Center provides a central location for taking advantage of all the Dragon NaturallySpeaking tools available to ensure excellent recognition. For more information, see Using the Accuracy Center.

- You can choose to always play back recorded speech in the Correction menu. You can set the respective option on the Correction tab of the Options dialog box.

Correcting misrecognized commands

If you speak a valid command and it is not recognized correctly, use the following procedure to ensure that Dragon NaturallySpeaking recognizes the command in the future. When valid command words and phrases appear in the Results box the box contains a blue border. Open the Command Browser from the New DragonBar or Classic DragonBar Tools menu for lists of valid commands.

To correct a misrecognized command

1. If the window or dialog box containing the misrecognized command is not active (that is, the title bar is not highlighted), click in it to make it active.

2. Say "Scratch That" (to delete the unwanted dictation), "Undo That", or "Undo Last Action" to undo an unwanted action.

3. Say the command again.

If the command was recognized as dictation, hold down the CTRL key as you start to say the command again. Holding down the CTRL key forces Dragon NaturallySpeaking to recognize what you say as a command. You can also switch to Command Mode.

Notes

- You can train commands to match your pronunciation, if necessary.

- When Dragon NaturallySpeaking recognizes a command, the borders of the results box turn blue. The only exception to this is when you use commands that you usually say without pausing during dictation, such as "new line", "new paragraph", "no caps", or "all caps".
The Accuracy Center provides a central location for taking advantage of all the Dragon NaturallySpeaking tools available to ensure excellent recognition. For more information, see Using the Accuracy Center.
Chapter 11: Revising Text

This section contains the following topics:

- Using Direct Editing commands ............................................................ 104
- Handling multiple text matches ............................................................ 106
- Revising text - quick reference ............................................................ 110

Using Direct Editing commands

Use Dragon NaturallySpeaking Direct Editing (formerly called Quick Voice Formatting) commands to do routine tasks faster by voice.

In previous versions of Dragon, deleting, cutting, copying, italicizing, underlining, and applying bold to text were two-step operations: you had to select the text before you could change it. Now you can perform these actions in one step.

See also

- Handling multiple text matches

Note

For commands that name a range of text, such as "bold <text> through <text>," Dragon expects to hear "to" or "through" depending on the region you selected when you created your User Profile. Use "through" in the United States and Canada, and use "to" in all other regions.

Formatting text

Use the commands in the following table to quickly format text using Direct Editing. Formatting commands are available only in programs that support formatting.
<table>
<thead>
<tr>
<th>To...</th>
<th>Say...</th>
</tr>
</thead>
</table>
| **Bold the specified text or a range of text.** | **Bold** `<text>`  
**Bold from** `<text>` to `<text>`  
**Bold** `<text>` through `<text>` |
| **Italicize the specified text or a range of text.** | **Italicize** `<text>`  
**Italicize from** `<text>` to `<text>`  
**Italicize** `<text>` through `<text>` |
| **Underline the specified text or a range of text** | **Underline** `<text>`  
**Underline from** `<text>` to `<text>`  
**Underline** `<text>` through `<text>` |
| **Capitalize the specified text of a range of text** | **Capitalize** `<text>`  
**Capitalize from** `<text>` to `<text>`  
**Capitalize** `<text>` through `<text>` |
Editing text

Use the commands in the following table to quickly revise text using Direct Editing.

<table>
<thead>
<tr>
<th>To...</th>
<th>Say...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut the specified text or a range of text.</td>
<td>Cut &lt;text&gt;</td>
</tr>
<tr>
<td></td>
<td>Cut from &lt;text&gt; to &lt;text&gt;</td>
</tr>
<tr>
<td></td>
<td>Cut &lt;text&gt; through &lt;text&gt;</td>
</tr>
</tbody>
</table>

**Note:** The Cut voice command is turned off by default to keep the word "cut" available for regular dictation. To enable using "Cut" as a command, change the Enable Cut shortcut command setting in the Options dialog box Commands tab and then Exit and Restart Dragon.

| Copy the specified text or a range of text. | Copy <text>                   |
|                                            | Copy from <text> to <text>     |
|                                            | Copy <text> through <text>     |

| Delete the specified text or a range of text. | Delete <text> |
|                                               | Delete from <text> to <text> |
|                                               | Delete <text> through <text> |

**Handling multiple text matches**

Use the commands in this topic when Dragon finds multiple instances of a word or phrase in the part of your document currently showing on screen. Dragon displays a number next to each instance, so that you can choose the one you had in mind for the command. This feature also lets you save time by applying the command to all instances at once if doing so makes sense for that particular command.

**Note**

- If you prefer that Dragon change only the instance of a word or phrase nearest to the cursor, you can turn this option off in Dragon’s Options dialog box, Commands tab (see Enable multiple text matches). Then, if Dragon selects the correct word or phrase but not the right instance, you can say "Select Again" to select the previous instance. By default, the feature is turned on.

Here’s an example of what Dragon does with the "Italicize <xyz>" command. When you say "italicize course," Dragon displays a number next to each matching item, as shown here. Then you can say "Choose <n>," where <n> represents one of the numbered text matches, or "Choose All" to apply the command to all text matches. Dragon only numbers text matches that are visible in your current document window.
You can cancel text matching by saying "Cancel," continuing to dictate, typing, or clicking the mouse. You can also use "Undo All" after you use "Choose All."

You can use this feature with Microsoft Word, Notepad, WordPad, Microsoft Outlook, Internet Explorer, Microsoft InfoPath, DragonPad and Dragon's Dictation Box.

When you say a command that can apply to multiple instances, the New DragonBar or Classic DragonBar message area (only visible when the Classic DragonBar is Docked or Floating, always visible on the New DragonBar) provides information about what you can say. This is an example of how it can be useful to check the New DragonBar or Classic DragonBar for messages regularly, especially if you are new to this version of Dragon.

See also

- Using Direct Editing commands

Use the following table as a quick reference for text matching commands.
<table>
<thead>
<tr>
<th>Command</th>
<th>To...</th>
<th>Say...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold &lt;xyz&gt;</td>
<td>Apply bold to one or more text matches</td>
<td>&quot;Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to apply the formatting to only the third instance of a number of text matches. OR &quot;Choose all&quot; to apply bold to all instances Dragon shows as text matches.</td>
</tr>
<tr>
<td>Underline &lt;xyz&gt;</td>
<td>Apply underlining to one or more text matches</td>
<td>&quot;Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to apply the formatting to only the third instance of a number of text matches. OR &quot;Choose all&quot; to underline all instances Dragon shows as text matches.</td>
</tr>
<tr>
<td>Italicize &lt;xyz&gt;</td>
<td>Apply italics to one or more text matches</td>
<td>&quot;Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to apply the formatting to only the third instance of a number of text matches. OR &quot;Choose all&quot; to italicize all instances Dragon shows as text matches.</td>
</tr>
<tr>
<td>Capitalize &lt;xyz&gt;</td>
<td>Capitalize the first letter of one or more text matches</td>
<td>&quot;Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to apply the formatting to only the third instance of a number of text matches. OR &quot;Choose all&quot; to capitalize all instances Dragon shows as text matches.</td>
</tr>
<tr>
<td>Delete &lt;xyz&gt;</td>
<td>Delete one or more text matches</td>
<td>&quot;Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to delete only the third instance of a number of text matches. OR &quot;Choose all&quot; to delete all instances Dragon shows as text matches.</td>
</tr>
<tr>
<td>Undo All</td>
<td>Undo changes to all revised text matches</td>
<td>1. Perform one of the commands in this table to revise two or more multiple text matches. 2. Say &quot;Undo All.&quot;</td>
</tr>
</tbody>
</table>

Bold <xyz> means to apply **bold** formatting to one or more text matches. Underline <xyz> means to apply **underlining** formatting to one or more text matches. Italicize <xyz> means to apply **italics** formatting to one or more text matches. Capitalize <xyz> means to capitalizes the first letter of one or more text matches. Delete <xyz> means to delete one or more text matches. Undo All means to undo changes to all revised text matches.
<table>
<thead>
<tr>
<th>Command</th>
<th>To...</th>
<th>Say...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Undo All can undo a maximum of 50 instances of the Bold, Italicize, Underline, and Delete commands, and up to a maximum of 25 instances of the Correct command.</td>
</tr>
<tr>
<td>Cut &lt;xyz&gt;</td>
<td>Cut one of the text matches</td>
<td>Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to cut only the third instance of a number of text matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: The Cut voice command is turned off by default to keep the word &quot;cut&quot; available for regular dictation. To enable using &quot;Cut&quot; as a command, change the Enable Cut shortcut command setting in the Options dialog box Commands tab and then Exit and Restart Dragon.</td>
</tr>
<tr>
<td>Copy &lt;xyz&gt;</td>
<td>Copy one of the text matches</td>
<td>Choose &lt;number&gt;&quot; or &quot;&lt;n&gt;.&quot; For example, say &quot;Choose 3&quot; or &quot;3&quot; to copy only the third instance of a number of text matches.</td>
</tr>
</tbody>
</table>
| Select <xyz> | Select one of the matches of selected text | Choose <number>" or "<n>." For example, say "Choose 3" or "3" to select only the third instance of a number of text matches. You must then choose one of the numbered text matches. **Notes:**
| OR           |                                           | • Depending on how Dragon's Correction Options are set, Dragon displays either the Correction menu or the Spelling window when you use the Select command. Changes to multiple text matches do not work from the Spelling window. |
| "Select <abc> through <xyz>" |                                            | • Replacing all instances of text matches does not work with the Select command. |
| Correct <xyz> | Use the Correction menu to change one or more text matches | Choose <number>" or "<n>." For example, say "Choose 3" or "3" to correct only the third instance of a number of text matches. **Notes:**
| OR           |                                           | "Choose all" to correct all text matches Dragon displays. |
| "Correct <abc>" through <xyz> |                                            | **Notes:** |
Command | To... | Say...
--- | --- | ---
|  |  | • Depending on how Dragon's Correction Options are set, Dragon displays either the Correction menu (see example below) or the Spelling window when you use the Correct command.

If you use "Choose all" when multiple correction options are displayed, you can replace all of the selections with a numbered option from the menu or use "all caps that."

Other menu commands apply to the last match selected.
• Changes to multiple text matches do not work from the Spelling window.

| Insert before | Move the cursor to just before a particular word or phrase in your document | Choose `<number>` or `<n>`. For example, say "Choose 3" or "3" to move cursor into position just before the third instance of a number of text matches. |
| Insert after | Move the cursor to just after a particular word or phrase in your document | Choose `<number>` or `<n>`. For example, say "Choose 3" or "3" to move cursor into position just after the third instance of a number of text matches. |

Notes

- For commands that apply to a range of text, such as "bold <abc> through <xyz>," Dragon expects to hear "to" or "through" depending on the region you selected when you created your User Profile. Use "through" in the United States and Canada, and use "to" in all other regions.
- Formatting commands are not available in Notepad and may not work correctly in Internet Explorer.
- To use formatting commands in Microsoft Outlook, make sure either HTML or RTF mail message format is turned on.

Revising text - quick reference

You can revise text by voice in any of the following ways.

See also

- Handling multiple text matches
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Delete text         | "Scratch That" to delete the last thing you said.  
                      "Delete <text>" where <text> is the word or phrase you want to delete *  
                      "Delete from <text> to <text>" *  
                      "Delete <text> through <text>" * |
| Cut text            | "Cut That" to cut previously selected text or the last thing you said.  
                      "Cut <text>" where <text> is the word or phrase you want to cut *  
                      "Cut from <text> to <text>"  
                      "Cut <text> through <text>"  
                      **Note:** The Cut Direct Editing command is turned off by default to keep it available for regular dictation.  
                      To enable the Cut command,  
                      1. Choose Tools > Options from the New DragonBar or Classic DragonBar.  
                      2. Click Commands > Enable Cut Command.  
                      3. Restart Dragon. |
| Copy text           | "Copy That" to copy previously selected text or the last thing you said.  
                      "Copy <text>" where <text> is the word or phrase you want to copy *  
                      "Copy from <text> to <text>" *  
                      "Copy <text> through <text>" * |
| Select text         | "Select that" to select the last thing you said.  
                      "Select <text>" where <text> is the word or phrase you want to change  
                      "Select <text> Through <text>."  
                      **Note:** Outside the USA or Canada, say "Select <text> To <text>."  
                      "Select from <text> to <text>" |
| Correct text        | "Correct That"  
                      "Correct <text>" where <text> is the word or phrase you want to change  
                      "Correct <text> To <text>"  
                      "Correct from <text> to <text>"  
                      "Correct<text> Through <text>." |
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Outside the USA or Canada, say &quot;Select &lt;text&gt; To &lt;text&gt;.&quot;</td>
<td></td>
</tr>
<tr>
<td>Correct text once you have selected it</td>
<td>&quot;Correct That&quot; OR The words you want to replace the selection.</td>
</tr>
<tr>
<td>Back up and resume dictating</td>
<td>&quot;Resume With &lt;word&gt;&quot; where &lt;word&gt; is the word you want Dragon to resume with. Then, dictate the revised text.</td>
</tr>
<tr>
<td>Move the cursor back to its last position in documents and e-mail messages</td>
<td>Pause briefly during dictation and say &quot;Go Back&quot; See Using &quot;Go Back&quot; to move the cursor.</td>
</tr>
</tbody>
</table>

* indicates a **Direct Editing command**: You can enable and disable these Direct Editing commands from the Commands tab of the Options dialog box.

The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after <xyz>…) work thanks to a functionality called Full Text Control. This functionality depends on Dragon’s ability to constantly obtain information from the text field about its content—for instance, in order to know where words and sentences begin and end, so Dragon can apply spacing between words and capitalization at the beginning of sentences. Most standard text fields allow full Full Text Control capabilities. For more information, see [The Full Text Control Indicator](#).

Knowing additional ways to perform the following tasks by voice is useful in revising text. Click the following links for more detailed explanations.

**Moving around in a document**
- [Selecting text](#)
- [Deleting dictated text](#)
- [Formatting text](#)

Automatically Format Text (see Dragon Help)

**Notes**
- Dragon can auto-format text and numbers using standard writing conventions or apply [Word Properties](#) to words as you dictate. For information about these settings, see Auto-formatting dialog box and The Word Properties dialog box.
- Dragon’s Smart Format Rules appear when you correct auto-formatted alphanumeric text or [Word Properties](#) using the Correction menu, the Spelling window, or the keyboard. For details, see [Using Smart Format Rules](#) and [Setting Auto-Formatting Options](#).
- When you use the "select" or "correct" command to select any part of a hyphenated word or a hyphen, Dragon selects the entire hyphenation. For example, in the
hyphenated word "brother-in-law" if you say "correct brother" because you only need to change that, Dragon selects "brother-in-law."
Chapter 12: Moving around in a document

The following topics describe how to move the text insertion point around in a document.

Moving the insertion point
Moving to specific words
Moving to the beginning or end of a line or document

Moving the insertion point

Use the procedures in this topic to move the text insertion point as follows:

- by characters
- by words
- by lines
- by paragraphs

Note

Anytime you move the insertion point by voice, keyboard or mouse, you can move it back to where it was by saying "Go Back."

For more information, see Using "Go Back" to move the cursor.

To move the insertion point by characters

Say the following to move the insertion point left or right by a number of characters.
Chapter 12: Moving around in a document

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move&quot;</td>
<td>&quot;Right&quot;</td>
<td>&quot;&lt;1-20&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left&quot;</td>
<td>&quot;a character&quot;</td>
</tr>
<tr>
<td>&quot;Forward&quot;</td>
<td></td>
<td>&quot;&lt;1-20&gt; characters&quot;</td>
</tr>
<tr>
<td>&quot;Back&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Examples**

"Move Right 3"
"Move Back 15 characters"
To move the insertion point by words

Say the following to move the insertion point by a number of words.

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move&quot;</td>
<td>&quot;Right&quot;</td>
<td>&quot;a Word&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Forward&quot;</td>
<td>&quot;&lt;1-20&gt; Words&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Back&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**Examples**

"Move Left 3 Words"
"Move Forward a Word"

To move the insertion point by lines

Say the following to move the insertion point up or down by lines. These commands press the up and down arrow keys.

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move&quot;</td>
<td>&quot;Up&quot;</td>
<td>&quot;&lt;1-20&gt; Lines&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Down&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**Examples**

"Move Up 3 Lines"
"Move Down 5"

To move the insertion points by paragraphs

You can use these commands to move around by paragraphs.

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move&quot;</td>
<td>&quot;Up&quot;</td>
<td>&quot;a Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Back&quot;</td>
<td>&quot;&lt;1-20&gt; Paragraphs&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Down&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Forward&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**Examples**

"Move Up a Paragraph"
"Move Forward 8 Paragraphs"

**Notes**

- These commands deselect any text that is selected.
- Commands that delete by words or paragraphs may not always have the expected effects in programs that do not use the same shortcut keys as WordPad (on which the
word processing features of Dragon NaturallySpeaking are based). For example, in Windows Notepad, the paragraph commands don't work because Notepad does not recognize a paragraph and in Microsoft Excel, these commands only work in the toolbar edit field.

**Moving to specific words**

You can move the insertion point before or after a particular word or phrase.

To move the insertion point to a specific word

Say "Insert Before <text>" or "Insert After <text>," where <text> is a word or phrase in the document.

<table>
<thead>
<tr>
<th>To</th>
<th>Say, for example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the insertion point before the word &quot;John&quot;</td>
<td>&quot;Insert Before John&quot;</td>
</tr>
<tr>
<td>Move the insertion point after the phrase &quot;Dear Sir&quot;</td>
<td>&quot;Insert After Dear Sir&quot;</td>
</tr>
</tbody>
</table>

**Notes**

- These commands deselect any text that is selected.
- Do not pause anywhere in the middle of saying these commands, including the text. For example, "Insert Before Dear Sir" is all one command.

**Moving to the beginning or end of a document or line**

You can use these commands to move the text insertion point to the top or bottom of a document and the beginning or end of a line.
Say | Then say
---|---
"Go to" | "Top"
"Move to" | "Top of Document"
| "Beginning of Document"
| "Start of Document"
| "Bottom"
| "Bottom of Document"
| "End of Document"
| "Beginning of Line"
| "Start of Line"
| "End of Line"

Examples
"Go to Top"
"Move to End of Line"

Note
These commands deselect any text that is selected.

Using "Go Back" to move the cursor

Use the "Go Back" command to return the cursor (insertion point) to its original position after you move the cursor by voice, keyboard or mouse.

To move the cursor back to its original position
- Pause briefly during dictation and say "Go Back."

You can repeat the command to move the cursor back to where your original action put it.

Examples
Use the Go Back command after commands that move the cursor from place to place, such as:
- "Select <text>." See Selecting text: quick reference
- "Move <direction>." See Moving the insertion point
- Moving the cursor with the mouse or keyboard. If you move the cursor around in a document or message with the mouse or keyboard, when you say "Go Back," Dragon returns the cursor to where it was last.
- "Insert before <text>." or "Insert after <text>" See Moving to specific words
- "Go to" or "Move to." See Moving to the beginning or end of a document or line
- "Correct <text>." Use "Go Back" if you dictate something new to make a correction when the Correction menu is open. See Correcting with the Correction menu
Note
To use "Go Back," the distance from the last cursor location must be greater than 10 characters.
Selecting text

This section contains the following topics:

- Selecting text - quick reference ................................................................. 120
- Selecting characters and words ............................................................... 120
- Selecting specific words or phrases ....................................................... 121
- Selecting lines and paragraphs ............................................................... 122
- Selecting text again .................................................................................. 123
- Changing an incorrect text selection .................................................... 123

Selecting text - quick reference

When you are dictating, you can select text in these different ways:

Selecting text

Selecting characters and words

Selecting specific words or phrases

Selecting parts of a document

Selecting text again

Changing an incorrect text selection

You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other sounds. Dragon NaturallySpeaking may interpret such noises as speech and replace the selection with new text. If this happens, say "Undo That" right away to reverse the action.

Selecting characters and words

You can use the following commands to select individual characters and words.
To select characters and words

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Select&quot;</td>
<td>&quot;Next&quot;</td>
<td>&quot;Character&quot;</td>
</tr>
<tr>
<td>&quot;Forward&quot;</td>
<td>&quot;&lt;1-20&gt; Characters&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Previous&quot;</td>
<td>&quot;Word&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Back&quot;</td>
<td>&quot;&lt;1-20&gt; Words&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Last&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes

- When you use the "select" or "correct" command to select any part of a hyphenated word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphenated word "brother-in-law" if you say "correct brother" because you only need to change that, Dragon selects "brother-in-law."
- You can select punctuation marks by voice. For example, you can say "Select comma."
- By default, when you select a word or phrase, Dragon NaturallySpeaking displays the Correction menu, which you can use to correct recognition errors. You can turn this feature off by clearing (deselecting) the "Select command bring up Correction menu" options on the Correction tab of the Options dialog box.
- Commands that delete by words or paragraphs may not always have the expected effects in programs that do not use the same shortcut keys as WordPad (on which the word processing features of Dragon NaturallySpeaking are based). For example, in Windows Notepad, the paragraph commands don’t work because Notepad does not recognize a paragraph and in Microsoft Excel, these commands only work in the FormulaBar edit field.

**Selecting specific words or phrases**

Use the following procedures to select a specific word or phrase:

**To select specific words**

▶ Say "Select <text>," where <text> is the word or phrase you want to select. The text must be visible on the screen for you to select it.

**Examples**

To select the words "White House" or "began to feel," say:

"Select White House"
"Select began to feel"

**To select a phrase or range of words**

▶ Say "Select <text> Through <text>," where <text> is a word or phrase at the beginning and at the end of the range you want to select. The text must be in view on the screen.

**Note:** Outside the USA or Canada, say "Select <text> To <text>."
Example

To select the words "enclosed the materials you requested," in the sentence: "I have also enclosed the materials you requested," say:

"Select enclosed Through requested"

Notes

- You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.
- In most instances, the "Select" command will display a number next to each instance of the word, allowing to select all instances or just a specific instance. See Handling multiple text matches for more information. If you find that a particular application does not display these numbers, you can still use the "Select Again" command.
- If you need to use the "Select Again" command, the selection commands search for the instance of the word nearest the insertion point. You can set the direction to always search backward on the Correction tab of the Options dialog box.
- When you select a word or phrase, Dragon NaturallySpeaking displays the Correction menu, which you can use to correct recognition errors. You can change this behavior on the Correction tab of the Options dialog box.
- When you use the "select" or "correct" command to select any part of a hyphenated word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphenated word "brother-in-law" if you say "correct brother" because you only need to change that, Dragon selects "brother-in-law."

Selecting lines and paragraphs

You can select parts of a document by lines or paragraphs, or you can select the whole document in the following ways:

To select one or more lines or paragraphs

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Select&quot;</td>
<td>&quot;Next&quot;</td>
<td>&quot;Line&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Forward&quot;</td>
<td>&quot;&lt;1-20&gt; Lines&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Previous&quot;</td>
<td>&quot;Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Back&quot;</td>
<td>&quot;&lt;1-20&gt; Paragraphs&quot;</td>
</tr>
</tbody>
</table>

You can also say

"Select Document"

"Select All"

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other sounds. Dragon NaturallySpeaking may interpret such noises as speech and replace the selection with new text. If this happens, say "Undo That" right away to reverse the action.
Notes

- You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.
- Commands that delete by words or paragraphs may not always have the expected effects in programs that do not use the same shortcut keys as WordPad (on which the word processing features of Dragon NaturallySpeaking are based). For example, in Windows Notepad, the paragraph commands don't work because Notepad does not recognize a paragraph and in Microsoft Excel, these commands only work in the FormulaBar edit field.

Selecting text again

Once you have selected a word or phrase, you can quickly select another occurrence of the same text.

To select text again

- Say "Select Again."

Example

In the sentence, "The frost is on the pumpkin, and the fruit is on the vine," say "Select is on the" to select the words "is on the" after the word "fruit."

Then, to select the instance of the words "is on the," after the word "frost" say "Select Again."

Changing an incorrect text selection

When you select text by saying "Select" and the text you want selected, Dragon NaturallySpeaking searches for the nearest instance of the text from the current location of the insertion point. Sometimes the program selects the wrong words. Other times, the program selects the right words, but they are not in the correct location.

When this happens, try the following techniques:

To change an incorrect text selection

- If the wrong text is selected, try saying "Select <text>" again. The second time, Dragon NaturallySpeaking searches for different text with a similar pronunciation.
- If the wrong text is selected, try using a longer phrase. This provides more information so Dragon NaturallySpeaking is more likely to select the correct text.
- If the correct words are selected but they are not in the correct location, say "Select Again" to select the previous occurrence of the same text.

Notes

- You can select punctuation marks.
- You can say "Select period" and then "Select Again" to move the insertion point sentence by sentence.
The default is for Dragon NaturallySpeaking for the nearest instance from the location of the insertion point. You can change the search direction to always be backward on the Correction tab of the Options dialog box.

To dictate the word "Select" at the beginning of an utterance (that is, as the first word after a pause), either say "Select" and then pause, or hold down the Shift key while you speak. You can also use Dictation Mode.
Deleting, Cutting, and Copying Text

This section contains the following topics:

Cutting, copying, and pasting ................................................................. 125
Deleting dictated text ............................................................................ 125
Deleting characters, words, lines, or paragraphs .................................. 126
Deleting by backspacing ...................................................................... 126

Cutting, copying, and pasting

You can say these commands to cut, copy, and paste selected text to and from documents.

To cut selected text

→ Say "Cut That."

To copy selected text

→ Say "Copy That" or "Copy All To Clipboard."

To paste cut or copied text

→ Say "Paste That."

Deleting dictated text

Use the following procedure to remove text from a document.

To delete the last words you dictated

→ Say "Scratch That."

Or

→ Say "Resume With <word>," where word is a word within the last 100 characters of text you dictated.

To delete any text

1. Select the text.
2. Say "Scratch That" or "Delete That."

To delete specific text or a range of text, see Revising words.

Notes

- You can repeat "Scratch That" up to ten times to delete the last things you said one at a time, or you can just say "Scratch That <2-10> Times."
- If you just dictated the text and want to delete it, say "Scratch That."
Deleting characters, words, lines, or paragraphs

You can delete any number of words or characters (up to 20) using the following commands.

To delete characters, words, lines, or paragraphs

<table>
<thead>
<tr>
<th>Say</th>
<th>Then Say</th>
<th>Then Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Delete&quot;</td>
<td>&quot;Next&quot;</td>
<td>&quot;Character&quot;</td>
</tr>
<tr>
<td>&quot;Previous&quot;</td>
<td>&quot;1 Character&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Last&quot;</td>
<td>&quot;&lt;2-20&gt; Characters&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Word&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;1 Word&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;&lt;2-20&gt; Words&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Line&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;1 Line&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;&lt;2-20&gt; Lines&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Paragraph&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;1 Paragraph&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;&lt;2-20&gt; Paragraphs&quot;</td>
<td></td>
</tr>
</tbody>
</table>

Examples:

"Delete Next Character"

"Delete Previous 4 Lines"

Notes

- If you delete text and an extra space remains, say "Delete Next Character," "Delete Previous Character," or "Backspace" to remove the space.

- Commands that delete by words or paragraphs may not always have the expected effects in programs that do not use the same shortcut keys as WordPad (on which the word processing features of Dragon NaturallySpeaking are based). For example, in Windows Notepad, the paragraph commands don't work because Notepad does not recognize a paragraph, and in Microsoft Excel, these commands only work in the FormulaBar edit field.

Deleting by backspacing

Use the following commands to remove characters to the left of the insertion point.
To delete characters

- Say "Backspace" or "Backspace" followed by the number of characters you want to delete (from 2 to 20).

**Examples:**

"Backspace" (will delete one character)

"Backspace 5" (will delete 5 characters)
Formatting

This section contains the following topics:

- Formatting text ................................................................. 128
- Formatting numbers ............................................................ 130
- Setting font name, size, and style ........................................... 131
- Aligning text ........................................................................ 131
- Adding new lines and paragraphs .......................................... 132
- Hyphenating words .............................................................. 132
- Joining words ...................................................................... 132
- Setting Auto-Formatting Options ........................................... 133
- Creating Word Properties ..................................................... 133

Formatting text

You can use the following commands to format text you have just dictated or text you have selected.

For information about applying formatting to multiple instances of words or phrases, see Handling multiple text matches.
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Apply bold                                   | "Bold That" or "Format that Bold" to bold previously selected text or the last thing you said.  
  "Bold <text>"*  
  "Bold from <text> to <text>"*  
  "Bold <text> through <text>"* |
| Apply italics                                 | "Italicize That" or "Format That Italics" to italicize previously selected text or the last thing you said.  
  "Italicize <text>"*  
  "Italicize from <text> to <text>"*  
  "Italicize <text> through <text>"* |
| Apply bold italics                           | "Format That Bold Italic" or "Format That Bold Italics"               |
| Add underlining                              | "Underline That" or "Format That Underline" to underline previously selected text or the last thing you said.  
  "Underline <text>"*  
  "Underline from <text> to <text>"*  
  "Underline <text> through <text>"* |
| Add strikeout                                | "Format That Strikeout"                                              |
| Remove all bold, italics, underline, and strikeout formatting | "Restore That" or "Format That Regular" or "Format That Plain"         |
| Change text to initial capitals              | "Format That Caps" or "Format That Initial Caps"                     |
| Change text to uppercase                     | "Format That Uppercase" or "all caps that" or "capitalize XYZ"       |
| Change text to lowercase                     | "Format That Lowercase" or "No-Caps That"                            |
| Create a bulleted list                       | "Format That Bullet Style"                                           |
| Left-align text                              | "Format That Left Aligned" or "Left Align That"                     |
| Right-align text                             | "Format That Right Aligned" or "Right Align That"                   |
| Center text                                  | "Format That Centered" or "Center That"                             |
| Put hyphens between words                    | "Hyphenate That"                                                     |
| Combine multiple words into one              | "Compound That"                                                      |
* indicates a **Direct Editing command**. You can enable and disable these Direct Editing commands from the Commands tab of the Options dialog box.

**Notes**

- The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after <xyz> ...) work thanks to a functionality called Full Text Control. This functionality depends on Dragon’s ability to constantly obtain information from the text field about its content—for instance, in order to know where words and sentences begin and end, so Dragon can apply spacing between words and capitalization at the beginning of sentences. Most standard text fields allow full Full Text Control capabilities. For more information, see [The Full Text Control Indicator](#).

- You can combine different formatting and font style commands. For example, you can say: "Format That Caps Bold" or "Format That Bullet Style Italic."

- In the DragonPad, when you use the "Format That" command to align an empty paragraph, the previous paragraph is aligned also. To prevent this, dictate some text in the new paragraph before saying the alignment command.

- Dragon can automatically format text and numbers as you dictate using standard writing conventions. For information about these settings, see the Auto-formatting dialog box.

- Dragon’s Smart Format Rules appear when you correct auto-formatted alphanumeric text using the Correction command, the Spelling window, or the keyboard. For details, see [Using Smart Format Rules](#) and the Auto-formatting dialog box.

### Formatting numbers

You can have Dragon NaturallySpeaking type your dictation as numerals. You can also change the format of text while you are dictating it or while you are editing existing text that you have selected.

**To format dictation as numerals**

- Say "Start Numbers Mode"

**To turn Numbers Mode off, say "Stop Numbers Mode"**

**Note**

- You can select text that contains several numbers separated by words. When you say one of these commands, the numbers will all reformat without changing the text.

- Dragon can automatically format text and numbers as you dictate using standard writing conventions. For information about these settings, see the Auto-formatting dialog box.

- Dragon’s Smart Format Rules appear when you correct auto-formatted alphanumeric text using the Correction command, the Spelling window, or the keyboard. For details, see [Using Smart Format Rules](#) and the Auto-formatting dialog box.
Setting font name, size, and style

You can use commands to specify any combination of font name, size, and style, in that order. These commands change selected text and text you dictate from then on.

To set a font name, size, or style

- Say "Set Size" or "Set Font Size" or "Format That" and the font name, size, and/or style.

Examples:

"Set Font Times"
"Set Font Size 12 Points"
"Format That Courier 18 Points Bold"
"Format That Arial 12 Points"

To remove font formatting

- To remove bold, italics, underline, and strikeout formatting, say "Format That Plain Text."

Notes

- You can specify any combination of font name, size, and style, but you must specify attributes in that order (name, size, style). If you specify only a size, you must say "Points." For example, say "Format That 12 Points."

- Not all of these commands work in all applications. These commands do work in Microsoft Word, Microsoft InfoPath, Corel WordPerfect, DragonPad, and WordPad. Check the Command Browser for additional application-specific commands.

- Commands that start with "Set Font" change selected text and text you dictate from then on.

- Commands that start with "Format That" change the selected text or what you just said.

- You can specify any combination of font name, size, and style, but you must specify attributes in this order: name, then size, then style.

Aligning text

You can align text while you are dictating it or while you are editing existing text that you have selected.
Adding new lines and paragraphs

While you are dictating, you can use the following commands to duplicate the action of pressing the Enter key once (to add a new line) or twice (to add a new paragraph).

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center text</td>
<td>&quot;Center That&quot; or &quot;Format That Centered&quot;</td>
</tr>
<tr>
<td>Left align text</td>
<td>&quot;Left Align That&quot; or &quot;Format That Left Aligned&quot;</td>
</tr>
<tr>
<td>Right align text</td>
<td>&quot;Right Align That&quot; or &quot;Format That Right Aligned&quot;</td>
</tr>
</tbody>
</table>

Note

Saying "New Paragraph" presses the Enter key twice and capitalizes the next word you dictate.

Hyphenating words

Dragon NaturallySpeaking automatically hyphenates words based on standard usage, but you can also insert hyphens manually.

To hyphenate words

- Say "Hyphenate That" to hyphenate the last phrase you said. You can also select specific words and say "Hyphenate That."

Spaces between words are replaced with hyphens. Any tabs or line breaks are also replaced.

Note

You can hyphenate words as you dictate by saying "hyphen" between words. For more information, see Dictating hyphenated and compound words in the Dragon Help.

Joining words

Dragon NaturallySpeaking automatically joins words based on standard usage, but you can also join words manually.

To join words

- Say "Compound That" to join the last words you said. Or, select specific words and say "Compound That."

Spaces between words are removed. Any tabs or line breaks are also removed. The word is added to your Vocabulary.
Note
You can join words as you dictate by saying "no space." When you use this technique, the new word is not added to your Vocabulary, but you can add it as a new compound word if necessary. For more information, click Adding words and phrases to your Vocabulary.

Setting Auto-Formatting Options
You can configure how Dragon NaturallySpeaking formats commonly used words and phrases.

Using Smart Format Rules
You can also use the Smart Format Rules feature to have Dragon recognize when you correct dictated text that corresponds to an Auto-formatting option or supported by this feature. Dragon then displays a Smart Format Rules dialog box, offering one or more setting adjustments relevant to the change you just made. If you don’t wish to change any setting, you can just ignore the Smart Format Rules box and continue dictating (or say "Cancel" to dismiss the box).

The Smart Format Rules box may appear whether you make a correction using

- the Spelling window
- or
- the keyboard.

For details, see Using Smart Format Rules, the Auto-formatting dialog box and Creating Word Properties.

To set auto-formatting options
1. On the New DragonBar or Classic DragonBar, select Tools > Auto-Formatting Options. The Formatting dialog appears.
2. Select the checkboxes of the formatting options that you want to enable. See The Auto-Formatting dialog box for a description of the different formatting options.
3. Click OK to save your changes.

Creating Word Properties
Use this procedure to see or edit the of a vocabulary entry.

To open the Word Properties dialog box
1. Open the Vocabulary Editor (say "Edit Vocabulary" or use the DragonBar’s Vocabulary menu).
2. In the list, click the entry that interests you.

   Note: Scroll up to view alphanumeric words and special characters in the Vocabulary.
3. Say "click Properties" or click the Properties button.

To revise default formatting
- Modify the Printed form field as warranted.
- Add or revise automatic formatting as warranted.

To revise Context

1. Say “click Use printed form 1” or click "Use printed form 1" and then use the drop-down list to change to "after numbers" or "before numbers" or "between numbers" as warranted. As an example, here is how Dragon displays the Context for the form "kHz" to be used for the word "kilohertz" after a number:

   ![Context 1](image)

   2. Say "click Format" or click the Format button to open the Written Form Formatting dialog box.
   3. Choose from the following options:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert <code>&lt;value&gt;</code> space before and <code>&lt;value&gt;</code> space after</td>
<td>Inserts the specified number of spaces before and after the word or phrase. Use the drop-down fields to select a number of spaces. Valid values are: 0, 1, 2</td>
</tr>
<tr>
<td>Precede by <code>&lt;value&gt;</code> and follow with <code>&lt;value&gt;</code></td>
<td>Inserts the specified spacing before and after the word or phrase. Use the drop-down fields to select the spacing type. Valid values are: -(nothing), - New Line, - New Paragraph, - Tab</td>
</tr>
<tr>
<td>Format the next word with <code>&lt;value&gt;</code></td>
<td>Inserts the word or phrase using the specified capitalization. Use the drop-down field to select the capitalization type. Valid values are: with normal capitalization, there is no special capitalization associated with this word. - capitalized (initial capitals), - in all capitals, - without capitals</td>
</tr>
<tr>
<td>Format preceding numbers <code>&lt;value&gt;</code> and following numbers <code>&lt;value&gt;</code></td>
<td>Inserts numbers using the specified format. Use the drop-down field to select the format. Valid values are: normally (Dragon NaturallySpeaking determines whether to insert Arabic numerals or the written form of the number) - a-s numerals, - as Roman numerals</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays a preview of how Dragon will apply formatting before and after your word.</td>
</tr>
<tr>
<td>Lower case in titles</td>
<td>Causes the word or phrase to never be capitalized unless it appears at the beginning of a sentence or phrase. This is typical of short articles, such as &quot;a&quot;, &quot;of&quot;, or &quot;the&quot; when they appear in a title that is normally capitalized, for example &quot;The Grapes of Wrath&quot;. Check the &quot;Lower case in titles&quot; checkbox to enable this feature.</td>
</tr>
</tbody>
</table>
If you wish to add a second Context, repeat the steps above.
Chapter 13: Working in Programs

This section contains the following topics:

- Scrolling in popular programs .................................................. 139
- Using the ribbon interface in Microsoft applications .................. 140
- About spoken commands in word processing programs .......... 142
  - About spoken commands in word processing programs .......... 142
  - Dictating in your word processor ........................................ 142
- Working with Microsoft Word .................................................. 144
  - Basic document commands in Microsoft Word ....................... 144
  - Creating, opening, and closing a document ......................... 144
  - Saving a document ........................................................... 145
  - Selecting text ................................................................. 152
  - Formatting text in Microsoft Word ...................................... 152
- Email Programs ................................................................. 155
  - Supported e-mail programs ............................................... 155
  - Working in e-mail programs .............................................. 155
  - Commands for working with e-mail messages ....................... 156
  - Commands for moving around in e-mail .............................. 156
  - Dictating e-mail and Web addresses .................................. 157
  - Dictating E-mail and Calendar commands ............................ 158
  - Commands for Windows Live Mail ...................................... 160
- Microsoft Outlook .............................................................. 162
  - Working with Microsoft Outlook ....................................... 162
  - Reading and sending e-mail with Microsoft Outlook .............. 162
  - Making appointments in Microsoft Outlook ......................... 163
  - Adding contacts in Microsoft Outlook ................................ 164
  - Writing notes in Microsoft Outlook ................................... 165
  - Using other Microsoft Outlook commands ........................... 165
  - Dialog box commands .................................................... 166
  - Moving around in a message window ................................. 166
  - Microsoft Outlook 2010 commands .................................... 167
- Microsoft Excel ................................................................. 168
  - Working with Microsoft Excel ........................................... 168
  - Dictating in Microsoft Excel with Full Text Control .............. 168
  - Basic commands for Microsoft Excel .................................. 169
  - Creating, opening, and closing a spreadsheet ...................... 170
Scrolling in popular programs

You can use the following commands in many programs to scroll and move the view through the program's work area.

These voice scrolling commands work with the supported versions of Microsoft Office programs, including Word, Outlook, Excel, PowerPoint, and InfoPath.

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start automatic upward scrolling</td>
<td>&quot;Start Scrolling Up&quot;</td>
</tr>
<tr>
<td>Start automatic downward scrolling</td>
<td>&quot;Start Scrolling Down&quot;</td>
</tr>
<tr>
<td>Stop automatic scrolling</td>
<td>&quot;Stop Scrolling&quot;</td>
</tr>
<tr>
<td>Increase the speed of automatic scrolling</td>
<td>&quot;Scroll Faster&quot;</td>
</tr>
<tr>
<td>Reduce the speed of automatic scrolling</td>
<td>&quot;Scroll Slower&quot;</td>
</tr>
<tr>
<td>Move the visible page up one line</td>
<td>&quot;Scroll Up&quot;</td>
</tr>
<tr>
<td>Move the visible page down one line</td>
<td>&quot;Scroll Down&quot;</td>
</tr>
<tr>
<td>Move up one line in the text</td>
<td>&quot;Line Up&quot;</td>
</tr>
<tr>
<td>Move down one line in the text</td>
<td>&quot;Line Down&quot;</td>
</tr>
<tr>
<td>Move the page up by a screen</td>
<td>&quot;Page Up&quot;</td>
</tr>
<tr>
<td>Move the page down by a screen</td>
<td>&quot;Page Down&quot;</td>
</tr>
</tbody>
</table>

For more information on how these commands work in individual programs, please see the following:

- Scrolling in windows and lists
- Web browser commands
- Basic document commands in Microsoft Word
- Using other Microsoft Outlook commands
- Basic commands for Microsoft Excel
Using the ribbon interface in Microsoft applications

Dragon supports the "ribbon" menu interface of Microsoft Office 2010 and Microsoft Office 2013. (Both 32-bit and 64-bit versions of Microsoft Office are supported.)

The ribbon presents application features organized into a set of tabs, including a Home tab and a View tab. The tabs display the controls that are most relevant for each of the task areas in the application, such as changing the font or zooming in.

Using the Office ribbon

To minimize the ribbon by voice, you can say “Minimize the ribbon” or “Collapse ribbon.” To expand it, say “Maximize ribbon” or “Expand ribbon.” You can also use the verbs “pin,” “show,” “toggle,” “unhide,” and “view” with those ribbon commands.

Dragon voice commands for the Office ribbon also work when the ribbon is minimized.

To open one of the ribbon’s tabs

▶ Say "click" followed by the name of the tab (or click on that tab). For example, to open the Home tab, say "click Home."

Note that the File tab is an exception; to open it, you must also say the word tab, as in "click File tab".

To click an item on the open tab

▶ Say the name of the feature you want to access (or click on it). For example, to apply the Heading 1 style to your current line of text, say "click Heading 1" (or select Heading 1 from the list of Styles).

If you’re unsure of the name of a feature, you can hold your mouse pointer over that feature’s graphic until the name appears.

Here’s an example of how the ribbon looks when you click the Home tab in Word 2013.
Here's an example of what appears when you click the File tab in Word 2013:

![File tab in Word 2013](image)

The unlabeled menu in WordPad and Windows Live Mail

In Windows 7, WordPad and Windows Live Mail have a menu for file-related commands but there is no label on this menu's tab.

To open this menu by voice, you can say "click Application menu."

Note: To close the menu, you can say "press Escape."
About spoken commands in word processing programs

This section contains the following topics:

About spoken commands in word processing programs ...................................................... 142
Dictating in your word processor .......................................................... 142

About spoken commands in word processing programs

Dragon NaturallySpeaking provides Natural Language Commands for use with popular word processing programs other than Microsoft Word and Corel WordPerfect. By using these commands, you can avoid the multiple menu-selection and mouse-movement steps associated with the traditional Microsoft Windows interface. These commands let you:

- Move the text insertion point around a document
- Select a word, phrase, or block of text
- Format text (including indenting text, changing text fonts and styles, setting colors, applying paragraph styles, adding tables, setting margins, and inserting new lines and paragraphs)
- Run spelling and grammar checks
- Edit text (including moving, copying, pasting, and deleting text)
- Print all or part of a document and print preview your work

Because the number of valid commands is so large, you should just try saying what you want to do. If you get unexpected results, say "Undo That" to undo the action and try a different way to speak the command. Alternatively, you can open the Command Browser or the Dragon Learning Center for more information.

Notes

- Dragon NaturallySpeaking displays commands with a blue border in the Results box. If you say a phrase that produces no action, look in the Results box. If the box does not have a blue border, Dragon NaturallySpeaking does not recognize it as a valid command. For example, if you say "Insert a 2 by 2 Table" when the insertion point is inside a table, nothing happens because you cannot insert a table inside a table.
- When creating a new document, always give the document a name before starting your dictation.

Dictating in your word processor

If you are dictating in a word processor, there are some things you can do to make Dragon NaturallySpeaking work more efficiently:

- Do not run other programs when you are running your word processor.
- Disable your word processor’s automatic spelling and grammar checker. Turning these options off frees memory for speech recognition. When you have finished
dictating you can run the grammar checker. Dragon NaturallySpeaking does not make spelling errors.

- Disable any automatic correction or other automatic features such as automatic formatting if they are not necessary. Turning these options off frees memory for speech recognition.
- Divide large documents into multiple smaller documents. Large documents cause Dragon NaturallySpeaking to work more slowly. The maximum document size you should have depends on your system and its resources.
- You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other sounds. Dragon NaturallySpeaking may interpret such sounds as speech and replace the selection with new text. If this happens, say "Undo That" one or more times right away to reverse the action.
Working with Microsoft Word

Dragon NaturallySpeaking provides a large number of Natural Language commands to use with different versions of Microsoft Word. Using these commands, you can avoid the multiple menu-selection and mouse-movement steps associated with the traditional Microsoft Windows interface. Because the number of valid commands is so large, you should just try saying what you want to do. If you get unexpected results, say "Undo That" to undo the action and try a different way to speak the command. Alternatively, you can open the Command Browser or the Dragon Learning Center for more information.

You can cancel a selection by saying "Unselect That," selecting different text, or moving the insertion point to another part of the document.

The following topics describe the natural language commands you can use to perform some common tasks using Word:

Basic document commands
Selecting text
Formatting text
Working with tables (see Dragon Help)
Using Voice Notations (see Dragon Help)

Basic document commands in Microsoft Word

Use this procedure as a reference for basic document operations using Microsoft Word.

See also

- For text formatting and editing help, see Using Direct Editing commands and Handling multiple text matches.
- Using the Microsoft Office ribbon

Creating, opening, and closing a document

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new document</td>
<td>&quot;Create New File&quot; or &quot;Open New File&quot;</td>
</tr>
</tbody>
</table>
| Open an existing document | 1. "Open File"
2. ".<file name> dot <file extension>\"", for example, "My Document Dot Doc"
3. "Press Enter"
| Close a document     | "Close File" or "Close Document"                                  |
# Saving a document

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Save a document as a .doc file          | 1. "Save Changes"  
                                    | 2. Dictate a file name (only needed if this is the first time       |
|                                         | 3. "Click Save"                                                    |
| Save a document with a new file         | 1. "Save Document As"  
| name and file type                      | 2. Dictate a file name  
|                                         | 3. "File Type <file type from list>", for example, "RTF"           |
|                                         | 4. "Click Save"                                                    |
| Save a document in HTML format          | 1. "Save Document as Web Page"  
|                                         | 2. "Click Save"                                                   |
|                                         | 3. If a dialog box appears warning of a text format loss,           |
|                                         | "Click Continue"                                                   |
| Save as document template               | "Save the Page Settings as Default"                                |
### Page Setup

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the page orientation</td>
<td>&quot;Set Page Orientation to Landscape&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Page Orientation to Portrait&quot;</td>
</tr>
<tr>
<td>Set the size</td>
<td>&quot;Set Page Width to &lt;number&gt; Inches/Centimeters&quot;, for example, &quot;Set Page Width to Eight Inches&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Page Height to &lt;number&gt; Inches/Centimeters&quot;, for example, &quot;Set Page Height to Eleven Inches&quot;</td>
</tr>
<tr>
<td>Set margins</td>
<td>&quot;Set Left/Right Margin to &lt;number&gt; Inches/Centimeters&quot;, for example, &quot;Set Left Margin to Two Inches&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Top/Bottom Margin to &lt;number&gt; Inches/Centimeters&quot;, for example, &quot;Set Bottom Margin to Five Centimeters&quot;</td>
</tr>
<tr>
<td>Number pages</td>
<td>&quot;Add Page Numbers&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Page Numbers&quot;</td>
</tr>
<tr>
<td>Create headers and footers</td>
<td>1. &quot;Go To Header/Footer&quot;</td>
</tr>
<tr>
<td></td>
<td>2. Dictate text to appear in the header or footer</td>
</tr>
<tr>
<td></td>
<td>3. &quot;Close Header/Footer&quot;</td>
</tr>
<tr>
<td>Add footnotes</td>
<td>1. Move the insertion point to the location where you want the footnote</td>
</tr>
<tr>
<td></td>
<td>2. &quot;Insert Footnote Here&quot;</td>
</tr>
<tr>
<td></td>
<td>3. Dictate the footnote text</td>
</tr>
<tr>
<td></td>
<td>4. &quot;Close Footnotes&quot;</td>
</tr>
</tbody>
</table>

### Viewing a document

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>View a document</td>
<td>&quot;Preview the File&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;View Master Document&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Preview Document as HTML&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Close the Preview&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set View to Normal&quot;</td>
</tr>
<tr>
<td>Enlarge or reduce the</td>
<td>&quot;Zoom to &lt;number&gt; Percent&quot;, for example, &quot;Zoom to Fifty Percent&quot;</td>
</tr>
<tr>
<td>document view</td>
<td>&quot;Set Zoom to Page Width/Height&quot;</td>
</tr>
<tr>
<td>Change the display</td>
<td>&quot;Show/Hide Headers and Footers&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Show/Hide the Ruler&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Show/Hide Paragraph Marks&quot;</td>
</tr>
</tbody>
</table>
### Printing

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print a range of pages</td>
<td>&quot;Print Pages &lt;number&gt; to &lt;number&gt;&quot;, for example, &quot;Print Pages One to Three&quot;</td>
</tr>
</tbody>
</table>
| Print part of a page      | 1. "Select <First/Last> paragraph", for example, "Select the Last Paragraph"
|                           | 2. "Print the Paragraph" or "Print the Selection"                   |

### Checking spelling and grammar

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Check spelling            | 1. "Check Spelling"
|                           | 2. "Click Change" or "Click Ignore" depending on how you want to respond
|                           | 3. "Click Close" when the spelling check is complete                  |

### Searching and replacing

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Search for text           | 1. "Find a Word"
|                           | 2. Dictate the word or phrase you want to find in the Find dialog box
|                           | 3. "Click Find"                                                      |
| Replace all instances of  | 1. "Find Text"
| a word or phrase         | 2. Dictate the word or phrase you want to find                       |
|                           | 3. "Click Replace"                                                   |
|                           | 4. "Click Replace With" (to move the insertion point to the Replace With field)
|                           | 5. Dictate the replacement word or phrase                            |
|                           | 6. "Click Replace All"                                               |
|                           | 7. "Click Close" (to close the Find and Replace dialog box)           |
## Inserting document segments

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Add a page                | 1. "Go To <location>" (to move the insertion point to where you want to insert the new page). For example, "Go To Bottom" to add a new page at the end of the current document.  
2. "Add a New Page"   |
| Create a line break       | 1. "Go To <location>" (to move the insertion point to the location where you want the text to break). For example, "Go To third line" to add a line break at the end of the third line in the current paragraph.  
2. "Insert Hard Line Break" |
| Create a page break       | 1. "Go To <location>" (to move the insertion point to the location where you want the text to break). For example, "Go To third paragraph" to add a page break at the end of the third paragraph in the current page.  
2. "Insert Page Break" |
| Add the date and time     | 1. "Go To <location>" (to move the insertion point to the location where you want to place the information)  
2. "Insert Date and Time" or "Insert Date" or "Insert Time" |
Moving text
<table>
<thead>
<tr>
<th>To</th>
<th>Do</th>
</tr>
</thead>
</table>
| Move a word         | 1. Move the insertion point to the word you want to move  
|                     | 2. "Select Word"  
|                     | 3. "Move Word Forward/Back <number> Words/Lines", for example, "Move Word Forward Five Lines"                                |
| Move a line         | 1. Move the insertion point to the line you want to move  
|                     | 2. "Select Line"  
|                     | 3. "Move Line Forward/Back <number> Lines" or "Move Line to the Beginning/End of Paragraph/Document", for example, "Move Line to the End of Paragraph" |
| Move a paragraph    | 1. Move the insertion point to the paragraph you want to move  
|                     | 2. "Select Paragraph"  
|                     | 3. "Move Paragraph Forward/Backward <number> paragraphs" or "Move Paragraph to the Beginning/End of Document", for example, "Move Paragraph to the Beginning of Document" or "Move Paragraph Backward Six Paragraphs" |
Moving around in a document

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to a specific place in a document window</td>
<td>&quot;Go to &lt;location&gt;,” where location can be top, bottom, start, or end.</td>
</tr>
<tr>
<td>Move up or down one line</td>
<td>&quot;Line Up&quot; or &quot;Line Down&quot;</td>
</tr>
<tr>
<td>Move up or down one page</td>
<td>&quot;Page Up&quot; or &quot;Page Down&quot;</td>
</tr>
<tr>
<td>Go back to the last place you moved the cursor</td>
<td>&quot;Go Back&quot; See <a href="#">Using &quot;Go Back&quot; to move the cursor</a></td>
</tr>
</tbody>
</table>

Switching between open documents

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Switch between open documents           | 1. "Say "List windows for Microsoft Word"  
Do one of the following:  
➤ Say "Choose n", where n is the number of the window you want to switch to. For example, say "Choose 2"  
OR  
➤ Choose the number of the program from the list and click OK                                                                 |

See [Scrolling in popular programs](#), [Scrolling in windows and lists](#), and [Moving the insertion point](#).

**Note**

You can also select the next or previous word, line, or paragraph by moving the insertion point to either before or after the word, line or paragraph you want to select and saying "Select Next/Previous Word/Line/Paragraph".

**Note**

Word 2013 introduced a new layout called Read Mode, which aims to make it easier to read documents as well as related tasks such as obtaining the definition or translation of a word. When in Read Mode, you cannot use Dragon to dictate or perform selections or corrections in the open document, even though the DragonBar indicates that Dragon has Full Text Control. However, it is possible to dictate and perform operations when you are in a Comment field in Read Mode.
Selecting text
You can use the following voice commands to select text in Microsoft Word and OpenOffice.org Writer.

<table>
<thead>
<tr>
<th>To</th>
<th>Do</th>
</tr>
</thead>
</table>
| Select a word, line, or paragraph       | 1. Move the insertion point to the word, line, or paragraph you want to select  
2. Say "Select <word>/<line>/<paragraph>" |
| Select an adjacent word, line or paragraph | 1. Move the insertion point to either before or after the word, line, or paragraph you want to select.  
2. Say "Select <next>/<previous> <word>/<line>/<paragraph>" |
| Select specific text or a range of text (see also Handling multiple text matches) | ▶ Select <text>*  
▶ Select <text> Through <text> (Note: Outside the USA or Canada, say "Select <text> To <text>".)  
▶ Select from <text> to <text>  
* For <text> substitute whatever text you want select. |
| Extend a selection                       | ▶ "Extend Selection Forward/Backward by <number> Words/Lines/Paragraphs"  
▶ "Extend Selection Up/Down by <number> Lines/Paragraphs"  
▶ "Extend Selection Left/Right by <number> Words" |

Formatting text in Microsoft Word
This topic contains examples of voice commands to format text in Microsoft Word.

For information about applying formatting to multiple instances of words or phrases, see Handling multiple text matches.

Changing text properties

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Change text properties                  | "Set Word/Line/Paragraph to Strikeout"  
"Underline this Word/Line/Paragraph"  
"Italicize Next <number> Words"  
"Bold This Page" |
### Changing font and point sizes

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change font name and point size</td>
<td>&quot;Set the Font to Twenty Four Points Times in the Word/Line/Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Increase/Decrease the Font Size to Eighteen Points in the Word/Line/Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set the Font to Courier in the Selection/Word/Line/Paragraph/Page/Section/Document&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Decrease Selection by Two Points&quot;</td>
</tr>
</tbody>
</table>

### Changing font properties

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change font properties</td>
<td>&quot;Turn on Bold and Italics&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Format That Regular&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Italicize the Next &lt;number&gt; Words/Lines/Paragraphs,&quot; for example,</td>
</tr>
<tr>
<td></td>
<td>&quot;Italicize the Next Five Lines&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Unitalicize That&quot;</td>
</tr>
</tbody>
</table>

### Changing capitalization

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change case</td>
<td>&quot;Capitalize the First/Last/Next &lt;number&gt; Words/Lines/Paragraphs,&quot; for example,</td>
</tr>
<tr>
<td></td>
<td>&quot;Capitalize the Next Five Words&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Lowercase the First/Last/Next &lt;number&gt; Words/Lines/Paragraphs,&quot; for example,</td>
</tr>
<tr>
<td></td>
<td>&quot;Lowercase the Last Ten Words&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Toggle the Case of the Word&quot;</td>
</tr>
</tbody>
</table>

### Changing font color

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change font color</td>
<td>&quot;Set Font Color to Green in This Line&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set the Color to Red in the Selection&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set It to Dark Blue&quot; (refers to current word or selection)</td>
</tr>
</tbody>
</table>

### Changing line spacing

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change line and paragraph spacing</td>
<td>&quot;Double Space the Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Single Space Selection&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Increase Paragraph Spacing to &lt;number&gt; Inches/Centimeters&quot;</td>
</tr>
</tbody>
</table>
### Changing text justification

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change text justification</td>
<td>&quot;Justify the Document&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Right Justify It&quot; or &quot;Right Align Selection&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left Align This Line/Paragraph&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Initial Indent to &lt;number&gt; Inches/Centimeters&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Hanging Indent to &lt;number&gt; Inches/Centimeters on This Page&quot;</td>
</tr>
</tbody>
</table>

### Creating bulleted or numbered lists

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and delete bullet</td>
<td>&quot;Set the paragraph to Bulleted/Numbered&quot;</td>
</tr>
<tr>
<td>points or list numbers</td>
<td>&quot;Delete Bullets From the Document&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Unnumber the Selection&quot;</td>
</tr>
</tbody>
</table>

### Working with outlines

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an outline</td>
<td>&quot;Set View to Outline&quot;</td>
</tr>
</tbody>
</table>
Email Programs

This section contains the following topics:

Supported e-mail programs ................................................................. 155
Working in e-mail programs ............................................................... 155
Commands for working with e-mail messages ..................................... 156
Commands for moving around in e-mail .............................................. 156
Dictating e-mail and Web addresses .................................................... 157
Dictating E-mail and Calendar commands ......................................... 158
Commands for Windows Live Mail ..................................................... 160

Supported e-mail programs

The e-mail commands listed in this section work in the following desktop e-mail applications:

- Microsoft Outlook
- Lotus Notes
- Mozilla Thunderbird
- Windows Live Mail

Dragon's Web application commands, along with many of the commands for desktop e-mail applications, work in these Web-based applications in supported Web browsers:

- Gmail
- Outlook.com
- Yahoo

Note

Regardless of what email program you use, you should ensure that Dragon can transcribe the contact names and email addresses that matter to you. See the Accuracy Center for ways to do it, including adding contacts and scanning sent e-mail.

Working in e-mail programs

The commands described in this topic are only applicable to desktop e-mail applications, such as Microsoft Outlook. There are different commands for Web-based e-mail. If you're using web-based email programs, see Using web-based email for the commands.

Check the list of supported e-mail programs to verify that Dragon works with your e-mail application.

To start an e-mail program

- Say "Start Mail" to start your default e-mail program.

To access and create e-mail messages

Use the following commands to check for, open, and create messages.
Chapter 13: Working in Programs

Commands for working with e-mail messages

To work with e-mail messages

Use the following commands if you are working in your Inbox and have a message selected or open.

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for new messages</td>
<td>&quot;Check Mail&quot;</td>
</tr>
<tr>
<td>Open the selected e-mail message</td>
<td>&quot;Open Mail&quot;</td>
</tr>
<tr>
<td>Create an e-mail message</td>
<td>&quot;New Mail&quot;</td>
</tr>
</tbody>
</table>

Commands for moving around in e-mail

To move around in e-mail

Use the following commands to move around when editing e-mail. Please note that only "Go to Previous Field" and "Go to Next Field" are supported in Windows Live Mail.
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the To field</td>
<td>&quot;Go to To&quot;</td>
</tr>
<tr>
<td>Move to the Subject field</td>
<td>&quot;Go to &quot;Subject&quot;</td>
</tr>
<tr>
<td>Move to the Body field</td>
<td>&quot;Go to Body&quot;</td>
</tr>
<tr>
<td>Move to the CC field</td>
<td>&quot;Go to CC Field&quot;</td>
</tr>
<tr>
<td>Move to the BCC field</td>
<td>&quot;Go to BCC field&quot;</td>
</tr>
<tr>
<td>Move to the First field</td>
<td>&quot;Go to First Field&quot;</td>
</tr>
<tr>
<td>Move to the Previous field</td>
<td>&quot;Go to Previous Field&quot;</td>
</tr>
<tr>
<td>Move to the Next field</td>
<td>&quot;Go to Next Field&quot;</td>
</tr>
<tr>
<td>Move to the Last field</td>
<td>&quot;Go to Last Field&quot;</td>
</tr>
<tr>
<td>Move up or down one line</td>
<td>&quot;Line Up&quot;</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;Line Down&quot;</td>
</tr>
<tr>
<td>Move up or down one page</td>
<td>&quot;Page Up&quot;</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;Page Down&quot;</td>
</tr>
<tr>
<td>Go to a specific place in a document or</td>
<td>&quot;Go to &lt;location&gt;,&quot; where location can be</td>
</tr>
<tr>
<td>message window</td>
<td>top, bottom, start, or end.</td>
</tr>
<tr>
<td>Go back to the last place you moved the</td>
<td>&quot;Go Back&quot; See Using &quot;Go Back&quot; to move the</td>
</tr>
<tr>
<td>cursor</td>
<td>cursor</td>
</tr>
</tbody>
</table>

**Note**

You can say "E-mail," "Message," or "Memo" in place of "Mail" in these commands.

**Dictating e-mail and Web addresses**

You can dictate e-mail and Web addresses as you normally speak them. To make sure that the address is lowercase, say "no caps on".
To Dictate | Say
--- | ---
info@samplecompany.com | "no caps on info at sample company dot com no caps off"
http://www.samplecompany.com/sales | "no caps on http www dot sample company dot com slash sales no caps off"

Notes

- The "Web and E-mail Addresses" box must be selected on the Auto-formatting dialog box. for you to dictate e-mail addresses as described here.
- You can say the following abbreviations by pronouncing them as words: com, net, org, and sys. Say the following abbreviations by saying their letters: edu, gov, mil, ca, de, fr, jp, sp, and uk.
- If an address contains nonwords or words that Dragon NaturallySpeaking does not recognize (for example, "baxterex" in "juliasmith@baxterex.com"), you can correct the recognition error and the address will usually be recognized in the future. You can also add names that you commonly use to your Vocabulary.
- Create text and graphics commands for addresses you dictate frequently.
- You can use the "Spell That" command to correct e-mail and Web addresses by spelling.
- You can add the names in your address book to your Dragon NaturallySpeaking Vocabulary by running the Learn From Sent E-mails tool.

**Dictating E-mail and Calendar commands**

Use the Dragon Voice Shortcuts in this topic to directly create your e-mails as well as Microsoft Outlook calendar entries and tasks.

Before you begin

- Before using the Dragon e-mail and Outlook calendar commands for the first time, you must run the Learn From Sent E-mails tool, so that Dragon NaturallySpeaking knows your e-mail contacts. To run the tool, say "Open Accuracy Center," then "Click Learn From Sent E-Mails," or click Vocabulary > Learn From Sent E-Mails. For more information, see Learn From Sent E-mails.
- Make sure Microsoft Outlook is the default e-mail client, before you start dictating shortcut commands for tasks or calendar.

The following table lists the types of e-mail and calendar commands that Dragon NaturallySpeaking supports, an example command, and a description of what happens after you say the command.
<table>
<thead>
<tr>
<th>Command Type</th>
<th>Syntax</th>
<th>Example command</th>
<th>What happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email the selected text, message or file(s) to one or more contacts</td>
<td>E-mail the selection to <code>&lt;name&gt;</code>... and <code>&lt;name&gt;</code></td>
<td>&quot;E-mail the selection to Peter Moreno and Caroline Chang&quot;</td>
<td>A new e-mail appears, addressed to the person(s) named, with as body the selected text (or email) or as attachment(s) the file(s) selected in Windows Explorer.</td>
</tr>
<tr>
<td>Send e-mail to specific contacts who are listed in your e-mail address book or contact list</td>
<td>(Send</td>
<td>Create) [an</td>
<td>a] (e-mail</td>
</tr>
<tr>
<td>Send e-mail about a specific subject</td>
<td>(Send</td>
<td>Create) [an</td>
<td>a] (e-mail</td>
</tr>
<tr>
<td>Schedule a meeting with specific contacts</td>
<td>(Schedule</td>
<td>create</td>
<td>book) ([a] meeting</td>
</tr>
<tr>
<td>Schedule a meeting or appointment about a specific subject</td>
<td>(Schedule</td>
<td>create</td>
<td>book) ([a] meeting</td>
</tr>
<tr>
<td>Schedule a meeting or appointment at a specific time</td>
<td>(Schedule</td>
<td>create</td>
<td>book) ([a] meeting</td>
</tr>
<tr>
<td>Move a message from one Microsoft Outlook folder to another</td>
<td>Move [the] (e-mail</td>
<td>message</td>
<td>selection</td>
</tr>
<tr>
<td>Command Type</td>
<td>Syntax</td>
<td>Example command</td>
<td>What happens</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create a task in Microsoft Outlook</td>
<td>Create task &lt;about</td>
<td>&quot;Create task about today's shopping list&quot;</td>
<td>A task window opens, with the subject &quot;today's shopping list.&quot;</td>
</tr>
<tr>
<td></td>
<td>on&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- If e-mail and calendar commands are not working in Microsoft Outlook, make sure the Natspeak Outlook Add-in is enabled in the Outlook Options. See the Microsoft Help for information about setting the options.
- The e-mail commands “mail it to…”, “send this to…”, and “forward that to…” have been removed from Version 12. You can continue to use “e-mail the selection to…” command.

**Enabling or disabling these shortcut commands**

To enable or disable e-mail and calendar commands, open the Options dialog box, Commands Tab and do one of the following:

- Select or deselect the "Enable E-mail and Calendar commands" check box.

The option is enabled by default.

**Commands for Windows Live Mail**

You can use the following voice commands using Windows Live Mail.
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Start the e-mail application | "Start Windows Live Mail"
Instead of "start," you can also say "open," "launch" or "show". For example, say "show Windows Live Mail"
| Read messages | "Check for New Mail"
"Open Message"
"Go To Next Unread Message"
"Mark Message as Unread"
"Go To Previous Message"
"Delete Message"
"Close the Message Window"
| Create and send a message | 1. "Create Message"
2. "Move to Text Field"
3. Then, dictate the content of your message and when you ready to send, say "Send Message". |
| Go to your Windows contacts folder (for Windows 7 only) | "Go to [the] [Windows] contacts" (for Windows 7 only)
"Display contacts folder" (for Live Mail only)
| Reply to a message | 1. "Reply to Author" to reply to the sender only, or "Reply to All" to reply to all recipients of the message
2. "Move to Text Field"
3. Then, dictate the content of your message and when you ready to send, say "Send Message". |
| Forward a message | "Forward the Message"
| Sort Inbox messages | "Sort ascending | descending"
"Sort e-mails ascending | descending"
"Sort memos ascending | descending"
| Access file-related commands | "click Application menu"

**Note**

Words shown in [brackets] are optional.
Microsoft Outlook

This section contains the following topics:

Working with Microsoft Outlook ................................................................. 162
Reading and sending e-mail with Microsoft Outlook ................................. 162
Making appointments in Microsoft Outlook ............................................. 163
Adding contacts in Microsoft Outlook ...................................................... 164
Writing notes in Microsoft Outlook ............................................................. 165
Using other Microsoft Outlook commands .............................................. 165
Dialog box commands .................................................................................. 166
Moving around in a message window ......................................................... 166
Microsoft Outlook 2010 commands ............................................................ 167

Working with Microsoft Outlook

Dragon NaturallySpeaking provides a number of natural language commands to use with Microsoft Outlook. Using these commands, you can avoid the multiple menu-selection and mouse-movement steps associated with the traditional Microsoft Windows interface. Because the number of valid commands is so large, you should just try saying what you want to do. If you get unexpected results, say "Undo That" to undo the action and try a different way to speak the command. Alternatively, you can open the Command Browser or the Dragon Learning Center for more information.

You can cancel a selection by saying "Unselect That", selecting different text, or moving the insertion point to another part of the document.

For information about applying formatting to multiple instances of words or phrases, see Handling multiple text matches.

In addition, the following topics describe the natural language commands you can use to perform some common tasks using Microsoft Outlook:

Reading and sending e-mail

E-mail and Calendar commands

Making appointments

Adding contacts

Writing notes

Using other Microsoft Outlook commands

Reading and sending e-mail with Microsoft Outlook

You can use the following voice commands to read, create, and send e-mail using Microsoft Outlook:
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a message without having Microsoft Outlook open</td>
<td>Say either of the following:</td>
</tr>
<tr>
<td></td>
<td>• &quot;Send e-mail to &lt;contact name&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>• &quot;Start Microsoft Outlook&quot;</td>
</tr>
<tr>
<td>Read your e-mail</td>
<td>1. &quot;Start Microsoft Outlook&quot;</td>
</tr>
<tr>
<td></td>
<td>Instead of &quot;start&quot;, you can also say &quot;open&quot;, &quot;launch&quot; or &quot;show&quot;. For example, say &quot;show Microsoft Outlook&quot;</td>
</tr>
<tr>
<td></td>
<td>2. &quot;Go To Inbox&quot;</td>
</tr>
<tr>
<td></td>
<td>3. &quot;Check for new mail&quot;</td>
</tr>
<tr>
<td></td>
<td>4. &quot;Open Mail Message&quot; to read first unread message</td>
</tr>
<tr>
<td>Reply to a message</td>
<td>1. &quot;Reply to Message&quot; or &quot;Reply to This Message&quot; to reply to the sender only, or &quot;Reply to All&quot; to reply to all recipients of the message</td>
</tr>
<tr>
<td></td>
<td>2. Dictate your reply</td>
</tr>
<tr>
<td></td>
<td>3. &quot;Send Message&quot;</td>
</tr>
<tr>
<td>Create a new message</td>
<td>1. &quot;Create E-mail&quot;</td>
</tr>
<tr>
<td></td>
<td>2. Dictate the address of the recipient</td>
</tr>
<tr>
<td></td>
<td>3. &quot;Subject&quot;</td>
</tr>
<tr>
<td></td>
<td>4. Dictate the subject line</td>
</tr>
<tr>
<td></td>
<td>5. &quot;Text Field&quot; or &quot;Move to Text&quot;</td>
</tr>
<tr>
<td></td>
<td>6. Dictate the text of the message</td>
</tr>
<tr>
<td></td>
<td>7. &quot;Send Message&quot;</td>
</tr>
<tr>
<td>Miscellaneous e-mail commands</td>
<td>• &quot;Mark the Message as Unread&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Copy this Message to a Folder&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Flag Message for Followup&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Close All Items&quot;</td>
</tr>
</tbody>
</table>

**Tip:** You can use the Send E-mail command even if Microsoft Outlook is closed. Here’s how:

1. Say "Send E-Mail to <contact name>," where *contact name* is the name of someone in your Outlook Contacts. Dragon opens an Outlook message with the contact name entered in the To field.
2. Compose your message and send it as usual. Outlook remains closed after the message is sent.

**Making appointments in Microsoft Outlook**

You can use the following voice commands to make appointments in Microsoft Outlook:
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Open your       | 1. "Start Microsoft Outlook"
| calendar         | Instead of "start", you can also say "open", "launch" or "show". For
|                  | example, say "show Microsoft Outlook"
|                  | 2. "View Calendar"                                                    |
| Create an event  | 1. "Create New All Day Event"
|                  | 2. Dictate the subject line, for example, "Company Picnic"
|                  | 3. "Set Start Time to <day>", for example "Set Start Time to Monday"
|                  | 4. "Press Tab Key" to move to the text box
|                  | 5. Dictate any additional information you want for the event, for example
|                  | "Be sure to bring your choice of beverage"
|                  | 6. "Invite People to This Event"
|                  | 7. Dictate the e-mail addresses of all the people you want to receive the
|                  | invitation
|                  | 8. "Send this appointment"                                            |
| Other appointment | "Make This an Online Event"
| commands         | "Set Reminder On"
|                  | "Show Time as Tentative"
|                  | "Decline This Event"
|                  | "Mark This Appointment as Unread"
|                  | "Forward This Appointment"

**Adding contacts in Microsoft Outlook**

You can use the following voice commands to add contacts in Microsoft Outlook:
## Writing notes in Microsoft Outlook

You can use the following voice commands to write notes in Microsoft Outlook:

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Open the Outlook notepad | 1. "Start Microsoft Outlook"  
Instead of "start", you can also say "open", "launch" or "show." For example, say "show Microsoft Outlook"  
2. "Open New Note" |

| Create and format a note | 1. Dictate the text of the new note  
2. "Right Align This", "Left Align This", "Justify This", or "Center This" to set the text alignment  
3. "Set This <text property>" where <text property> is any font style or point size you want  
4. "Find a Word" to perform a search |

## Using other Microsoft Outlook commands

You can use the following voice commands to access various features in Microsoft Outlook:
Chapter 13: Working in Programs

Miscellaneous commands

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the calendar view</td>
<td>&quot;View Calendar&quot;</td>
</tr>
</tbody>
</table>
| Open and view the journal properties | 1. "View Journal"  
                                        | 2. "View Properties" or "View Properties of Journal" |
| Open Internet Explorer from Outlook | "Switch to Web Browser"                 |

Dialog box commands

When you create or edit e-mail messages in HTML format, you must use the same voice commands that you use in Internet Explorer to navigate in certain Outlook dialog boxes, such as the Find, Picture, and Font dialog boxes. You can identify these dialog boxes by the Internet Explorer symbol (a small document icon with the letter "e" in it) appearing in the upper-left corner of the dialog box header. To allow Dragon NaturallySpeaking to recognize these commands, you must have the "Enable commands in HTML windows" option selected on the Commands tab of the Options dialog box.

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click a button</td>
<td>&quot;Click &lt;button name&gt;&quot;, for example, &quot;Click Apply&quot;. Saying &quot;Click&quot; is optional.</td>
</tr>
<tr>
<td>Show all check boxes and go to the first one</td>
<td>&quot;Click Check Box&quot; or &quot;Check Box&quot;</td>
</tr>
<tr>
<td>Show all option (radio) buttons on the dialog box</td>
<td>&quot;Click Radio Button&quot; or &quot;Radio Button&quot;</td>
</tr>
<tr>
<td>Show all boxes with lists of choices</td>
<td>&quot;Click List Box&quot; or &quot;List Box&quot;</td>
</tr>
<tr>
<td>Open a list of choices</td>
<td>&quot;Show Choices&quot;</td>
</tr>
<tr>
<td>Close a list of choices</td>
<td>&quot;Hide Choices&quot;</td>
</tr>
<tr>
<td>Choose an entry from a list of choices</td>
<td>&quot;Choose &lt;text&gt;&quot;, for example, &quot;Choose Ariel bold&quot;. Saying &quot;Choose&quot; is optional.</td>
</tr>
<tr>
<td>Select the item identified by a number such as that appears if your choice matches more than one thing</td>
<td>&quot;Choose &lt;number&gt;&quot;, for example, &quot;Choose Eight&quot;.</td>
</tr>
<tr>
<td>Select the next matching object on the dialog box</td>
<td>&quot;Next&quot;, &quot;Next Match&quot;, or &quot;Next Control&quot;</td>
</tr>
<tr>
<td>Select the previous object on the dialog box</td>
<td>&quot;Previous&quot;, &quot;Previous Match&quot;, or &quot;Previous Control&quot;</td>
</tr>
<tr>
<td>Click the selected edit box or other object.</td>
<td>&quot;Click That&quot;</td>
</tr>
</tbody>
</table>

Moving around in a message window

See [Scrolling in popular programs](#) and [Scrolling in windows and lists](#).
## Microsoft Outlook 2010 commands

<table>
<thead>
<tr>
<th>To</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an appointment</td>
<td>&quot;Create a new appointment at (&lt;time&gt;)&quot; For example, (&quot;12:15 p.m.)&quot; See Times in Auto-formatting dialog box..</td>
</tr>
<tr>
<td>Copy information from one contact to another</td>
<td>&quot;Copy to new contact&quot;</td>
</tr>
<tr>
<td>Ignore a conversation</td>
<td>&quot;Ignore conversation&quot;</td>
</tr>
<tr>
<td>Clean up a conversation</td>
<td>&quot;Clean up conversation&quot;</td>
</tr>
<tr>
<td>Clean up a folder</td>
<td>&quot;Clean up folder&quot;</td>
</tr>
<tr>
<td>Clean up a folder and all it's subfolders</td>
<td>&quot;Clean up folder and subfolders&quot;</td>
</tr>
</tbody>
</table>
Microsoft Excel

This section contains the following topics:

- Working with Microsoft Excel ....................................................... 168
- Dictating in Microsoft Excel with Full Text Control .......................... 168
- Basic commands for Microsoft Excel ............................................. 169
- Creating, opening, and closing a spreadsheet .................................. 170
- Editing in a spreadsheet .............................................................. 170
- Saving, renaming, and moving to another a spreadsheet ................... 170
- Setting up a spreadsheet ............................................................. 171
- Viewing the spreadsheet ............................................................. 171
- Printing ....................................................................................... 171
- Moving around a spreadsheet ......................................................... 171
- Switching between open spreadsheets ............................................ 172
- Formatting a Microsoft Excel spreadsheet ...................................... 173
- Working with cell contents in Microsoft Excel ................................ 173

Working with Microsoft Excel

Dragon NaturallySpeaking provides a number of natural language commands to use with Microsoft Excel. Using these commands, you can avoid the multiple menu-selection and mouse-movement steps associated with the traditional Microsoft Windows interface. Because the number of valid commands is so large, you should just try saying what you want to do. If you get unexpected results, say "Undo That" to undo the action and try a different way to speak the command. Alternatively, you can open the Command Browser or the Dragon Learning Center for more information.

You can cancel a selection by saying "Unselect That", selecting different text, or moving the insertion point to another part of the document.

In addition, the following topics describe the natural language commands you can use to perform some common tasks using Microsoft Excel:

- Dictating in Microsoft Excel with Full Text Control
- Basic Microsoft Excel commands
- Formatting a Microsoft Excel spreadsheet
- Working with contents in Microsoft Excel

Dictating in Microsoft Excel with Full Text Control

You can use Full Text Control commands and built-in commands to enter and revise content and to navigate between cells in Microsoft Excel. For a complete list of the commands you can use in Microsoft Excel, use the Command Browser.

Dictation and Editing Modes

There are two modes for using voice commands in Microsoft Excel. The two modes are described in the following table.
### Edition Mode | Description
--- | ---
| **Quick Edition Mode** | Allows you to enter new content into a cell, overwrite the current contents of a cell, or format the entire contents of a cell. When you select a cell and begin dictating, a yellow background appears to indicate that the dictated text will be inserted into the cell. If the cell currently contains text, the new dictated text will overwrite the existing text. If you want to format the contents of a cell, select the cell, or select a portion of the cell’s contents using Full Text Control commands, and say a formatting command, such as "Set Font Arial 10 Points Bold".
| **Full Edition Mode** | Allows you to edit the existing contents of a cell. If you want to add to or edit the current contents of a cell, select the cell and say "Edit Cell" or "Press F2" to open the cell for editing. When you enter Full Edition Mode, the background color changes to blue. Entering Full Edition Mode is analogous to double-clicking a cell. Line and Paragraph commands, such as "New Line" operate within the selected cell in Full Edition mode.

#### Using Full Text Control

In general, Full Text Control is available in cells except when you type something into a cell before you dictate. For example:

- If you dictate into a cell, then type some characters, and dictate more text into that cell, Full Text Control is available.
- If you type at the beginning of a cell and dictate some text or numbers, Full Text Control is available only on the portion you dictated.
- Once you have edited a cell using any combination of typing and dictation, when you move back to that cell by voice, Full Text Control is available in the entire cell.
- The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after <xyz> …) work thanks to a functionality called Full Text Control. This functionality depends on Dragon’s ability to constantly obtain information from the text field about its content—for instance, in order to know where words and sentences begin and end, so Dragon can apply spacing between words and capitalization at the beginning of sentences. Most standard text fields allow full Full Text Control capabilities. For more information, see [The Full Text Control Indicator](#).

#### Basic commands for Microsoft Excel

You can use the following voice commands to perform basic operations using Microsoft Excel.
## Creating, opening, and closing a spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new spreadsheet</td>
<td>&quot;Create New File&quot; or &quot;Create New Workbook&quot;</td>
</tr>
</tbody>
</table>
| Open an existing spreadsheet | 1. "Open File" or "Open Document"  
|                          | 2. "<file name>", for example, "My Spreadsheet"  
|                          | 3. "Press Enter"                                        |
| Close a spreadsheet     | "Close File" or "Close Document"                        |

### Editing in a spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new line within a cell</td>
<td>&quot;New Line&quot;</td>
</tr>
<tr>
<td>Edit the contents of a selected cell</td>
<td>&quot;Edit cell&quot; or &quot;Edit selection&quot;</td>
</tr>
<tr>
<td>Complete a cell entry and stay in the cell</td>
<td>&quot;Apply&quot;</td>
</tr>
<tr>
<td>Complete a cell entry and move down one cell (Quick Edition mode only)</td>
<td>&quot;Press Enter&quot;</td>
</tr>
<tr>
<td>Cancel a cell entry and remain in the cell</td>
<td>&quot;Press Escape&quot; or &quot;Cancel&quot;</td>
</tr>
</tbody>
</table>

### Saving, renaming, and moving to another a spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Save a spreadsheet as a .xls file     | 1. "Save file"  
|                                       | 2. Dictate a file name (only needed if this is the first time the file has been saved)  
|                                       | 3. "Click Save"                                                     |
| Save a spreadsheet in HTML format     | 1. "Save File as Web Page"  
|                                       | 2. "Click Save"  
|                                       | 3. (If a dialog box appears warning of a format loss) "Click Continue" |
| Rename a spreadsheet                  | "Rename the Worksheet"                                             |
| Moving to another open spreadsheet    | "Go To the Next/Previous Worksheet"                                |
### Setting up a spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set printing area</td>
<td>1. &quot;Fit to &lt;number&gt; Pages Wide&quot;</td>
</tr>
<tr>
<td></td>
<td>2. &quot;Fit to &lt;number&gt; Pages Tall&quot;</td>
</tr>
</tbody>
</table>

### Viewing the spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enlarge or reduce the spreadsheet view</td>
<td>&quot;Zoom to &lt;number&gt; Percent&quot;, for example, &quot;Zoom to Fifty Percent&quot;</td>
</tr>
<tr>
<td>Change the display</td>
<td>- &quot;Hide/Unhide This Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Hide/Show the Drawing Toolbar&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Hide/Unhide the Formulas in This Column/Row&quot;</td>
</tr>
</tbody>
</table>

### Printing

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print a range of pages</td>
<td>&quot;Print Workbook&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Print the Selection&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Print Column &lt;number&gt; to Column &lt;number&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Print Next &lt;number&gt; Rows&quot;</td>
</tr>
<tr>
<td>Preview a printout</td>
<td>&quot;Go To Print Break Preview&quot;</td>
</tr>
<tr>
<td>Print part of a page</td>
<td>&quot;Set Print Area to Selection&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Print Area to the First/Next/Previous &lt;number&gt; Rows/Columns&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Print the Selection&quot;</td>
</tr>
</tbody>
</table>

### Moving around a spreadsheet

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to new location</td>
<td>&quot;Next/Previous Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Start of This/Next/Previous Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Row/Column &lt;number/letter&gt;&quot;, for example, &quot;Row Five&quot; or &quot;Column A&quot;.</td>
</tr>
<tr>
<td></td>
<td>If the column includes two or more letters, say the alpha-bravo form</td>
</tr>
<tr>
<td></td>
<td>of the letter, for example to go to Column AB, say &quot;Column Alpha Bravo&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Start of Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Next/Previous Cell in the Row/Column&quot;</td>
</tr>
<tr>
<td>To</td>
<td>Say</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Start automatic downward scrolling</td>
<td>&quot;Start Scrolling Down&quot;</td>
</tr>
<tr>
<td>Start automatic upward scrolling</td>
<td>&quot;Start Scrolling Up&quot;</td>
</tr>
<tr>
<td>Move to the bottom of the spreadsheet</td>
<td>&quot;Scroll Down&quot;</td>
</tr>
<tr>
<td>Move to the top of the spreadsheet</td>
<td>&quot;Scroll Up&quot;</td>
</tr>
<tr>
<td>Stop automatic scrolling</td>
<td>&quot;Stop Scrolling&quot;</td>
</tr>
<tr>
<td>Increase the rate of automatic scrolling</td>
<td>&quot;Scroll Faster&quot;</td>
</tr>
<tr>
<td>Decrease the rate of automatic scrolling</td>
<td>&quot;Scroll Slower&quot;</td>
</tr>
<tr>
<td>Move down one row</td>
<td>&quot;Line Down&quot;</td>
</tr>
<tr>
<td>Move up one row</td>
<td>&quot;Line Up&quot;</td>
</tr>
</tbody>
</table>

**Switching between open spreadsheets**

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between open spreadsheets</td>
<td>1. Say &quot;List windows for Microsoft Excel&quot;</td>
</tr>
<tr>
<td></td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>▶ Say &quot;Choose n&quot;, where n is the number of the</td>
</tr>
<tr>
<td></td>
<td>window you want to switch to. For example, say</td>
</tr>
<tr>
<td></td>
<td>&quot;Choose 2&quot;</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>▶ Choose the number of the program from the</td>
</tr>
<tr>
<td></td>
<td>list and click OK</td>
</tr>
</tbody>
</table>
Formatting a Microsoft Excel spreadsheet

You can use the following voice commands to format a Microsoft Excel spreadsheet:

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change column width</td>
<td>&quot;Set Column Width to &lt;number&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Set Width to &lt;number&gt; in Column &lt;number&gt;&quot;</td>
</tr>
<tr>
<td>Change row and column appearance</td>
<td>&quot;Shade This Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Apply Pattern to Current/This Row/Column&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Center the Next/Previous &lt;number&gt; Rows/Columns&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Indent the Next/Previous &lt;number&gt; Rows/Columns &lt;number&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Bold/Italicize This Row/Column/Cell&quot;</td>
</tr>
</tbody>
</table>

Working with cell contents in Microsoft Excel

You can use the following voice commands to work with content in Microsoft Excel. See also Basic commands for Microsoft Excel.
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Edit the contents of a selected cell    | "Edit cell"  
Or  
"Edit selection"                                                              |
| Sum or average a column or row of numbers | 1. Move the insertion point to the cell where you want the sum to appear  
2. "Sum/Average the Values on the Right/on the Left/Above/Below" |
| Sort a column or row of numbers         | 1. Select the row, column, or range of cells you want to sort  
2. "Sort the Selection"                                                              |
| Change contents from decimals to fractions | 1. Move the insertion point to the row, column, or cell you want to change  
2. "Set this Row/Column/Cell to Fractions in <number>", for example "Set this Cell to Fractions in Eighths" |
| Lock or unlock contents                  | 1. Move the insertion point to the row, column, or cell you want to lock or unlock  
2. "Lock/Unlock This Row/Column/Cell"                                                              |
| Fill a cell, row, or column             | 1. Move the insertion point to the row, column, or cell you want to fill  
2. "Fill This Cell Up/Down/Right/Left <number>  
Cells/Rows/Column", for example, "Fill This Cell Down Two Rows" |
| Delete the contents of a cell, row, or column | 1. Move the insertion point to the row, column, or cell you want to clear  
2. "Clear All From This Row/Column/Cell"                                                              |
| Hide the contents of a cell, row, or column | 1. Move the insertion point to the row, column, or cell you want to hide  
2. "Hide This Row/Column/Cell"                                                              |
Chapter 14: Working with Web applications

This section contains the following topics:

- About the Dragon Web Extension ......................................................... 176
- Browser requirements for the Dragon Web Extension ............................ 176
- Installing and enabling the Dragon Web Extension ............................... 177
- How to tell if the Dragon Web Extension is Enabled .............................. 182
- Using Web-based Email ...................................................................... 183
- Editing text in a supported Web application ........................................ 186
- Using Dragon’s Web capabilities without the Dragon Web Extension ...... 189
- If you have problems using Web application support ........................... 190

About the Dragon Web Extension

The Dragon Web Extension allows you to use Full Text Control in supported browsers and most Web applications to help you perform common tasks by voice. For example, you can say "Click Link", "Click Button", or "Click Inbox" to click the elements on the page. If you do not install the Dragon web extension, you cannot click page elements by voice. In addition, Full Text Control is not available for dictation in the browsers and Web applications. Without the Dragon web extension enabled, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

Note: Dragon's functionality differs between Web browsers. For more information, see Working with a Web browser. For example, in Chrome, you cannot use the "Refresh Page" command. For this action, you must use global commands, such as mouse commands, or press commands, such as “Press F5”.

Browser requirements for the Dragon Web Extension

The Dragon Web Extension is available in the following Web browsers and versions:

- Microsoft Internet Explorer, version 9, 10, and 11, both 32-bit and 64-bit
- Mozilla Firefox version 24 and later
- Google Chrome
If you don't have one of these browsers in the version listed, you cannot click page elements by voice. In addition, Full Text Control is not available in the browsers and Web applications. You'll need to click page elements manually (or using MouseGrid and mouse commands) and, if you want Full Text Control, you’ll need to use the Dictation Box.

The makers of Firefox and Chrome frequently release new versions of their browser. For the latest details on Dragon functionality with a particular application, please see the Technical Support page for Dragon on the Nuance website.

**Note**: Dragon’s functionality differs between Web browsers. For example, in Chrome, you cannot use the “refresh page” command; to perform such actions by voice, you must use mouse commands or press commands such as “press F5”. For more information, see Working with a Web browser.

**Feature support**

The feature is not supported in the following modes:

- Chrome's Incognito mode
- Chrome's Metro mode
- Firefox's Metro mode

### Installing and enabling the Dragon Web Extension

To enable The Dragon Web Extension, do the following.

If you need to re-install, see [here](#).

**Internet Explorer 9 and later**

1. Open Internet Explorer. A prompt appears the first time you open the browser after Dragon installation.

   ![Enable Dragon in Internet Explorer](image)

   **Note**: If you click No Thanks at the initial prompt and then later decide to install the extension, you must close and reopen both Internet Explorer and Dragon for the prompt to reappear. If you select Do not ask me again and then later decide to install the extension, see [Do you need to reinstall?](#) below.
2. Click **Proceed**. Installation instructions appear.

![Install Dragon Web Extension for IE]

If you would like to use Dragon with Internet Explorer, you must install the Dragon Web Extension by performing the steps in Option A or B:

**Option A:**

If you see a message at the bottom of the page like this one:

![Enable Dragon Web Extension]

1. Ensure that the message refers to "Dragon Web Extension".
2. Click "Enable".
3. Restart Internet Explorer.

**Option B:**

If you don't see the message in Option A, please follow these steps to install the Dragon Web Extension:

1. Click the Settings button in the top-right of Internet Explorer, or press "Alt-T".
2. Choose "Manage Add-ons".
3. In the list of Add-ons, select the item called "Dragon Web Extension for Internet Explorer".
4. Click "Enable".
5. Click "Close".
6. Restart Internet Explorer.

3. Follow the instructions provided.

**Mozilla Firefox 24 or later**

1. Open Firefox. When a valid user profile is loaded, a prompt appears the first time you open the browser after Dragon installation.

![Enable Dragon in Firefox]

**Note:** If you click **No Thanks** at the initial prompt and then later decide to install the extension, you must close and reopen both Firefox and Dragon for the prompt to reappear. If you select Do not ask me again and then later decide to install the extension, see **Do you need to reinstall?** below.

2. Click **Proceed**. Installation instructions appear.
Install Dragon web extension for Firefox

Step 1

Click the button below to install the Dragon web extension for Firefox:

Install web extension

When you see this message, click “Allow”.

When you see this message, click “Install Now”.

Step 2 - Important!

You must now ensure that the Dragon Plugin is set to “Always Activate”. Click the button below to view the plugin settings in a new tab. This screenshot shows the location of the setting.

Verify plugin settings

When you are done, you may close the Add-Ons Manager tab.
3. Click the **Install web extension** button, and then follow the instructions on the screen to install the web extension.

4. Click the **Verify plugin settings** button, and then follow the instructions on the screen to verify the plugin settings.

When you've installed the extension and plugin, ensure that the **Update Add-ons Automatically** option is selected to receive updates from Nuance. To select it:

1. Click the Firefox button 😠, and then select **Add-ons**. The Add-ons Manager appears.

2. Click the cog icon 🔧, and then select **Update Add-ons Automatically** if it is not already selected.

---

**Google Chrome 16 or later**

1. Open Chrome. When a valid user profile is loaded, a prompt appears the first time you open the browser after you install Dragon.

---

**Note:** If you click **No Thanks** at the initial prompt and then later decide to enable the Dragon Web Extension, you must close and reopen both Chrome and Dragon for the prompt to reappear. In addition, if you select **Do not ask me again** and then later decide to install the extension, see **Do you need to reinstall?** below.
2. Click **Proceed**. The Chrome Web Store opens.

3. Click **Add**. A confirmation appears.
4. Click **Add**. Chrome downloads and installs the extension.

![Chrome Web Extension](image)

Resolving problems

If you're having trouble, see [If you have problems using Web Application support](#).

Do you need to re-install?

If you did not enable the extension initially, copy and paste the appropriate link to the address bar of your browser for installation instructions:

**Internet Explorer:**

**Chrome:**

**Firefox:**

How to tell if the Dragon Web Extension is Enabled

To determine if the **Dragon Web Extension** is enabled:

**Internet Explorer**

1. Open Internet Explorer.

2. Click the cog icon, and then select **Manage add-ons**. The Manage Add-ons dialog box opens.

3. Look for the Dragon Web Extension and plugin and ensure the status is **Enabled**.

![Manage Add-ons Dialog](image)

If the status is **Disabled**, do the following to enable it:

- Select the extension.
- Click **Enable** at the bottom of the Manage Add-ons dialog box.
- Restart the browser.
Mozilla Firefox

1. Open Mozilla Firefox.

2. Click the Firefox button or the Menu icon, and then select Add-ons. The Add-ons Manager appears.

3. Click Plugins and look for the Dragon NaturallySpeaking Plugin.

4. Click Extensions and look for the Dragon Web Extension.

In older versions of Firefox, the Enable option appears rather than Always Activate. Click the Enable button to enable it.

Google Chrome

1. Open Google Chrome.

2. Click the menu icon, and then select Settings. The Settings page opens.


4. Look for the Dragon Web Extension and ensure it is enabled.

If it is disabled, select the Enabled check box to enable it.

Resolving problems

If this is the first time you've tried using a supported web application with Dragon, try restarting your browser and reconnecting to the web application.

If you are using a Web application and browser that support the Dragon web extension, but the feature is not active, see If you have problems using Web application support.

For more information, see Using the Dictation Box, Web browser commands and Dictating e-mail and Web addresses.

Using Web-based Email

To write email using a web-based email program, you must have installed the Dragon web extension for your browser. The Dragon Web Extension allows you to use Full Text Control in supported browsers and most Web applications to help you perform common tasks by voice.
For example, you can say "Click Link", "Click Button", or "Click Inbox" to click the elements on the page. If you do not install the Dragon web extension, you cannot click page elements by voice. In addition, Full Text Control is not available for dictation in the browsers and Web applications. Without the Dragon web extension enabled, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

**Note:** This topic applies to web-based email programs only. For information on using Dragon with other email programs, such as Microsoft Outlook, see [Working in email programs](#).

**Before you begin**

Before you begin, make sure

- The [Web extension](#) is enabled if you are using Internet Explorer, Google Chrome or Mozilla Firefox. Please see [How to tell if Web application support is active](#).
- You have your email Web application open and you are logged in.
- If you're using Gmail, you're using Gmail's latest interface layout. Dragon's Gmail support only works with the newest Gmail interface and not with Gmail "Classic."

**Writing e-mail messages**

Use the following steps to write e-mail messages.

1. To start a new message, say "Click New" or "Click Compose," as required.
2. Do the following:
   - Say "Click Text Field", and then say "Choose X", where X is the number next to the To field. Then, Dictate the e-mail address of the person you'll be sending the message to.
     If you see a list of suggested addresses, choose one from the list by saying "Choose <n>"; where <n> is the number shown for the address you want to use. If the address is not in the list, continue dictating the address.
   - Say "Click Text Field", and then say "Choose X", where X is the number next to the Subject field. Then, dictate your subject text.
   - Say "Click Text Field", and then say "Choose X", where X is the number next to the Body field. Then, dictate your message.
3. Say "Click Send".

**Using commands**

[The Dragon Web Extension](#) adds the following voice commands to most email web applications. See also [Editing text in a supported Web application](#).
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show all places on the page where you can enter text</td>
<td>&quot;Click Type Text&quot; or &quot;Click Edit Box&quot;</td>
</tr>
<tr>
<td>Show all text fields on the page</td>
<td>&quot;Click Text Field&quot;</td>
</tr>
<tr>
<td>Show all check boxes on the page</td>
<td>&quot;Click Check Box&quot;</td>
</tr>
<tr>
<td>Show all images on the page with links</td>
<td>&quot;Click Image&quot;</td>
</tr>
<tr>
<td>Show all buttons on the page</td>
<td>&quot;Click Button&quot;</td>
</tr>
<tr>
<td>Show all links on the page</td>
<td>&quot;Click Link&quot;</td>
</tr>
<tr>
<td>Show all radio buttons on the page</td>
<td>&quot;Click Radio Button&quot;</td>
</tr>
<tr>
<td>Show all boxes on the page with lists of choice</td>
<td>&quot;Click List Box&quot;</td>
</tr>
<tr>
<td>Open a list of choices</td>
<td>&quot;Show Choices&quot;</td>
</tr>
<tr>
<td>Close a list of choices</td>
<td>&quot;Hide Choices&quot;</td>
</tr>
<tr>
<td>Choose an entry from a list of choices</td>
<td>&quot;Choose &lt;text&gt;&quot;; for example, &quot;Choose Hardware Compatibility Guide.&quot; Saying &quot;Choose&quot; is optional.</td>
</tr>
</tbody>
</table>

Using Dragon’s Web capabilities without the Dragon Web Extension

If the Dragon Web Extension isn’t available, you cannot click web page elements by voice directly; also, for Firefox and Chrome, none of the text fields have Full Text Control.

Symptoms of lack of Full Text Control include:
- The Dictation Box appears (if the option for this automatic opening is active).
- Dragon does not capitalize the first word.
- Dragon does not insert space before a word as expected.

Without the Dragon Web Extension, you’ll need to click page elements manually or with global commands, and you may wish to use the Dictation Box to dictate or edit in text fields.

Global commands that can be helpful for Web navigation include keyboard commands such as “press Alt d,” “press Enter,” “press tab,” “press F5,” and “page down,” as well as commands for clicking and dragging the mouse, such as “MouseGrid 3 3” and “mouse click.”

For more information about Dragon’s Web capabilities, see Working with a Web browser.
Editing text in a supported Web application

Use this topic for examples of how you can edit text in any of the Web applications that Dragon supports.

In supported browsers, you'll have Full Text Control, so that you can dictate content and use a broad range of Dragon commands. You'll also be able to navigate between mail fields and perform common tasks like "Click Inbox" and "Click Compose."
Editing text
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete the last text Dragon entered</td>
<td>Scratch That</td>
</tr>
<tr>
<td>Correct selected text or the last text Dragon entered</td>
<td>Correct That</td>
</tr>
<tr>
<td>Spell a word to add it to the vocabulary</td>
<td>Spell That</td>
</tr>
<tr>
<td>Return the cursor back to where you last placed it in documents and e-mail messages</td>
<td>Go Back</td>
</tr>
<tr>
<td>Correct the previous correction</td>
<td>Correct Previous</td>
</tr>
<tr>
<td>Correct the next correction</td>
<td>Correct Next</td>
</tr>
<tr>
<td>Train Dragon about how you pronounce a new word</td>
<td>Train That</td>
</tr>
<tr>
<td>Hyphenate selected words</td>
<td>Compound Selection</td>
</tr>
</tbody>
</table>
| Hyphenate a string of words | Compound `<text>` through `<text>` (North America)  
Compound `<text>` to `<text>` (Outside the U.S. and Canada) |
| Inserts selected text before the last text that Dragon entered | Insert Before That |
| Inserts selected text after the last text that Dragon entered | Insert After That |
| Inserts selected text before some text that you quote from your existing content | Insert Before `[text]` |
| Inserts selected text after some text that you quote from your existing content | Insert After `[text]` |
Selecting text

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select text you specify in your document</td>
<td>Select &lt;text&gt;</td>
</tr>
<tr>
<td>Selects the next text item, such as the next word, line or paragraph, or the next instance when there are multiple text matches</td>
<td>Select Again</td>
</tr>
<tr>
<td>Selects the previous text item, such as the next word, line or paragraph, or the next instance when there are multiple text matches</td>
<td>Select Previous</td>
</tr>
<tr>
<td>Selects the next text item, such as the next word, line or paragraph, or the next instance when there are multiple text matches</td>
<td>Select Next</td>
</tr>
<tr>
<td>Select the last text you dictated</td>
<td>Select That</td>
</tr>
</tbody>
</table>

Capitalizing text

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capitalize the first letter of each word in the last text you dictated</td>
<td>Cap That</td>
</tr>
<tr>
<td>APPLY ALL UPPERCASE</td>
<td>All Caps That</td>
</tr>
<tr>
<td>apply all lowercase</td>
<td>No Caps That</td>
</tr>
<tr>
<td>Capitalize the first letter of each word in selected text</td>
<td>Cap Selection</td>
</tr>
<tr>
<td>Apply all capital letters to text you have selected</td>
<td>All Caps Selection</td>
</tr>
<tr>
<td>Makes all capital letters lower case in selected text</td>
<td>No Caps Selection</td>
</tr>
</tbody>
</table>

Using Dragon's Web capabilities without the Dragon Web Extension

If the Dragon Web Extension isn't available, you cannot click web page elements by voice directly; also, for Firefox and Chrome, none of the text fields have Full Text Control.

Symptoms of lack of Full Text Control include:

- The Dictation Box appears (if the option for this automatic opening is active).
- Dragon does not capitalize the first word.
- Dragon does not insert space before a word as expected.

Without the Dragon Web Extension, you'll need to click page elements manually or with global commands, and you may wish to use the Dictation Box to dictate or edit in text fields.
Global commands that can be helpful for Web navigation include keyboard commands such as “press Alt d,” “press Enter,” “press tab,” “press F5,” and “page down,” as well as commands for clicking and dragging the mouse, such as “MouseGrid 3 3” and “mouse click.” For more information about Dragon’s Web capabilities, see Working with a Web browser.

If you have problems using Web application support

If you’re having problems using Dragon with a supported Web application, this topic can help you identify the cause and find a solution.

Is the Web application supported in your browser?

The Dragon Web Extension is available in the following Web browsers and versions:

- Microsoft Internet Explorer, version 9, 10, and 11, both 32-bit and 64-bit
- Mozilla Firefox version 24 and later
- Google Chrome

If you don’t have one of these browsers in the version listed, you cannot click page elements by voice. In addition, Full Text Control is not available in the browsers and Web applications. You’ll need to click page elements manually (or using MouseGrid and mouse commands) and, if you want Full Text Control, you’ll need to use the Dictation Box.

The makers of Firefox and Chrome frequently release new versions of their browser. For the latest details on Dragon functionality with a particular application, please see the Technical Support page for Dragon on the Nuance website.

Note: Dragon’s functionality differs between Web browsers. For example, in Chrome, you cannot use the “refresh page” command; to perform such actions by voice, you must use mouse commands or press commands such as “press F5”. For more information, see Working with a Web browser.

Feature support

The feature is not supported in the following modes:

- Chrome’s Incognito mode
- Chrome’s Metro mode
- Firefox’s Metro mode

Is the feature active?

To determine whether the feature is active, see How to tell if Web application support is active.

Do you need to re-install?

To use all of Dragon’s functionality in your browser, you must enable Dragon’s web extension. If you did not enable the extension, open the browser you want to install to use the following links while in that browser:

Internet Explorer: https://dnsriacontent.nuance.com/13/addons.html?lang=ENX&browser=ie


Is your browser extension or plug-in enabled?

Your Dragon installation includes extension and/or plug-in and files that Web browsers use to provide you with full text support. If you are having trouble, make sure the Dragon web extension is enabled for the browser you are using. Typically, you can do this from a Tools or Options menu. After enabling the Dragon web extension, restart your browser. For details, see Enabling Web application support.

Be careful when you upgrade!

When you upgrade Firefox, make sure you choose to keep the Dragon web extension active when prompted, or Firefox will automatically disable it. If this happens, you can re-enable it.

If you were running Internet Explorer 8 when you installed Dragon and you upgrade to Internet Explorer 9, you need to install the Dragon web extension. To do so, go to your original Dragon installation file (typically this is located on a DVD) and launch setup.exe. When you see the installation wizard, select the Repair option and click Next.

Could there be an issue with the site?

Changes a site makes to its layout or functionality can cause compatibility problems for Dragon. We make every effort to keep up with these changes, but if you encounter difficulties, please contact Dragon NaturallySpeaking Support.

For more information, see the Dragon NaturallySpeaking Administrator Guide at http://www.nuance.com/support, or the Technical Support Knowledgebase.

Are you using a different language?

To use the Dragon Web Extension, you must set the language of the Web application to the same language as your the user profile. If your profile is set up in English, you must have your Web application set up in English. The Dragon web extension does not require that your Web browser be in the same language as your profile, but it must be if you want to use other Web browser commands.

If you want to work in a different language, you can create another user profile with that language and load it into Dragon when you need it.

Is the Dictation Box behaving in an unexpected way?

Sometimes the Dictation Box misunderstands the context of what you're working on and it displays text you didn't dictate, and that you can't edit. This can happen when the focus of the application you're using is on a field you can't edit and:

- you intentionally open the Dictation Box, or
- you speak into your microphone, prompting the Dictation box to open automatically

For example, if you have your e-mail application open with an item in your message list selected, the Dictation Box may display the header text of that message.

If this happens, just go to the Dictation Box and say or click "Cancel" to close it.

Are you trying to play back dictation?

To play back dictation in Web applications, please use voice commands such as "Play that back," "Read that," and "Read selection." In Web applications, Dragon does not support
playback of dictation using menus and buttons.

**Playback restricted to the current field**

In a Web application like Gmail or Outlook.com, playback is limited to the current dictation for the current field. This means that when you move to another field, you can no longer play back dictation for previous fields, even if you go back to them.

For example, if you dictate an address in a message’s To field and then you go to the Subject field, you can’t play back dictation for the To field. If you return to the To field and dictate another address, you can play back the new dictation but not the original dictation.

**Are you working offline?**

Offline mode is not supported for working with Web-based documents.

**Are you having trouble opening the Correction menu?**

Dragon does not currently support the following methods for opening the Correction menu when working in Web applications:

- Using the hot keys. By default, this is the Minus key (-) on the numeric keypad
- Double-clicking on selected text
- Clicking the Correction button on the Classic DragonBar Extras toolbar
Chapter 15: Working with Web browsers

This section contains the following topics:

- Working with a Web browser .................................................. 194
- Searching the Web by voice ................................................... 195
- Web browser commands ...................................................... 199
- Internet Explorer commands ............................................... 204

Working with a Web browser

Dragon NaturallySpeaking includes many commands designed to enable you to surf the Web by voice in Microsoft Internet Explorer, Mozilla Firefox, and Google Chrome. When you open the browser and a valid user profile is loaded, a prompt appears the first time you open the browser after Dragon installation, providing information on installing the Dragon web extension.

The Dragon Web Extension allows you to use Full Text Control for dictation in browsers and web applications and to click page elements, such as buttons and links, by voice. If you do not install and enable the Dragon Web Extension, you cannot click page elements by voice. In addition, Full Text Control is not available for dictation in the browsers and Web applications. Without the Dragon web extension, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

Important: Please keep in mind that Dragon’s capabilities differ among Web browsers, both in terms of commands and in terms of text control. Note in particular:

- For Chrome, Dragon has no commands such as “go to Address bar”, “go home”, “refresh page”, etc. However, remember that you can take advantage of Dragon’s global command capabilities: mouse-related commands (such as “MouseGrid 3 9”, “mouse click”, and “move mouse upper left”) and key-pressing commands (such as “press Alt d”, “press Enter”, “press control t”, “press tab”, “press F5”, “press Escape”, “page down”).

The following topics cover various Web-related capabilities:

Web browser commands
Internet Explorer commands
About the Dragon Web Extension

In the Dragon Help, see:

Following links and clicking buttons

Specifying Web addresses

Going to text boxes and selecting check boxes and option buttons

Notes

- You cannot select icons on the toolbar, Java™ or ActiveX® applets, or items in the History, Search, or Channels panels by voice. You also cannot select icons in Adobe Flash Player.
- The "Enable commands in HTML windows" box must be selected on the Commands tab of the Options dialog box to use Internet Explorer and Firefox commands.
- You can use the same voice commands that you use with Internet Explorer to navigate in other applications that run within an HTML window. This includes Help windows based on HTML, such as this Help topic.
- On some versions of Windows, you can control Internet Explorer menus and dialog boxes by voice only if the "Voice-enable menus, buttons, and other controls, excluding" box is selected on the Miscellaneous tab of the Options dialog box.
- On some versions of Windows, Microsoft Active Accessibility should be installed before using voice commands with Internet Explorer. If Microsoft Active Accessibility is not installed, you must always start Dragon NaturallySpeaking before you start Internet Explorer. If Internet Explorer is already running, close it, start Dragon NaturallySpeaking, and then restart Internet Explorer.

Searching the Web by voice

Use the Dragon Voice Shortcuts in this topic to perform the following types of Web searches:

- **Search the Web**: Starts a Web search in your default browser. Dragon NaturallySpeaking displays your search string for editing if needed, and then uses your default search provider to search the Internet for your search terms. See Search the Web for details.
- **Search a specific Web site**: Starts a Web search of a specific site in your default browser. Dragon NaturallySpeaking displays your search string for editing if needed, and then uses your default search provider to search a specific Web site for your search terms. See Search a specific Web site for details.
- **Search a category on the Web**: Starts a Web search of a specific category of information in your default browser. Dragon NaturallySpeaking displays your search string for editing if needed, and then uses your default search provider to search a specific category for your search terms. See Search a category on the Web for details.

You can also Search the Web using dates, times, names, or currencies and Directly open a Web site with Google’s "I'm feeling lucky".
Notes

- The option to edit the search string before it is sent to your browser is configurable, so you can turn it off if you prefer. See Display search text before performing search for details in the Dragon Help.
- Depending on your Web browser and the complexity of the search, displaying the results may take a few moments.
- Your Web browser does not have to be open to start a Web search by voice. Dragon NaturallySpeaking recognizes when you use a voice search command and opens your default browser for you. See your browser's documentation for information on setting the default browser.

The following table lists the types of Web searches you can perform, the commands that Dragon NaturallySpeaking supports, examples of how to use the commands, and descriptions of what happens after you say them.
<table>
<thead>
<tr>
<th>Search type</th>
<th>Syntax</th>
<th>Example commands</th>
<th>What happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search the Web</td>
<td>Search [the] Web for [the]</td>
<td>&quot;Search the Web for Italian restaurants in Boston&quot;</td>
<td>Optionally, Dragon NaturallySpeaking displays your search string so that you can edit the keywords if necessary. Your default Web browser opens and displays the results of a search for the phrase &quot;Italian restaurants in Boston&quot; using your default search engine.</td>
</tr>
<tr>
<td></td>
<td>&lt;dictation&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search a specific Web site</td>
<td>Search &lt;Web site&gt; for [the]</td>
<td>&quot;Search eBay for waffle irons&quot; or &quot;Search Yahoo for movies in Boston&quot;</td>
<td>Optionally, Dragon NaturallySpeaking displays your search string so that you can edit the keywords if necessary. Your default Web browser opens and displays the results of searching eBay for the phrase &quot;waffle irons&quot;. Dragon NaturallySpeaking supports Web site searches for the following Web sites: About (for about.com) AltaVista Amazon Answers (for answers.com) AOL Ask Bing Creative Commons eBay Facebook (login required) Google IRS MSN MySpace Twitter Wikipedia Yahoo! YouTube For Dragon NaturallySpeaking: ICD-9 PubMed UpToDate WebMD</td>
</tr>
<tr>
<td></td>
<td>&lt;dictation&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search type</td>
<td>Syntax</td>
<td>Example commands</td>
<td>What happens</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search a category on the Web</td>
<td>Search &lt;category&gt; for &lt;dictation&gt;</td>
<td>&quot;Search video for JFK inaugural address&quot;</td>
<td>Optionally, displays your search string so that you can edit the keywords if necessary. Your default WD Dragon NaturallySpeaking browser opens and displays the results of a search on the words &quot;JFK inaugural address&quot; in your default search engine's video category. Dragon NaturallySpeaking recognizes the following search categories: Search (images</td>
</tr>
<tr>
<td>Search the Web using dates, times, names, or calculations</td>
<td>Search the Web for &lt;date, time, name, or calculations&gt;</td>
<td>Remember to say the words without pausing. Also, you can leave out punctuation and Dragon adds it for you. For example, say: “Search Google for 87 divided by 12” &quot;Search the Web for 11 o'clock am November 11 1945&quot; (Dragon displays the search terms as “11:00 AM November 11 , 1945”) &quot;Search the Web for 57 Euros in US dollars&quot; &quot;Search the Web for Winston Churchill&quot;</td>
<td>Optionally, Dragon NaturallySpeaking displays your search string so that you can edit the keywords if necessary. Dragon NaturallySpeaking searches the Web as requested using your default browser and search engine.</td>
</tr>
</tbody>
</table>
### Search type

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Example commands</th>
<th>What happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directly open the top-ranked Web site for your search term</td>
<td>&quot;Open top Web site (on</td>
<td>about</td>
</tr>
<tr>
<td>&quot;Open top Web site for University of Kansas&quot; You can also substitute &quot;Web page&quot; or &quot;site&quot; for &quot;Web site&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Note

The "Find a Web site (on | about | for ) [the] <specific topic or Web site>" command has been removed from Version 12. You can continue to use "Open top Web site (on | about | for ) [the] <specific topic or Web site>" command.

### Using Google's I'm feeling lucky

**To find Google's top-ranked Web site for a search term using "I'm feeling lucky":**

1. Open the Google home page, for example, www.google.com.
2. Dictate or type your search terms in the search box.

### Enabling or disabling searching the Web by voice

To by voice, open the Options dialog box, Commands Tab and do one of the following:

- Select or deselect the "Enable Web search commands" check box.

The option is enabled by default.

### Changing your default browser or search engine

If you change your default browser or search engine you will have to restart Dragon and the browser to ensure that the search is conducted through the new default search engine.

### Web browser commands

**Important:** Please keep in mind that Dragon’s capabilities differ among Web browsers, both in terms of commands and in terms of text control. See [Working with a Web browser](#).

Text in *italics* represents words or numbers that can change.
Chapter 15: Working with Web browsers

Starting your browser

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Internet Explorer</td>
<td>&quot;Start Internet Explorer&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Start Microsoft Internet Explorer&quot;</td>
</tr>
<tr>
<td>Start Mozilla Firefox</td>
<td>&quot;Start Firefox&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Start Mozilla Firefox&quot;</td>
</tr>
<tr>
<td>Start Google Chrome</td>
<td>&quot;Start Google Chrome&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Start Chrome&quot;</td>
</tr>
</tbody>
</table>

Instead of "start," you can also say "open," "launch" or "show".

Navigating the Web

Please note that not all of these commands work in all browsers. See the Command Browser for more information.
<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the insertion point to the Address Bar</td>
<td>&quot;Go to Address Bar&quot; (Internet Explorer and Firefox only. For Chrome, you can say &quot;press Alt d.&quot;) See also Internet Explorer Commands.</td>
</tr>
<tr>
<td>Go to the URL in the Address Bar</td>
<td>&quot;Click Go&quot; or &quot;Go There&quot; (Firefox and Internet Explorer only. For Chrome, you can say &quot;press Enter.&quot; )</td>
</tr>
<tr>
<td>Refresh the current page from the Web</td>
<td>&quot;Refresh page&quot; or &quot;Reload page&quot; (Firefox and Internet Explorer only. For Chrome, you can say &quot;press F5.&quot; )</td>
</tr>
<tr>
<td>Click a button</td>
<td>&quot;Click&quot; followed by all or part of the button name. If there are multiple matches, Dragon NaturallySpeaking displays a number next to each one. Say the number of the button you want to click. A red arrow points to your choice and then Dragon NaturallySpeaking clicks it.</td>
</tr>
<tr>
<td>Click a link that is a word or phrase</td>
<td>&quot;Click&quot; followed by the link text or part of the text. If there are multiple matches, say the number of the link you want to click, or say the text for the link. A red arrow highlights your choice and then Dragon NaturallySpeaking opens the link to the associated Web page.</td>
</tr>
<tr>
<td>Click on an image that is a link</td>
<td>Say &quot;Click&quot; and the text that appears when the mouse pointer moves over the image, for example, &quot;Click Dragon&quot; if &quot;Dragon&quot; is the text that appears.</td>
</tr>
<tr>
<td>Stop loading a Web page</td>
<td>&quot;Stop Loading&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td>Load the previous page in the history list</td>
<td>&quot;Go Back&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td>Load the next page in the history list</td>
<td>&quot;Go Forward&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td>Load your home page</td>
<td>&quot;Go Home&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td>Open a browser tab in a new browser window</td>
<td>&quot;Open this in a new window&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td>Open a currently displayed Web page in another browser tab that stays in the background</td>
<td>&quot;Open this in a background tab&quot; (Firefox and Internet Explorer only)</td>
</tr>
<tr>
<td></td>
<td>&quot;Open this in a new tab&quot;</td>
</tr>
</tbody>
</table>
### Chapter 15: Working with Web browsers

#### Using tabs

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate the Favorites and RSS icon in IE 9, 10, and 11</td>
<td>&quot;Click Favorites&quot; (Firefox and Internet Explorer only)</td>
</tr>
</tbody>
</table>

#### To | Say
---|---
Open a new tab | "Add a New Tab"
| "Open a New Tab"
| "Create a New Tab" or "press control t"

Close the tab | "Close This Tab" or "press control w"

Go to the next tab | "Go to the Next Tab"
| "Switch to the Next Tab"
| "Move to the Next Tab"

Go to the previous tab | "Go to the Previous Tab"
| "Switch to the Previous Tab"
| "Move to the Previous Tab"

Go to the first tab | "Go to the First Tab"
| "Switch to the First Tab"
| "Move to the First Tab"

*These commands don't work in Firefox. They work in Chrome and Internet Explorer only.

Go to the last tab | "Go to the Last Tab"
| "Switch to the Last Tab"
| "Move to the Last Tab"

*These commands don't work in Firefox. They work in Chrome and Internet Explorer only.

Go to the [nth] tab | "Go to the Third Tab"
| "Switch to the Third Tab"
| "Move to the Third Tab"

*These commands don't work in Firefox. They work in Chrome and Internet Explorer only.

Bookmark all open tabs | "Bookmark All Tabs" (Chrome and Firefox only)

---

**Clicking page elements and entering text**

*The Dragon Web Extension* allows you to click the elements on the page, such as buttons and links, by voice. If you do not install and enable the Dragon web extension, you cannot click page elements by voice; in addition, Full Text Control is not available for dictation in the
browsers and Web applications. Without the extension, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

To use the commands below, you'll need to install the extension for your browser. For more information, see [Installing and enabling the Dragon Web Extension](#).

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Show all places on the page where you can enter text | "Click Type Text"  
or  
"Click Edit Box"  
or  
"Click Text Field"  |
| Show all check boxes on the page                  | "Click Check Box"                        |
| Show all images on the page with links            | "Click Image"                            |
| Show all buttons on the page                       | "Click Button"                           |
| Show all links on the page                         | "Click Link"                             |
| Show all radio buttons on the page                 | "Click Radio Button"                     |
| Show all boxes on the page with lists of choices  | "Click List Box"                         |
| Open a list of choices                             | "Show Choices"                           |
| Close a list of choices                            | "Hide Choices"                           |
| Choose an entry from a list of choices            | "Choose &lt;text&gt;," for example, "Choose Hardware Compatibility Guide." Saying "Choose" is optional. |

**Notes**

You can use most text selection commands when you work with text that you enter in a Web form.

Use the "Choose &lt;n&gt;" command listed under [Navigating the Web](#) to select among multiple choices.
Moving around a Web page

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the page down by a screen</td>
<td>&quot;Page Down&quot;</td>
</tr>
<tr>
<td>Move the page up by a screen</td>
<td>&quot;Page Up&quot;</td>
</tr>
<tr>
<td>Move down to the bottom of the page</td>
<td>&quot;Scroll Down&quot;</td>
</tr>
<tr>
<td>Move up to the top of the page</td>
<td>&quot;Scroll Up&quot;</td>
</tr>
<tr>
<td>Move the page down by a few lines of text</td>
<td>&quot;Line Down&quot;</td>
</tr>
<tr>
<td>Move the page up by a few lines of text</td>
<td>&quot;Line Up&quot;</td>
</tr>
<tr>
<td>Display the top of the current page</td>
<td>&quot;Go To Top&quot;</td>
</tr>
<tr>
<td>Display the bottom of the current page</td>
<td>&quot;Go To Bottom&quot;</td>
</tr>
<tr>
<td>Start automatic downward scrolling</td>
<td>&quot;Start Scrolling Down&quot;</td>
</tr>
<tr>
<td>Start automatic upward scrolling</td>
<td>&quot;Start Scrolling Up&quot;</td>
</tr>
<tr>
<td>Stop automatic scrolling</td>
<td>&quot;Stop Scrolling&quot;</td>
</tr>
<tr>
<td>Increase the rate of automatic scrolling</td>
<td>&quot;Scroll Faster&quot;</td>
</tr>
<tr>
<td>Decrease the rate of automatic scrolling</td>
<td>&quot;Scroll Slower&quot;</td>
</tr>
</tbody>
</table>

**Internet Explorer commands**

The following commands are specific to Internet Explorer. See also the [Dragon Learning Center](https://www.digitallabs.com/dragonlearningcenter) and [Command Browser](https://www.digitallabs.com/dragoncommandbrowser).

New commands for Internet Explorer 9 and 10

Dragon provides voice support for pinning Web sites or specific Web pages to the Windows Start menu. (Then, when you open the site or page from there, it displays as a separate browser icon on the Windows taskbar.)

**To pin a Web site or page to the Start menu**

1. Say "Pin this [web] site | page to Start menu." A dialog box displays, where you can update the address for the Web page to be added.
   **Note:** If you are using Windows 8 machine and IE 10, the command is "Pin this [web] site | page to Start Screen". Using this command adds an icon of the site to the Start Screen.
2. Say or click "Add" to complete the command.
Internet Explorer 9, 10, and 11 support entering Web search terms in the same box that displays the URL of the page you are viewing. The box is called the One Box or Address Bar.

To move the cursor to the One Box

- Say "go to the One Box."

Notes

Home button and Home menu

Internet Explorer 9 has both a Home button, which displays in the top-right corner of the browser window, and a separate Home menu, available from the Command bar as shown here:

If both are displayed, Dragon usually recognizes the Home button when you say the "Home" command.

Tools menus

Internet Explorer 9 has a main Tools menu, which displays when you click the cog icon in the top-right corner of the browser window, and a secondary Tools menu on the Command bar.

If both are displayed, Dragon usually opens the main Tools menu when you say the "Tools" command.

Using Quick tabs

- display quick tabs
- hide quick tabs
- unhide quick tabs
- open quick tabs
- show quick tabs
- turn quick tabs on
- turn quick tabs off
- view quick tabs

Using feeds

- open feeds
- close feeds
- show feeds
- display feeds
- view feeds
- hide feeds
- unhide feeds
- toggle feeds
- switch to feeds
Chapter 16: Working on Your Desktop

This section contains the following topics:

- Starting and exiting programs .................................................. 208
- Using Windows Desktop commands ........................................... 210
- Controlling menus ................................................................. 213
- Selecting buttons and dialog box options .................................... 213
- Selecting tabs in a dialog box .................................................... 214
- Resizing and closing windows .................................................... 214
- Selecting and opening icons ...................................................... 215
- Scrolling in windows and lists .................................................... 215
- Searching your Desktop by voice ............................................... 216
- Switching between programs and windows ............................... 217

Starting and exiting programs

Use the following voice commands to open programs that appear anywhere on your Start menu or your Desktop (even when the Start menu or Desktop are not visible).

Attention

The ability to open a desktop or Start menu item by name at any time is an option. Turning it off can reduce computer memory use and eliminate misrecognitions of dictation as commands. See Enable launching from the Start menu in the Dragon Help.

To start a program

- Say "Start" followed by the program name.

Instead of "start," you can also say "open," "launch" or "show." For example, say "open Notepad."

Shorter names for popular programs

For the popular Windows programs listed here, you can use shorter program names in addition to the standard program label shown on the Start menu or under the program icon on the Desktop. For other programs you'll need to say the standard program label.
- MS Word, Microsoft Word, Microsoft Office Word
- MS Excel, Microsoft Excel
- MS Outlook, Microsoft Outlook
- MS PowerPoint, Microsoft PowerPoint
- MS Access, Microsoft Access
- MS InfoPath, Microsoft InfoPath
- Internet Explorer, Microsoft Internet Explorer
- Firefox, Mozilla Firefox
- Chrome, Google Chrome
- Corel WordPerfect, WordPerfect
- Acrobat Reader
- Lotus Notes

Examples:

- Say "Start Microsoft Word"
- Or
- Say "Start Acrobat Reader"

Notes

- You can also start your standard desktop email client by saying "Start Mail." See Working in e-mail programs for details.

To start any other programs

To start other Windows desktop programs, you need to know the name of the program shortcut or icon. Say "start" and then the text on the program icon label.

Examples:

Microsoft Visual Basic, listed in Windows like this: Microsoft Visual Basic 2008 Express Edition

- Say "Start Microsoft Visual Basic 2008 Express Edition"

OR

Adobe Acrobat Pro, listed in Windows like this: Adobe Acrobat 9 Pro

- Say "Start Adobe Acrobat 9 Pro"

Tip

To simplify start commands or to run programs using names of your choice, you can rename Desktop icons or create new Windows Shortcuts. See your Windows documentation for details.

To exit a program

- With any window that has the active focus on your screen, say "Close Window," or say "Click Close"
Notes

- To access some built-in items on the main section of the Windows Start menu, including Shut Down, Help, Run, and the Favorites, Find, and Settings menus, you must say "Click Start" or "Click Start Menu" and then say the menu names you want until you reach the program. For example, to start the Find Files or Folders tool, say "Click Start" and then "Find Files or Folders."
- In some versions of Windows you must close any open applications before you can use the voice command "Shut Down Windows" to exit Windows.
- On some versions of Windows, you can control Internet Explorer menus and dialog boxes by voice only if the "Voice-enable menus, buttons, and other controls, excluding" box is selected on the Miscellaneous tab of the Options dialog box.
- To use Dragon NaturallySpeaking to operate Windows menus and dialog box controls by voice, the option Voice-enable menus, buttons, and other controls must remain enabled in the Miscellaneous tab of the Options dialog box. The setting ensures that the Windows Active Accessibility feature allows voice control of Windows menus and controls. This option is turned on by default.

Using Windows Desktop commands

You can use voice commands to perform many actions on the Windows Desktop, as shown in the table below.

Notes

- Instead of dictating the verb "open," you can also say "start," "launch" or "show." For example, say "start Notepad."
- For details about how to say program names, see Starting and exiting programs.
- See About the Command Browser for more variants of all commands listed here and see Creating new commands in the Dragon Help for information about how to create your own commands.
- Items in square brackets are optional.
<table>
<thead>
<tr>
<th>To do this</th>
<th>You can say</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Windows special folders</strong></td>
<td></td>
</tr>
<tr>
<td>Open your My Computer window</td>
<td>&quot;Open My Computer&quot;</td>
</tr>
<tr>
<td>Open your My Documents folder</td>
<td>&quot;Open My Documents&quot;</td>
</tr>
<tr>
<td>Open your My Pictures folder</td>
<td>&quot;Open My Pictures&quot;</td>
</tr>
<tr>
<td>Open your My Music folder</td>
<td>&quot;Open My Music&quot;</td>
</tr>
<tr>
<td>Open your My Videos folder</td>
<td>&quot;Open My Videos&quot;</td>
</tr>
<tr>
<td><strong>Start applications and utilities</strong></td>
<td></td>
</tr>
<tr>
<td>Start a program by name</td>
<td>&quot;Open &lt;program name&gt;&quot;</td>
</tr>
</tbody>
</table>

**Note:** This command can be turned off to reduce computer memory use and eliminate misrecognitions of dictation as commands. See Enable launching from the Start menu in the Dragon Help.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Windows Explorer</td>
<td>&quot;Open Windows Explorer&quot;</td>
</tr>
<tr>
<td>Open Windows Help and Support Center</td>
<td>&quot;Open Windows Help&quot;</td>
</tr>
<tr>
<td>Open the Windows Task Manager</td>
<td>&quot;Open Task Manager&quot;</td>
</tr>
<tr>
<td>Open the Windows Run dialog box</td>
<td>&quot;Open Run dialog&quot;</td>
</tr>
<tr>
<td>Open the Windows System Configuration Utility (msconfig)</td>
<td>&quot;Open System Configuration Utility&quot;</td>
</tr>
<tr>
<td>Open the Windows Control Panel</td>
<td>&quot;Open Control Panel&quot;</td>
</tr>
<tr>
<td>Open the Windows Print Manager</td>
<td>&quot;Open Print Manager&quot;</td>
</tr>
<tr>
<td>Add a printer to your Windows system</td>
<td>&quot;Add a new printer&quot;</td>
</tr>
<tr>
<td>Add or remove programs to your Windows system</td>
<td>&quot;Open Add or Remove Programs window&quot;</td>
</tr>
<tr>
<td>To do this</td>
<td>You can say</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Change the Windows Display Settings</td>
<td>&quot;Change Display Settings&quot;</td>
</tr>
<tr>
<td>Change the Windows screen resolution</td>
<td>&quot;Change screen resolution&quot;</td>
</tr>
<tr>
<td>Change Windows Power Settings</td>
<td>&quot;Change power settings&quot;</td>
</tr>
<tr>
<td><strong>Navigate between windows</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Switch between windows                         | ▶"List programs" or "List all windows" or "List windows for Dragon" and then "Choose \(n\)," where \(n\) is the number of the window you want to switch to. For example, say "Choose 2" OR  
▶"Switch to previous window" OR  
▶"Switch to next window."                  |
| Switch to a specific program or document       | ▶"Switch to <program name>" For example, say "Switch to Microsoft Word" OR  
▶"Switch to <document name>" OR  
▶"List windows for <program name>" See Switching between programs and windows |
| **Work with windows**                          |                                                  |
| Enlarge the active window to the size of your monitor's screen | "Maximize window"                              |
| Minimize the active window                     | "Minimize window"                               |
| Close the active window                        | "Close window"                                  |
| Minimize all windows and display the Windows Desktop | ▶"Show Desktop"  
▶"Minimize [all] windows"                      |
| Return a maximized window to its original size | "Restore window"                                |
| Restore all minimized windows                  | "Restore [all] windows"                         |
Controlling menus

You can open, close, and choose items from the menus in most programs by voice. To control the menus in a window, the window must be active.

To open a menu

- Say one of the following:
  "Click" followed by the name of the menu.

Just say the menu name.

Example:

"Click File" or "File"

Dragon's default setting is to require that you say "Click" to select menus and controls. See Require "Click" to select menus Require "Click" to select menus in the Dragon Help.

To choose an item from an open menu

- Just say the item (you can still say "Click" but Dragon doesn't need you to).

Example:

If the File menu is open, say "New"

To close a menu

- Say "Cancel"

Notes

- Say "Click Start Menu" or "Click Start" to open the Start menu. You must say "Click" to open the Start menu. By default, you must say "Click" before the name of menus in commands. To change the setting, see Require "Click" to select menus Require "Click" to select menus in the Dragon Help.

- Saying "Cancel" is equivalent to pressing the ESC key.

- In some versions of Windows, a feature called Active Accessibility allows you to control certain windows menus and controls by voice. If your version of Windows supports Active Accessibility, the "Voice-enable menus, buttons, and other controls, excluding" option on the Miscellaneous tab of the Options dialog box must be on in order to use voice commands to control menus. When you first install Dragon NaturallySpeaking, this option is on by default.

Selecting buttons and dialog box options

You can select buttons and dialog box options by voice.

The dialog box must be the active window.

To select a button, checkbox or option

- Say "Click" followed by the name of the button or other control, as it appears in the window.
Chapter 16: Working on Your Desktop

Saying "Click" before the name of the button required. If you want to make it optional you can specify that "Click" ought not be spoken on the Commands tab of the Options dialog box.

To open a list

If the list is selected (the item displayed is highlighted), say "Expand List" or "Drop List." If the list is not selected say the name of the list. To open the next list, say "Press Tab" and then either "Expand List" or "Drop List."

To click the Close or OK buttons

- Say "Close" or "Click Close," "OK" or "Click OK."

Notes

- You cannot say the following items: file names in dialog boxes, folder names in dialog boxes, names of items within list boxes, and toolbar icons.
- On some versions of Windows, you can control Internet Explorer menus and dialog boxes by voice only if the "Voice-enable menus, buttons, and other controls, excluding" box is selected on the Miscellaneous tab of the Options dialog box.

Selecting tabs in a dialog box

You can select tabs on a tabbed dialog box (such as the Options dialog box in Dragon NaturallySpeaking) in the following manner:

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the next tab</td>
<td>&quot;Move to Next Tab&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Go to Next Tab&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Click Next Tab&quot;</td>
</tr>
<tr>
<td>Select the previous tab</td>
<td>&quot;Move to Previous Tab&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Go to Previous Tab&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Click Previous Tab&quot;</td>
</tr>
</tbody>
</table>

Note

If the tab has a caption with a shortcut key (underlined character) you can say "Click" followed by the name of the tab.

Resizing and closing windows

You can resize and close windows by voice.

To resize a window

1. Make the window you want to resize active.
2. Say "Maximize Window," "Minimize Window," or "Restore Window."
To close a window

1. Make the window you want to close active.
2. Say "Close Window."

Note
These commands only work when you are using an English version of your operating system. If you have a different version of the operating system, you must say "Click" and the command used by that system in place of "Maximize," "Minimize," or "Restore."

Selecting and opening icons
You can select icons on the Desktop in the following manner:

To select a desktop icon

1. Point to the Windows desktop and say "Mouse Click" to make the desktop active.
2. Say the name of an icon. For example, "My Documents."

The icon becomes highlighted to indicate that it is selected.

3. To select another icon, say "Move" followed by a direction (Left, Right, Up, or Down) and the number of icons (up to 20) you want to move. For example, "Move Right 1" or "Move Up 3."

You can open icons on the desktop in the following manner:

To open a desktop icon (including an application)

1. Point to the Windows desktop and say "Mouse Click" to make the desktop active.
2. Say "Open" and the name of an icon. For example, "Open My Documents."

You can close an open window in the following manner:

To close an open window

1. Point to the open window and say "Mouse Click" to make the window active.
2. Say "Close Window."

Scrolling in windows and lists
With Dragon NaturallySpeaking you can scroll within a window or list in a dialog box.

To scroll vertically

- Make sure the insertion point is in the list of a dialog box and say "Move Down" or "Move Up" followed by the number of lines (up to 20) you want to scroll. This presses the Up or Down Arrow key the number of times you specify. You can also say "Page Up" or "Page Down" to press the Page Up or Page Down key.

Examples:

"Move Up 10"
"Move Down 4"
"Page Up"

To scroll horizontally

- If the list or window has a horizontal scroll bar, make sure the insertion point is in the list or dialog box and say "Move Left" or "Move Right" followed by a number up to 20. This presses the Left or Right arrow keys the number of times you specify.

Examples:
"Move Left 10"
"Move Right 5"

Note
You can use these commands to scroll Help windows by voice.

**Searching your Desktop by voice**

Use the Dragon Voice Shortcuts in this topic to search your Desktop by voice.

The search commands require that you have third-party indexing/search software installed. Dragon NaturallySpeaking supports the following search software:

- Google Desktop
- Windows 7 and Windows 8 search

The following table lists the types of Desktop commands that Dragon NaturallySpeaking supports, an example command, and a description of what happens after you say the command:
<table>
<thead>
<tr>
<th>Command Type</th>
<th>Syntax</th>
<th>Example command</th>
<th>What happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search your computer</td>
<td>search [the] computer for [the] &lt;dictation&gt;</td>
<td>&quot;Search the computer for budget spreadsheets&quot;</td>
<td>The search engine displays all indexed items with the keywords &quot;budget spreadsheets&quot;.</td>
</tr>
<tr>
<td>Search e-mail</td>
<td>search e-mail for [the] &lt;dictation&gt;</td>
<td>&quot;Search e-mail for the budget&quot;</td>
<td>The search engine displays all indexed email with the keyword &quot;budget&quot;. <strong>Note:</strong> You can use the terms e-mail, mail, or message interchangeably.</td>
</tr>
<tr>
<td>Find the top-ranked email</td>
<td>find [an] email (about</td>
<td>on</td>
<td>[the] &lt;dictation&gt;</td>
</tr>
<tr>
<td>Search documents</td>
<td>search [the] (documents</td>
<td>files) for [the] &lt;dictation&gt;</td>
<td>&quot;Search documents for budget&quot;</td>
</tr>
<tr>
<td>Search your Web history, favorites, or bookmarks</td>
<td>search [the] &lt;category&gt; for [the] &lt;dictation&gt;</td>
<td>&quot;Search the Web history for the budget forecast&quot;</td>
<td>The search engine displays search results containing all pages from your Web history that use the keyword &quot;budget&quot;. Valid search categories are: - favorites - bookmarks - Web history</td>
</tr>
</tbody>
</table>

**Enabling or disabling searching the Desktop by voice**

To enable or disable searching the Desktop by voice, open the Commands tab of the Options dialog box and do one of the following:

▶ Select or deselect the "Enable Desktop search commands" check box.

The option is enabled by default.

**Switching between programs and windows**

Use this procedure to do any of the following:

- List and switch between open programs or windows.
- List and switch between windows of multi-document applications.
- List and switch between open Dragon windows.
Note

You can use this command to switch to your Web browser, but this command does not list open tabs in your web browser. For information on browser tabs, see Working with a Web Browser.

To switch between open programs or windows

1. Do any of the following:

   ▶ To list all open programs, say "List Programs" or "List all windows." The List of Open Applications window opens. For example,

   ![List of Open Applications](image)

   Or

   ▶ To list open windows of multi-document applications, say "List windows for <program name>" For example, say "List windows for Microsoft Word" The List of Windows opens. For example,
To list all open Dragon windows, say "List windows for Dragon" or "List Dragon windows". The list of Dragon windows opens. For example,

For information about dictating program names, see Starting and exiting programs.
2. To switch to an open program or window:

- Say "Choose n," where n is the number of the program or window you want to switch to, or just say the number next to the word. For example, say "Choose 2" or "2"

OR

- Choose the number of the program or window from the list and click OK.
Chapter 17: Controlling the Mouse and Keyboard

This section contains the following topics:

- Controlling the keyboard ................................................................. 222
- Moving the mouse pointer ............................................................... 224
- Move commands ........................................................................... 224
- Optional move commands ............................................................... 224
- Stopping mouse movement ............................................................. 225
- Positioning the mouse pointer with MouseGrid ............................ 225
- Clicking and dragging the mouse .................................................... 226
- Clicking the mouse ........................................................................ 227
- Dragging the mouse ...................................................................... 227
- Stopping mouse movement ............................................................. 228

Controlling the keyboard

When Dragon NaturallySpeaking is running, you can control the keyboard by voice.
<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Press&quot;</td>
<td>&quot;Tab&quot;</td>
</tr>
<tr>
<td>&quot;Press Key&quot;</td>
<td>&quot;Backspace&quot;</td>
</tr>
<tr>
<td>&quot;Type&quot;</td>
<td>&quot;Caps Lock&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Enter&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Escape&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Space Bar&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Print Screen&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Scroll Lock&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Pause&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Num Lock&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Up Arrow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Down Arrow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Right Arrow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left Arrow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Home&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;End&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Page Up&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Page Down&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Insert&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Delete&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Function 1&quot; to &quot;Function 12&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Keypad&quot; followed by any numeric keypad key: 0...9, ., /, *, -, +, Enter).</td>
</tr>
<tr>
<td></td>
<td>&quot;Shift,&quot; &quot;Control,&quot; or &quot;Alt&quot; (alone or in combination) followed by any other key.</td>
</tr>
</tbody>
</table>
Chapter 17: Controlling the Mouse and Keyboard

Notes

- You can say "Press" or "Type" followed by any combination of modifier keys (Shift, Control, Alt), and then any letter, number, symbol, arrow key, and so on.
- You can say "Press Tab" to move around a dialog box or a list and "Press Enter" to select items.
- You cannot undo a keystroke by saying "Scratch That." For example, if you say "Press Cap A" then "Scratch That," "A" remains in the document. You can, however, say "Undo That."

Moving the mouse pointer

You can move the mouse pointer up, down, left, or right using the mouse pointer commands.

Move commands

The following commands are always available and can move the pointer a short distance (up to 10 units):

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Mouse&quot;</td>
<td>&quot;Up&quot;</td>
<td>&quot;&lt;1—10&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Down&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Left&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Right&quot;</td>
<td></td>
</tr>
</tbody>
</table>

Examples:

"Mouse Down Two"

"Mouse Right Eight"

Optional move commands

You can use the following movement commands if the "Enable mouse motion commands" box on the Commands tab of the Options dialog box is selected.
<table>
<thead>
<tr>
<th>Say</th>
<th>Then a direction</th>
<th>Then a speed (optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move Mouse&quot; or</td>
<td>&quot;Up&quot;</td>
<td>&quot;Faster&quot;</td>
</tr>
<tr>
<td>&quot;Mouse Move&quot;</td>
<td>&quot;Down&quot;</td>
<td>&quot;Very Fast&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left&quot;</td>
<td>&quot;Much Faster&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Right&quot;</td>
<td>&quot;Slower&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Upper Left&quot;</td>
<td>&quot;Very Slow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Lower Left&quot;</td>
<td>&quot;Much Slower&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Upper Right&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Lower Right&quot;</td>
<td></td>
</tr>
</tbody>
</table>

You can say a speed command at any time while the pointer is moving to speed the movement up or slow it down.

Examples:

"Move Mouse Down Faster"

"Mouse Move Lower Right Very Fast"

"Mouse Move Up Very Fast (pause) Slower (pause) Stop"

**Stopping mouse movement**

While the mouse pointer is moving, you can stop the movement by saying one of the following commands:

- "Stop"
- "Cancel"

**Notes**

- You can combine moving the mouse pointer with clicking the mouse or marking and dragging the object in a single voice command.
- You can disable the mouse motion commands by clearing the check box "Enable mouse motion commands" on the **Commands tab of the Options dialog box**.
- The default mouse motion speed is 2 (on a scale from 1 to 25). You can change the default speed by clicking the Speed button on the **Commands tab of the Options dialog box** and selecting a new speed.

**Positioning the mouse pointer with MouseGrid**

You can position the mouse pointer anywhere on the screen using MouseGrid. The movement can be relative to the full screen or the active window.
To position the pointer with MouseGrid

1. Say "MouseGrid" to place the MouseGrid over the full screen or say "MouseGrid Window" to place it over the active window.

   MouseGrid divides the screen or window into nine numbered areas.

2. Say the number (from 1 to 9) to position the pointer in that numbered area. To position it again, say another number.

   You can pause slightly after each number you say.

Examples:

"MouseGrid 3 2 5"
"MouseGrid Window 7 8"

Notes

- To have MouseGrid close automatically, end the MouseGrid command with "Go." For example, say "MouseGrid 5 3 Go."
- To undo the last MouseGrid action, say "Undo That."
- To close MouseGrid, say "Cancel."
- MouseGrid will close when the microphone is turned off, or when you say the command "Go To Sleep."
- You can combine the MouseGrid command with clicking the mouse or marking and dragging the object in a single voice command. For example, you can say "MouseGrid 5 3 Double-Click."

Clicking and dragging the mouse

You can click and drag the mouse by voice.
**Clicking the mouse**

<table>
<thead>
<tr>
<th>Say</th>
<th>Then say</th>
<th>Then say</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Mouse&quot;</td>
<td>&quot;Click&quot;</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>&quot;Double-Click&quot;</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>&quot;Right-Click&quot;</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>&quot;Left-Click&quot;</td>
<td>–</td>
</tr>
<tr>
<td>&quot;Press&quot; or &quot;Type&quot;</td>
<td>&quot;Shift&quot;</td>
<td>&quot;Right Click&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Left Click&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Control&quot;</td>
<td>&quot;Right Click&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Left Click&quot;</td>
</tr>
</tbody>
</table>

**Examples:**

- "Mouse Double-Click"
- "Mouse Right-Click"
- "Press Shift Right Click"
- "Type Control Left Click"

**Dragging the mouse**

You can use the following movement commands if you select the Enable mouse motion commands check box on the Commands tab of the Options dialog box.
Chapter 17: Controlling the Mouse and Keyboard

You can say a speed command at any time while the pointer is moving to speed the movement up or slow it down.

Examples:
"Drag Mouse Down Faster"
"Mouse Drag Lower Right Very Fast"
"Mouse Drag Up Very Fast (pause) Slower (pause) Stop"
"Shift Drag Mouse Up"

**Stopping mouse movement**

While the mouse pointer is moving, you can stop the movement by saying one of the following commands:
- "Stop"
- "Cancel"

Notes
- You can combine dragging the mouse pointer and clicking the mouse. For example, to open an application from the Desktop, you can say "Mouse Drag Lower Left" and when the Desktop icon is selected, say "Double-Click."
- You can disable the mouse motion commands by clearing the check box "Enable mouse motion commands" on the Commands tab of the Options dialog box.

<table>
<thead>
<tr>
<th>Say</th>
<th>Then a direction</th>
<th>Then a speed (optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Drag Mouse&quot; (to move)</td>
<td>&quot;Up&quot;</td>
<td>&quot;Faster&quot;</td>
</tr>
<tr>
<td>&quot;Mouse Drag&quot; (to move)</td>
<td>&quot;Down&quot;</td>
<td>&quot;Very Fast&quot;</td>
</tr>
<tr>
<td>&quot;Control Mouse Drag&quot; (to copy) or &quot;Control Drag Mouse&quot;</td>
<td>&quot;Right&quot;</td>
<td>&quot;Much Faster&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Left&quot;</td>
<td>&quot;Slower&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Upper Right&quot;</td>
<td>&quot;Very Slow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Upper Left&quot;</td>
<td>&quot;Much Slower&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Lower Right&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Lower Left&quot;</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 18: Improving recognition accuracy

This section contains the following topics:

The Dragon Accuracy Center ................................................................. 240
Recognition Modes .............................................................................. 243
Teaching Dragon to Understand You Better ......................................... 247
Personalizing your Dragon Vocabulary .................................................. 250
Managing Vocabularies ......................................................................... 258

Top 10 ways to improve accuracy

Here’s our top 10 list of ways to optimize Dragon’s ability to recognize your speech.

1. **Use careful dictation practices** Dictating with Dragon is different than talking to someone. When we talk, we often hesitate, mumble, slur words, or leave words out altogether, but we’re still able to understand each other. And people can easily filter out noise, which lets us understand each other, even in noisy environments, like restaurants, but speech software needs help separating dictation from other sounds. With dictation, the idea is to speak in a consistent speed and volume - try not to hesitate, exaggerate your pronunciation, or talk loudly or slowly. So make sure background noise doesn’t drown you out and that you have the microphone close enough for Dragon to hear you properly, usually about an inch from your mouth and to one side. Also, remember to dictate using complete phrases, so that Dragon gets the context. For example, we use our experience and common sense to decide whether someone said "I Scream," or "Ice Cream." But Dragon doesn’t understand what words mean, so it can’t use common sense the way we do. Instead, Dragon interprets your speech by using its knowledge of words that tend to appear together. Dragon calculates how frequently you use words and phrases and can offer you suggestions when it makes mistakes. Try to think about your whole phrase or sentence before you start dictate it, and you’ll be on your way to dictation mastery. For more information, see **Dictation Basics**.

2. **Import lists of words or phrases** Rather than adding words or phrases one at a time, you can import one or more lists. The lists can even include spoken forms. This method can be particularly useful for businesses that have a lot of people dictating similar names or words or if you need to use more than one user profile. For more information, see **Preparing a list of custom words to add to a Vocabulary**.
3. **Learn from specific documents** You can select specific documents or entire folders containing typical documents, your own or those of others, that reflect the type of dictation you will typically do. You can then train Dragon how you pronounce unusual words or about proper names you need to dictate. For example, if you were an academic and ran the tool to add words from essays and articles in your field of study, or a blogger using a lot of new acronyms, Dragon would automatically learn your words, word frequency and contexts, and make better guesses about your speech. Dragon also moves words from its backup dictionary to its active vocabulary based on the scan. If there are a lot of words to train, you'll need to plan this activity when you have a few minutes to spend adding the words.

4. **Learn from sent e-mails** Similar to Learn from specific documents, this tool helps refine your profile by analyzing representative text, only in this case it analyzes e-mail messages sent from your installed email program. In addition to analyzing frequency of word use and typical word sequences, it can suggest contact names you may want to add to the vocabulary. **Note:** For the first run, plan this activity when you can let Dragon use your computer for 5 to 30 minutes. Subsequent scans build on the first one, however, and are much faster.

5. **Run Accuracy Tuning** This process refines your user profile by analyzing audio and text data that Dragon archives from your dictation. You can launch Accuracy Tuning from the New DragonBar or Classic DragonBar Audio menu or schedule it to run later. Choose a time when your computer is on but you can close Dragon – for example, when you typically have a meal or a meeting.

6. **Perform additional training** Dragon learns about how you pronounce words and your vocal tones when you create your user profile, but it can learn more if you read one or more of the supplied training texts. We recommend you read a training text after a few hours of using Dragon. On the DragonBar, select Audio > Read Text to Improve Accuracy.

7. **Turn off what you don’t use** Visit the Performance Assistant for useful strategies for optimizing accuracy and speed with Dragon. For example, you can turn off the ability to "voice-click" menus, buttons and other controls in some or all programs, or the ability to open items from the Windows Start menu or desktop. Turning off these options reduces Dragon’s use of computer resources and reduces the possibility of isolated words or phrases being executed as commands, such as "Click Send" or "Open Network."

8. **Use Smart Format Rules** to have Dragon recognize when you change a custom or built-in auto-formatting option or word property for alphanumeric text or a word. Dragon automatically applies formatting to many common spoken forms of text, such as Web and e-mail addresses, street addresses, dates, numbers, units of measure, and so on. The Smart Format Rules feature recognizes your changes to rules and offers to customize the settings to suit your needs as you work. You can also add custom word properties to words to make Dragon’s text entry more intuitive and efficient. By setting word properties, you specify a variety of options that can be associated with vocabulary entries. You can specify that a word be preceded or followed by specific characters and customize properties for placement or handling. For example, question marks and exclamation marks have default properties of "Precede by (nothing)" and "Format the next word capitalized."

Or, you can specify one or more for words. If the Alternate printed form checkbox is selected for "meter," when you dictate the word after a number Dragon enters only "m." For example, if the Alternate form checkbox is not selected, and you dictate "meter," Dragon types the full word, "meter."
9. **Make corrections** You can prevent many errors using the methods listed above, but if an error does happen, correcting it will help Dragon to learn. Redictating or retyping words or phrases are sometimes the fastest approach, but Dragon provides a lot of flexibility about how and when you correct errors.

10. **Save your user profile** Remember that as Dragon works on your documents with you, it needs to save what it learns. After you correct dictation, train words, or perform any of the other accuracy optimization operations, save your profile to save your changes for your next session.

Using Smart Format Rules

The Smart Format Rules box may appear when Dragon notices that you corrected dictated text corresponding to an Auto-Formatting option or **Word Property**.

Through this optional feature, Dragon offers you one or more adjustments to its settings. When Dragon presents a Smart Format Rules box, you can choose one of the adjustments it offers, or you can just ignore the box and continue working (you can also say “cancel” and the box will close).

Here is an example of the Smart Format Rules box that appears if you change in your text the standard abbreviation for kilograms, which is kg:

```
Smart Format Rules

Say "Choose" followed by a number, or just ignore this box.

"choose 1" Never abbreviate units of measure
"choose 2" Always use the alternate written form 'kilograms'
```

What to do when a Smart Format Rules box appears

When Dragon displays a Smart Format Rules box, you can usually do any of the following:

- If you don’t want Dragon to auto-format the text using this rule now and in future dictation, click the first line or say **choose 1**.
- If you want Dragon to use the same auto-formatting setting in the future, click the second line or say **choose 2**.
- If you don’t want to adjust any setting, ignore this box. It will go away when you continue dictating or working in your document. (You can also say “Cancel” to dismiss the box.)

The choices are slightly different in the case of Smart Format Rules about entering zeros rather than the word "million," for numbers greater than or equal to 10, and for **word properties**. For details and examples, see Options controlled by Smart Format Rules below.

What causes the Smart Format Rules box to appear

The Smart Format Rules box appears after you edit dictated text, whether you make the correction using

- the Correction menu
- the Spelling window
or

- the keyboard.

**Showing the last Smart Format Rule**

If a Smart Format Rules box appears and you continue dictating or cancel it accidentally, you can redisplay it by saying the command "Show Smart Format Rule." Previously accepted rules cannot be displayed.

**Disabling Smart Format Rules**

If you want to turn off the Smart Format Rules feature, you can do so from the Correction tab of the Options dialog box.

1. Open the DragonBar’s Tools menu and click Options. You can also say "Switch to DragonBar," then "Click Tools," then "Options."
2. Click the Correction tab then clear the check box next to Show Smart Format Rules" (or say "click Show Smart Format Rules").
3. Click OK or say "Click OK" to close the dialog box.

**Restoring a Smart Format Rule**

You can restore a default in the Auto-formatting dialog box or Word Properties dialog box.

Another way to restore a setting: correct the text to the format you want and pick the corresponding rule from the Smart Format Rules box that your correction triggered.

**Options controlled by Smart Format Rules**

- **Auto-formatting Web and e-mail addresses**
  
  Turns on automatic e-mail and Web address formatting, so that you can dictate them as you would normally say them out loud. For example, if you say "jane dot smith at my adventure travel dot com" Dragon enters "Jane.Smith@myadventuretravel.com." Dragon substitutes the @ sign for the spoken "at," uses a period for "dot," and omits spaces. Or if you say "www dot nuance dot com," Dragon enters www.nuance.com.

- **Auto-formatting street addresses**
  
  Turns on automatic formatting of postal addresses. For example, if you say "49 orchard lane boston massachusetts oh two four four six," Dragon NaturallySpeaking enters "49 Orchard Lane, Boston, MA 02446."

  Certain addresses can be hard for Dragon NaturallySpeaking to interpret. For example, "Two Hundred Forty Fifth Street" could be interpreted as 245th Street, 200 45th Street, or 240 5th Street. In a situation like this, Dragon NaturallySpeaking uses context to try to determine what you meant. In some cases, using the word "And" can help to narrow down the choices. In the example above, saying "Two Hundred And Forty Fifth Street" would eliminate 200 45th Street as a possibility.

  **For user profiles whose region setting is UK or Canada:** This option also enables the proper formatting of UK postcodes and Canadian postal codes. For example, you could format a postcode for London by saying "W Two Four R J" to enter W2 4RJ, and format a postal code for Toronto by saying "M Five H Two L Two" to enter M5H 2L2.

  See Choose your region and vocabulary in the Dragon Help.
For user profiles whose region setting is United States: If you are using a U.S. English user profile, you can enable UK postcodes and Canadian postal codes from the UK and Canadian postcodes option in this dialog box.

See Choose your region and vocabulary in the Dragon Help.

Auto-formatting titles

Inserts abbreviated versions of any title in Dragon's Abbreviated titles list. For example, "Mr." for "Mister," or "Pres." for "President."

Auto-formatting dates

Controls how Dragon NaturallySpeaking formats dates when you dictate the day, month, and year together.

Use the drop-down button to select the format you want to use most often. Available formats are:

- Dates As Spoken
- Month D, YYYY
- Month DD, YYYY
- Mon D, YYYY
- Mon DD, YYYY
- M/D/YYYY
- M/D/YY
- MM/DD/YYYY
- MM/DD/YY
- MM-DD-YY
- D Month, YYYY
- D/M/YYYY
- D/M/YY
- DD/MM/YYYY
- DD/MM/YY
- DD-Mon-YY
- YYYY-MM-DD

Notes

If you clear the "Dates" checkbox, Dragon will not apply automatic date formatting. For example, after clearing the checkbox, if you dictate "July twenty seventh," Dragon will write "July 27th."

By default, Dragon does not use the numeral form of numbers smaller than 10, whether for cardinal numbers (one, two, three...) or ordinal numbers (first, second, third...). If the "Dates" checkbox is cleared, Dragon writes "the 10th of June" and "the seventh of June" unless you change the default setting "Numbers, if greater or
*equal to* on the Auto-Formatting Options dialog box.

- If you use the "Dates As Spoken" setting, Dragon NaturallySpeaking needs you to dictate dates in an unambiguous way, using the name and not the digit for the month. For example, with "Dates As Spoken" selected, Dragon will correctly format "January eleven two thousand nine" and "the seventh of February two thousand four" using date formats, but will format "eleven one two thousand nine" as a number.

If you dictate dates differently, for example you use digits to say the month, try selecting the value that best matches how you dictate the date. For example, if you normally say "eleven one two thousand nine", setting the date format to "D/M/YYYY" will cause Dragon to correctly transcribe the date.

- If you omit the year, for example, you say "July twelve", Dragon NaturallySpeaking transcribes "July 12" ("The twelfth of July" becomes "12 July") regardless of which date formatting you select.

Auto-formatting common abbreviations

Enables Dragon NaturallySpeaking to recognize most standard abbreviations while transcribing your dictation. For example, Dragon would rewrite "versus" as "vs.", "Institute" as "Inst.", and "Department" as "Dept." For more information about dictating abbreviations, see Dictating abbreviations and acronyms.

Auto-formatting contractions

Enable this option if you want Dragon to expand contractions when you dictate them. For example, if you say "Don't go near the water", Dragon NaturallySpeaking transcribes "Do not go near the water".

If you leave this option turned off, Dragon NaturallySpeaking enters contractions the way you dictate them.

**Note:** In some situations, the formal expression of a contraction may be ambiguous. For example, the phrase "It's always" could either mean "It is always" or "It has always," depending on the tense of the verb that follows. In this situation, Dragon NaturallySpeaking always expands the contraction, regardless of how this option is set.

Auto-formatting " million" instead of ",000,000"

Enable this option to have Dragon enter the word "million" rather than zeros and commas (",000,000") when you dictate round numbers in the millions. For example, Dragon enters "8 million" rather than "8,000,000."

If a number in the millions range is not rounded to the nearest million, Dragon enters the number as digits. For example, if you dictate "eight million one hundred thousand" Dragon enters "8,100,000".

Auto-formatting numbers, if greater than or equal to

Enters numbers as numerals if they are equal to or greater than the value shown in the
drop-down list. If the number is less than the chosen value, the number is spelled out. For example, using the value of "10", Dragon will write "five" when you dictate "five" and "11" when you dictate "eleven".

The available values are:

- 0
- 2
- 10
- 100

**Note:** You can also use Dragon to enter numbers as Arabic or Roman numerals. See [Dictation commands](#).

### Auto-formatting units of measure

Turns on automatic formatting of standard units of measure, such as feet and inches. For example, if you say "Six Foot Three Inches", Dragon NaturallySpeaking enters 6' 3".

If a unit of measure is not formatted in the way you expect, you can also use the Word Properties dialog box to use an alternate form for that particular unit of measure.

### Auto-formatting ISO currency codes

If you have selected the Prices option, then you can select "ISO currency codes" to display currency amounts with the International Standards Organization currency symbol corresponding to the region and language set for your Windows operating system or, if different, for your user profile (see How region and language affect number and currency punctuation).

For example, if your profile's region is set to United States and you enable both the Prices and ISO currency codes Auto-Formatting options, when you dictate "Ten Dollars" Dragon NaturallySpeaking enters "USD10".

### Auto-formatting phone numbers

Turns on automatic formatting of telephone numbers.

**For U.S. English User Profiles using the United States or Canada for the Region:** Turns on automatic formatting North American telephone numbers when you speak a sequence of seven or ten numbers. For example, if you say "7815551234", Dragon NaturallySpeaking will transcribe "781-555-1234".

**Notes**

- Vanity phone numbers such as 1-800-EXAMPLE are not supported.
- The automatic formatting of U.S. telephone numbers is not supported for user profiles with a UK Region setting.

**For User Profiles using the UK for the Region:** Turns on automatic formatting of UK telephone numbers.
Notes

- Country code +44 can be dictated as "four four", "forty four" or "double four" with a preceding plus sign. For example, if you say "plus-sign four four two nine two oh seven four seven seven four seven", Dragon transcribes "+44 29 2074 7747".
- Area codes that are dictated without the preceding country code must be dictated with a leading zero. For example, if you say "zero two nine two oh eight seven nine three two seven", Dragon transcribes "029 2087 9327".
- When you dictate a 6-digit number, Dragon transcribes the number with no spaces. When you dictate a 7-digit or 8-digit number, Dragon transcribes the number with a space before the last 4 digits.
- The automatic formatting of UK telephone numbers is not supported for U.S. and Canadian-based user profiles.

Auto-formatting prices

Inserts prices and currencies in the proper format with the appropriate currency symbol. For example, "$10" instead of "10 dollars", or "€50" instead of "50 euros".

Supported currencies are:

<table>
<thead>
<tr>
<th>ISO code</th>
<th>Symbol</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>USD</td>
<td>$</td>
<td>Dollars</td>
</tr>
<tr>
<td>USD</td>
<td>US$</td>
<td>U.S. dollars</td>
</tr>
<tr>
<td>CAD</td>
<td>C$</td>
<td>Canadian dollars</td>
</tr>
<tr>
<td>EUR</td>
<td>€</td>
<td>Euros</td>
</tr>
<tr>
<td>JPY</td>
<td>¥</td>
<td>Yen</td>
</tr>
<tr>
<td>GBP</td>
<td>£</td>
<td>Pounds Sterling Pence/Penny</td>
</tr>
<tr>
<td>CHF</td>
<td>F</td>
<td>Swiss francs</td>
</tr>
</tbody>
</table>

Auto-formatting times

Turns on automatic formatting of standard time formats. For example, if you say "Six Thirty PM", Dragon will transcribe "6:30 PM". Dictating standard time runs on a 12 hour clock, letting you make the distinction between AM and PM.

Military time: With the Time option enabled, you can also dictate times in military format. For example, if you say "sixteen hundred hours", Dragon transcribes "1600 hrs". If you say "oh three oh five hours" or "zero three zero five hours", Dragon transcribes "0305 hrs".

Dictating Military time uses a 24-hour clock and abbreviates "hours" to "hrs".
Auto-formatting UK and Canadian postcodes

Turns on proper formatting of UK postcodes and Canadian postal codes. For example, with the option on, format a London postcode by saying "W Two Four R J" to enter W2 4RJ, and format a Toronto postal code by saying "M Five H Two L Two" to enter M5H 2L2.

Auto-formatting other numbers

Enables the formatting of all numbers not covered by other options on this dialog box, such as negative numbers, numbers with punctuation, fractions, decimals, and Roman numerals.

Note: Dragon applies Auto-formatting for mixed numbers and also for fractions where the denominator is 5 or greater, but not for simple fractions like "one half," "two thirds," and "three quarters."

For more information, see Dictating numbers.

Auto-formatting US social security numbers

Turns on automatic formatting of U.S. Social Security Numbers when you speak a sequence of 9 numbers. For example, if you say "123456789," Dragon NaturallySpeaking enters "123-45-6789."

Auto-formatting using Word Properties

Use Word Properties to customize how Dragon enters words or phrases as you dictate them. Word Properties can add custom spacing before and after, next word capitalization, settings for numbers before and after, or apply alternate written forms, such as abbreviations.

To add or edit Word Properties, see Creating Word Properties.

Note

- If you make a correction that corresponds to an auto-formatting option and a word property, Dragon displays only the smart format rule prompt for the word property.

Adjusting Speed vs. Accuracy

You can increase product speed or, alternatively, increase recognition accuracy by using the Speed vs. Accuracy slider.

The Speed vs. Accuracy slider lets you control the number of words and phrases that the program examines in order to find a word match. The more words examined, the greater the possibility of an accurate match at the expense of using more memory and taking a longer time to recognize your speech.

Moving the slider can influence the performance of Dragon NaturallySpeaking. Dragging the slider toward accuracy sometimes increases the accuracy of the matches at the expense of additional time in transcribing your dictation. Moving the slider to the right normally increases
recognition accuracy but may also slow system performance. As a general rule, you should move the slider farther to the right on faster machines than on slower ones.

To use the Speed vs. Accuracy slider

1. On the Tools menu of the New DragonBar or Classic DragonBar, click Options.
2. In the Options dialog box, click the Miscellaneous tab.
3. Drag the Speed vs. Accuracy slider to tune performance.
4. Test the new setting by using Dragon NaturallySpeaking. If you are not satisfied with the result, try a different setting.

Notes

■ Running other programs while Dragon NaturallySpeaking is running will also affect accuracy and speed, since other programs compete for system resources.
■ If you get a "The recognizer has encountered an utterance that is too long to process" error, try setting the slider more towards "Fastest Response".
The Dragon Accuracy Center

This section contains the following topics:

Using the Accuracy Center ................................................................. 240
Running the Acoustic and Language Model Optimizer .......................... 240

Using the Accuracy Center

You can use the Accuracy Center to refine the accuracy of your User Profile or to learn more about Dragon. For example, you'll find tools or information in the Accuracy Center for the following kinds of tasks:

- Personalize your Vocabulary
- Adjust your acoustics
- Find or train commands
- Set options and configure formatting
- Find out more about Dragon

To open the Accuracy Center

- say "Open Accuracy Center" or click Help > Improve My Accuracy on the New DragonBar or Classic DragonBar.

To use the Accuracy Center

- Click or say the first few words of a link to start it.

Accuracy Center options

To learn about the specific features of the Accuracy Center, click The Accuracy Center options in the Dragon Help.

Notes

- When you start the Accuracy Center option that checks your audio settings, the Check Microphone wizard starts and the Dragon NaturallySpeaking microphone is automatically turned off if it is on. This is necessary in order to facilitate the audio tests.

Running the Acoustic and Language Model Optimizer

Use this procedure to increase Dragon's accuracy with the Acoustic and Language Model Optimizer.

As you make and train corrections, train new words or phrases, use commands, or read a text for acoustic training, Dragon NaturallySpeaking stores the acoustic and language data in an archive and uses it to enhance recognition accuracy. The Acoustic and Language Model Optimizer accumulates this data from session to session.
Acoustic Optimization
Perform Acoustic Optimization to update your Profile with accumulated acoustic data from any corrections and training you do.

Language Model Optimization
Perform Language Model Optimization to update your language model. The language model contains statistical information that predicts which words are most likely to occur in the context of your dictations. Language Model Optimization uses text extracted from your .DRA files to add commonly used word sequences to the language model. (Note: Based on the speech data collected, Language Model Optimization may change the language model selected when you created your Profile.)

Before you begin
- Because it can take up to an hour to incorporate the analyzed data into your Profile, you may want to schedule the optimization when you are not using your computer. You can schedule optimization using the Acoustic and Language Model Optimizer Scheduler. If you are part of an organization or company and you do not have Dragon administrator rights, you can request that your Dragon administrator schedule optimization.
- Be sure that the "Store corrections in archive" option is selected on the Data tab of the Options dialog box. Otherwise you may see a message that there is not enough data for the Acoustic and Language Model Optimizer to process. The "Store corrections in archive" option should be selected whenever you use Dragon NaturallySpeaking for an extended period of time.
- If you have a Profile set to the Correction Only Mode (for example, to work as a transcriptionist), you must disable the Correction Only Mode option on the Miscellaneous Tab of the Administrative Settings dialog box before running the Acoustic and Language Model Optimize on this Profile.

To run the Acoustic and Language Model Optimizer
1. Click Launch Accuracy Tuning on the DragonBar's Audio menu or say "Switch to DragonBar," then "Audio," then "Launch Accuracy Tuning".

   The Acoustic and Language Model Optimizer dialog box opens with Perform Acoustic Optimization and Perform Language Model Optimization selected. Nuance recommends that you run both optimizations to maximize accuracy.
2. Click "Go" to start the Acoustic and Language Model Optimizer.
3. The Acoustic and Language Model Optimizer may ask if you want to save your current Profile. Choose "Yes" if you made corrections since the last time you ran the Acoustic and Language Model Optimizer, or if you have not run the Acoustic and Language Model Optimizer since you started using Dragon NaturallySpeaking.

The Acoustic and Language Model Optimizer dialog box shows Dragon's estimate of how long it will take to finish adapting your Profile. How long this takes depends on the amount of Acoustic Data stored in your Profile.
Notes

- By default, the amount of acoustic data saved is limited to 180 minutes (the maximum). You can reduce this amount on the Data tab of the Options dialog box.

- If you attempt to run the Acoustic and Language Model Optimizer before you have trained any corrections (even if you have corrected errors without training the corrections), or before you have performed any additional training, you will see an error message saying that there is not enough data for the Acoustic and Language Model Optimizer to process.

- Training multiple words or phrases rather than training individual words is generally more effective at increasing accuracy. Most people have a tendency to over-enunciate when saying individual words as opposed to a complete phrase.

- The Acoustic and Language Model Optimizer automatically makes a backup of the old Profile before it begins modifying them. Your Profile is automatically restored if you click Cancel before the Acoustic and Language Model Optimizer is finished.
Recognition Modes

This section contains the following topics:

Using Recognition Modes ................................................................. 243
Switching recognition modes ............................................................ 245

Using Recognition Modes

By default, Dragon interprets what it hears as either dictation (something to write on the screen) or a command (something to execute). This is called Dictation & Commands mode on the New DragonBar, or Normal Mode on the Classic DragonBar. Dragon NaturallySpeaking allows you to use restricted Recognition Modes, which increases accuracy in transcription and is more efficient. The following describes ways you can use these modes while you dictate. Click the links to display the related procedures.

Normal Mode [ ] or [ ]

To dictate and say commands interchangeably

The most flexible mode in Dragon NaturallySpeaking is the default Normal Mode. In Normal Mode, Dragon NaturallySpeaking distinguishes dictation from commands by analyzing what you say between pauses. For this reason, you should always pause before and after you say a command.

For example, to bold the word "exciting" in the sentence: "Speech recognition is an exciting technology".

1. Say "Speech recognition is an exciting technology period"
2. Pause briefly.
3. Say "Select exciting".
4. Pause again.
5. Say "Bold That".

You need to pause only briefly. You can adjust the length of the pause required before Dragon NaturallySpeaking recognizes commands on the Commands tab of the Options dialog box.

Dictation Mode [ ] or [ ]

To dictate rapidly without looking at your computer monitor

In Dictation Mode, Dragon NaturallySpeaking interprets everything you say as dictation and Dictation Commands, such as New Line, New Paragraph, and Cap, are recognized. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate without looking at the screen. Say "Start Dictation Mode" or "Dictation Mode On."

1. Say "Start Dictation Mode" or "Dictation Mode On".

"Dictation Mode" appears in the status box of the DragonBar.
2. Dictate a few paragraphs. You can dictate without looking, knowing that everything will be transposed as text and no commands (except for Dictation commands) will be executed. You can also dictate sentences that contain words that Dragon normally interprets as commands, such as "I really liked your novel. No, scratch that - I loved your novel!"

Dragon NaturallySpeaking should transcribe the words as text and not execute commands as it normally would.

Command Mode

In Command Mode Dragon NaturallySpeaking interprets everything you say as a command and nothing is interpreted as dictated text. This can be helpful when formatting an existing document.


2. Use commands to format a document. For example, to capitalize the last five words you dictated, say "Capitalize the Last Five Words".

For more examples, see Formatting text in Microsoft Word or Formatting text in Corel WordPerfect in the Dragon Help.

Numbers Mode

To insert numeric characters

By default, when you say a number that is lower than 10, Dragon transcribes it as a word, unless you say the dictation command "numeral" before it. In Numbers Mode Dragon NaturallySpeaking interprets almost all of your dictation as numbers. This is useful if you need to enter numeric data in a table or in spreadsheets.

1. Say "Start Numbers Mode" or "Numbers Mode On".

The DragonBar shows the Numbers mode indicator and "Numbers mode" in the status box.

2. Dictate only numbers. The numbers can include currency or percentages. For example, say "5 percent sign" to enter "5%" or say "Seven hundred twenty three dollars and sixty eight cents" to enter the dollar amount "$723.68".

Spell Mode

To spell words or insert alphanumeric characters

In Spell Mode Dragon NaturallySpeaking allows you to say any combination of letters, digits, or symbols. For example, use Spell Mode to dictate part numbers, license plate numbers, or proper nouns that are not in Dragon's Vocabulary. You can also say keystrokes such as "space bar" or "backspace key", or Internet or Web addresses.

2. Dictate an alphabetic string, such as a homophone alternative you need to use. For example, say the letters "F O R E" to have Dragon enter the word "fore". When Spell Mode is on, you will not be able to dictate words.

You can still use commands while in Spell Mode.

Switching recognition modes

You can use the following techniques to switch recognition modes:

To switch to Normal Mode

On the New DragonBar, Dictation & Commands mode is the equivalent of Normal Mode.
- Say "Switch to Normal Mode" or "Start Normal Mode" or "Normal Mode On".

On the New DragonBar, these commands select Dictation & Commands mode.
- From the Recognition Mode drop-down list on the New DragonBar, select Dictation & Commands.
- On the Modes menu of the Classic DragonBar, click Normal Mode.

To switch to Dictation Mode

- Say "Switch to Dictation Mode" or "Start Dictation Mode" or "Dictation Mode On".
- Hold down the Shift key as you dictate.
- From the Recognition Mode drop-down list on the New DragonBar, select Dictation.
- On the Modes menu of the Classic DragonBar, click Dictation Mode.

To switch to Command Mode

- Say "Switch to Command Mode" or "Start Command Mode" or "Command Mode On".
- Hold down the Control key as you dictate.
- From the Recognition Mode drop-down list on the New DragonBar, select Commands.
- On the Modes menu of the Classic DragonBar, click Command Mode.

To switch to Numbers Mode

- Say "Switch to Numbers Mode" or "Start Numbers Mode" or "Numbers Mode On".
- From the Recognition Mode drop-down list on the New DragonBar, select Numbers.
- On the Modes menu of the Classic DragonBar, click Numbers Mode.
Chapter 18: Improving recognition accuracy

To switch to Spell Mode (or Spell Mode On):

- Say "Switch to Spell Mode" or "Start Spell Mode" or "Spell Mode On".
- From the Recognition Mode drop-down list on the New DragonBar, select Spell.
- On the Modes menu of the Classic DragonBar, click Spell Mode.

Notes
Teaching Dragon to Understand You Better

This section contains the following topics:

Training misrecognized commands ............................................................... 247
Training individual words and phrases ....................................................... 248
Supplemental training .................................................................................... 249

Training misrecognized commands

If Dragon NaturallySpeaking consistently misrecognizes a specific voice command (for example, it hears "Correct That" as "Correct dot"), you can train it to recognize your pronunciation of the command.

To train commands

1. Say "Open Command Browser" or click Command Browser on the Tools menu of the New DragonBar or Classic DragonBar.
2. Say "Click Browse", then "Context", then "<Application name>" (the program in which the command is available) or click Browse > Context > <Application name>.
3. Say or click "Keyword Filter."
4. Say or type a keyword for the command you want to train in the Choose Word box.
5. Say or click "Add" to move the word to the "Current list of filter words." Repeat until you have as many keywords as you need to find the command in question.
6. Say or click "Done."
7. If more than one command appears in the list, select the command you are looking for, expanding it with the Optional, Ellipsis, or Refine buttons if necessary.
8. Do one of the following:
   - Say or click "Train" and follow the directions on the Train Words dialog box that appears.
   - Or
   - Say or click "Train Later." Dragon adds the command to the Train List. Open it to train the commands you stored there.

If you have untrained commands in the Train List when you close the Command Browser, Dragon offers you the choice to train them before you exit.

Notes

- When you train words or phrases, be careful to speak in your normal voice. Avoid the natural tendency to over enunciate when speaking single words or short phrases as it could actually reduce recognition accuracy.
- When you train a command using the Train Words dialog box, you add to the acoustic data stored for later use by the Acoustic Optimizer. This data, including your pronunciation and the acoustic differences between the trained correction and the misrecognized word or phrase, are used by the Acoustic Optimizer to enhance recognition accuracy.
Training individual words and phrases

If Dragon NaturallySpeaking is not recognizing certain words or phrases, and you have tried correcting the misrecognition at least twice, then you should consider training that word or phrase to teach Dragon NaturallySpeaking exactly how you pronounce it.

The following procedures describe two different ways to train words or phrases:

To train individual words and phrases immediately after dictating them

1. Correct the misrecognized word or phrase you want to train and say "Train That."
2. Click Go in the Train Words dialog box and record your speech saying the word or phrase you want to train.
3. When you have finished recording the text, click Done.

To train individual words and phrases at any time

1. Say "Open Vocabulary Editor", or click Vocabulary > Open Vocabulary Editor on the New DragonBar or Classic DragonBar.
2. In the Vocabulary Editor, say or click Train.
3. Type the word or phrase you want to train in the Training dialog box.
4. Click Go in the Train Words dialog box and record your speech saying the word or phrase you want to train.
5. When you have finished recording the text, click Done.

Using punctuation with written and spoken forms

If the written form of a word contains any punctuation, you should provide a spoken form so that there is no doubt as to how the item will be pronounced. Do not use abbreviations, symbols or punctuation in the spoken form.

Examples:

<table>
<thead>
<tr>
<th>Written form</th>
<th>Spoken form</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Man from U.N.C.L.E.</td>
<td>the man from uncle</td>
</tr>
<tr>
<td>Soddy-Daisy, TN</td>
<td>Soddy Daisy Tennessee</td>
</tr>
<tr>
<td>Trenton-Mercer Airport</td>
<td>Trenton Mercer Airport</td>
</tr>
</tbody>
</table>

If you want to add punctuation to a word that already exists in the Vocabulary for use in a specific setting, you can create a new written form with the punctuation included and a unique word or phrase for the spoken form.

For example, if you wanted Dragon to type the word "U.N.C.L.E." in the header of your letters, the written form could be "U.N.C.L.E." and the spoken form could be "UNCLE." That way, Dragon would still type only the word "uncle" when you dictate it as usual, because it also exists in the Vocabulary.
Alternately, if you wanted to add punctuation to a word that already exists in the Vocabulary every time you used that word, you would change the properties of the existing word. For more information, see Word Properties in the Dragon Help.

Notes
- When you train words or phrases, be careful to speak in your normal voice. Avoid the natural tendency to over-enunciate when speaking single words or short phrases as it could actually reduce recognition accuracy.
- A word or phrase must exist in the Vocabulary (that is, have been created previously) before you can train it.
- You can also use the Train button in the Vocabulary Editor dialog box.
- When you train a word or phrase using the Train Words dialog box, you add to the acoustic data stored for later use by the Acoustic Optimizer. This data, including your pronunciation and the acoustic differences between the trained correction and the misrecognized word or phrase are used by the Acoustic Optimizer to enhance recognition accuracy.

Supplemental training
General training refers to a text reading you perform to help improve your recognition accuracy. It is most useful when:
- You have used Dragon NaturallySpeaking for a few days. By then, you will be somewhat accustomed to dictating to it, and acoustic training should reflect how you actually dictate, as opposed to how you would read aloud a regular text, such as an article in today's newspaper.
- You move to an environment that is significantly noisier or quieter or that has different background sounds.
- You have changed your microphone or sound card.

To train Dragon NaturallySpeaking
1. Do one of the following:
   - Say "Switch to DragonBar," then "Audio" then "Read Text to Improve Accuracy."
   - Or
   - Say "Open Accuracy Center" then "click Read text to train Dragon."
2. As you read, try to speak with the same tone of voice, speed, and volume as you typically will when dictating to Dragon.
3. When you are finished, click Finish.

You can read as much or as little as you want, but the longer you train, the more likely you will notice improvements in recognition accuracy.
Personalizing your Dragon Vocabulary

This section contains the following topics:

About personalizing your Vocabulary .......................................................... 250
Adding words or phrases to your Vocabulary ........................................... 251
Learning from specific documents ......................................................... 252
Importing lists of words or phrases ......................................................... 253
Adding words with the Spelling window ................................................. 253
Learn From Sent E-mails ......................................................................... 254
Adding contact names to the Vocabulary ............................................... 255
Deleting words ......................................................................................... 256
Using the Don't Recognize That Word Command ................................... 256

About personalizing your Vocabulary

You can personalize the Vocabulary to more closely match your writing style and to recognize any special words which you dictate. You can do this in several ways, by adding words or phrases (or lists of them), or by having Dragon analyze documents that reflect what you write, and by using Smart Format Rules. Dragon can update the Vocabulary to reflect your usage of words and phrases; this improves the likelihood that it will correctly transcribe what you say in the future.

You can use the following methods to add or delete entries in the Vocabulary.

Adding words or phrases to your Vocabulary
Learning from specific documents
Importing lists of words or phrases
Adding words by spelling
Deleting words
Using the Don't Recognize That Word Command

Notes

- You are not required to train new words because Dragon NaturallySpeaking automatically "guesses" the pronunciations based on their spelling. If, however, your new words are not recognized correctly, you should train them.
- Be sure to save your User Profile after adding new words or the new words will not be saved.
- If you make unwanted changes to a Vocabulary, you can create a new one or restore your User Profile from a backup copy.
- If you use multiple-word phrases with unusual capitalization (for example, "ComputerWeek"), you can improve recognition accuracy by adding these phrases to the Vocabulary before Dragon NaturallySpeaking analyzes your documents. Add these phrases by using the (say "Open Vocabulary Editor" or click Vocabulary > Open Vocabulary Editor on the New DragonBar or Classic DragonBar.) or by including them in lists of items you import into the Vocabulary.
- Dragon can auto-format text and numbers using standard writing conventions or apply Word Properties to words as you dictate. For information about these settings, see Auto-formatting dialog box and The Word Properties dialog box.
- Dragon’s Smart Format Rules appear when you correct auto-formatted alphanumeric text or Word Properties using the Correction menu, the Spelling window, or the keyboard. For details, see Using Smart Format Rules and Setting Auto-Formatting Options.

**Adding words or phrases to your Vocabulary**

If Dragon NaturallySpeaking gets a word wrong, it may be that the word is not in Dragon's Vocabulary. When this is the case, you can use the following procedure to add that word so that it is recognized in the future.

To add individual words

1. Do one of the following:
   - Click Vocabulary > Add New Word or Phrase on the New DragonBar or Classic DragonBar.
   - Say "Switch to DragonBar" then "Vocabulary" then "Add New Word or Phrase".
2. In the Add Word or Phrase dialog box, spell (by voice) or type the word you want to add.
3. Include a Spoken form of the new word if necessary. For example, if the word contains an accent, such as "Gaspé," you would add a Spoken form like "gas pay" so that Dragon recognizes the pronunciation and enters the Written form when you dictate the word.
4. Optionally, select "I want to train the pronunciation of this word or phrase".
5. Click Add.

If you chose to train the word, the word you entered appears in the Train Words dialog box, and you will be able to teach Dragon NaturallySpeaking your pronunciation of that word.

See also Automatically add words to Vocabulary in the Dragon Help.

**Using punctuation with written and spoken forms**

If the written form of a word contains any punctuation, you should provide a spoken form so that there is no doubt as to how the item will be pronounced. Do not use abbreviations, symbols or punctuation in the spoken form.

**Examples:**

<table>
<thead>
<tr>
<th>Written form</th>
<th>Spoken form</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Man from U.N.C.L.E.</td>
<td>the man from uncle</td>
</tr>
<tr>
<td>Soddy-Daisy, TN</td>
<td>Soddy Daisy Tennessee</td>
</tr>
<tr>
<td>Trenton-Mercur Airport</td>
<td>Trenton Mercer Airport</td>
</tr>
</tbody>
</table>

If you want to add punctuation to a word that already exists in the Vocabulary for use in a specific setting, you can create a new written form with the punctuation included and a unique
word or phrase for the spoken form.

For example, if you wanted Dragon to type the word "U.N.C.L.E." in the header of your letters, the written form could be "U.N.C.L.E." and the spoken form could be "UNCLE." That way, Dragon would still type only the word "uncle" when you dictate it as usual, because it also exists in the Vocabulary.

Alternately, if you wanted to add punctuation to a word that already exists in the Vocabulary every time you used that word, you would change the properties of the existing word. For more information, see Word Properties in the Dragon Help.

**Learning from specific documents**

You can use the Learn from Specific Documents wizard to personalize your profile by adding words from specific folders or documents to your vocabulary. Dragon NaturallySpeaking analyzes the documents to update the vocabulary with information about your word usage.

**Caution**

To maintain accuracy, Dragon must only analyze content in the language in which your user profile was created. Be sure to select only documents in the language of your current profile.

To add words from specific documents

1. Say "Open Accuracy Center" and then "Learn From Specific Documents" or click Vocabulary > Learn From Specific Documents on the New DragonBar or Classic DragonBar.
2. In the Learn from Specific Documents wizard, select from the following options:
   - Find Known Words with Unknown Capitalization: Select this option to have Dragon look for words on your system that are in its Vocabulary but which use different capitalization, such as Desktop. This option is turned off by default.
   - Adapt to Writing Style: Select this option to have Dragon analyze word combinations to improve its capacity to anticipate your writing and dictation style. This option is turned on by default.
3. Click Next to continue. The Learn from Specific Documents screen opens.
4. Do any of the following:
   - Click Add Folder if you want Dragon to scan a specific folder, such as your My Documents folder. Click Include Subfolders in the Browse for Folders dialog box if there are subfolders you want to analyze.
   - Click Add Document if you want Dragon to scan specific documents.
   - Click Remove Document if you add a document and then decide that you don't want Dragon to include it in the scan.
   - Click View Document if you want to review a document you added before proceeding.
5. Click Next to continue. A Document Analysis window opens, displaying a status bar during the scan. Dragon confirms whether new words were found and displays a summary of the results.
6. Click Next to continue. If you selected words to add to the Vocabulary, a Train Words screen opens.

7. You can click Train to train Dragon about how you pronounce each added word.

8. When you finish training new words, click Next. The Adapt to Writing Style screen opens, indicating whether the adaptation was successfully completed.

9. Click Next to continue. The Summary screen opens, showing the results of the scan. For example, "1 new word was found" and "1 word was added to your Vocabulary".

10. Click Finish to close the wizard.

11. Say "Switch to DragonBar" and then "Profile" and then "Save User Profile", or click Profile > Save User Profile on the New DragonBar or Classic DragonBar to finish adding the words.

Notes

- If you make a mistake and do not want to add the words, avoid making additional changes to the Vocabulary that you want to save, and then exit Dragon NaturallySpeaking without saving.
- When adding words from documents, you will get the better results if you remove all formatting from the documents you use. For information about how to prepare documents, see the topic Preparing documents to add to the Vocabulary.

Importing lists of words or phrases

Use the Import list of words or phrases wizard if you want to add multiple-word phrases to your Vocabulary, even if they are used in documents that you will process using the Learn from Specific Documents wizard. You should do this because the Import list of words or phrases wizard adds words from documents as phrases, not single words.

For information about how to prepare a list, see the topic Preparing documents to add to the Vocabulary.

To import lists of words or phrases

1. Say "Accuracy Center," or click Help > Improve My Accuracy.
2. On the Accuracy Center, click or say "Import a list of words or phrases".
3. Follow the steps on the Import list of words or phrases wizard.

Adding words with the Spelling window

If Dragon NaturallySpeaking misrecognizes a word, it may be that the word is not in the program's Vocabulary. When this is the case, you can use the following procedure to add the word so that it is recognized in the future.

To add words with the Spelling window

1. Say "Spell That," followed by the first four to six letters of the desired word.

The Spelling window opens.

2. In the the Spelling window, finish typing the word or spell it by voice.
3. If you wish to train the pronunciation of the word, click Audio > Improve Recognition of Word or Phrase and follow the instructions in the Train Words dialog box.

**Note**

You cannot use the Spelling window to add a word that has hyphens or spaces. The program recognizes each part of such a word as separate pieces. For example, if you tried to use the Spelling window to add the name "Havisham-Smythe," you would actually be adding the names "Havisham" and "Smythe". The next time you spoke the name you would get "Havisham Smythe" without the hyphen. To add such a word or name, use the Vocabulary Editor dialog box (say Open Vocabulary Editor).

**Learn From Sent E-mails**

Use the Learn From Sent E-mails tool to make your profile more accurate by personalizing the vocabulary based on emails you have sent.

The tool will offer a list of names from the recipients of your emails and give you the opportunity to train any of them before they are added to the vocabulary.

Optionally, you can also have this tool use the contents of your sent e-mail to adapt the Language Model (Dragon’s statistics on how frequently a given word appears individually and in the context of other words).

**Caution**

To maintain accuracy, Dragon must only analyze content in the language in which your user profile was created. If you have Sent e-mail in other languages, only use this tool to add e-mail contacts to your profile.

**Note**

You may want to run the Learn From Sent E-mails tool only when you are not using your computer for other purposes because the tool uses large amounts of computer memory and processing power.

**To open the Learn From Sent E-mails tool**

- Say "Open Accuracy Center," then "Learn From Sent E-mails."

Or

- Click Vocabulary > Learn From Sent E-Mails on the DragonBar.

**Tip**

You can also start the Learn From Sent E-mails tool by saying "Add Contacts".

Once you start the Learn From Sent E-mails wizard, proceed by clicking Next. The tool leads you through the following screens:

- Choose options
- Scan e-mail
- Add contacts to Vocabulary
- Train words
- Adapt to Writing Style
- Report
Adding contact names to the Vocabulary

The Learn From Sent E-mails tool lets you add the names of people to whom you have sent e-mail to your Dragon NaturallySpeaking Vocabulary. Using this tool, you can edit and train the names you add. You can also have Dragon NaturallySpeaking analyze the contents of your sent e-mail to adapt the language model to more accurately recognize your writing style.

Dragon NaturallySpeaking supports adding contacts in the following e-mail programs:

- Microsoft Outlook
- Windows Live Mail
- Lotus Notes
- Gmail and other Web-based email

To add contact names from your sent e-mail to your Vocabulary

1. Start the Learn From Sent E-mails tool from the Vocabulary menu of the DragonBar.
2. On the first screen of the Learn From Sent E-mails wizard, click Next.
3. On the Choose options screen, select the e-mail programs from which you would like to add contact names and select the "Add contact names from e-mail to the Vocabulary" box.
4. Optionally, you can select the "Improve my profile from my e-mail writing style" if you want Dragon NaturallySpeaking to better understand your Vocabulary and word usage by analyzing your e-mail messages. You can also choose whether the tool should scan all sent emails or just the emails sent since its last scan.
5. Click Next and wait for the wizard to scan the selected e-mail programs. (It may take a few seconds before the process starts.) When the wizard is finished, click Next.
6. On the Add contacts to Vocabulary screen, select the words you want to add, and click Next. Note: you can save time by using the Uncheck All or Check All buttons.
7. On the Train Words screen, select the items you want to train, if any, then click Next to read these items out loud.
8. Wait for the program to adapt your language model. A report screen will then summarize the wizard’s results, including number of words added, if any.

Notes

- If you want Dragon to analyze Web-based email, make sure your computer is connected to the Internet for the duration of the email analysis.
- (Lotus Notes only) New contact names will be detected for everyone to whom you have sent e-mail, except those contacts to whom you have sent Reply messages.
- Nicknames can only be added to your Vocabulary if your e-mail program supports nicknames.
- Do not use "Improve my profile from my e-mail writing style" if you wrote e-mail messages in languages other than the language of your current profile, as this could decrease recognition accuracy.
Deleting words

Use this procedure to delete words from the active Vocabulary. Deleting words is not normally necessary, but you may want to do it for particular words if Dragon tends to substitute a word you never use for a word you want to use, such as “Schaeffer” instead of “Schafer.”

To delete words

1. Open the Vocabulary Editor. Click Vocabulary > Open Vocabulary Editor on the DragonBar, or say "Edit Vocabulary" or "Open Vocabulary Editor.
2. Select the desired word. To find the word you want to delete, enter it into the Search field (type it or use the "spell" command to enter it character by character.
3. When the word appears and is highlighted, use the Delete button or say "click Delete".
4. Close the Vocabulary Editor.

To restore words

Use this procedure if you have deleted a word from the Vocabulary and later want to restore it.

1. Open the Vocabulary Editor.
2. From its Display drop-down list, choose Deleted Words Only. The display now shows any words you have deleted.
3. Choose a Deleted word, and say "click Add" or click the Add button.

Note

If you delete a word using the Vocabulary Editor but that word exists in the current document, the word may be automatically added back into your active Vocabulary.

Using the Don't Recognize That Word Command

Dragon NaturallySpeaking lets you to turn off recognition of words using the Correction menu and the "Don't recognize that word" command.

Don't Recognize That Word removes the selected word from your active Vocabulary, so that Dragon NaturallySpeaking won't recognize it again. This can save you time if Dragon NaturallySpeaking repeatedly replaces words you dictate with words you don't use.

For example, if you dictate the name "Cassity" often and Dragon NaturallySpeaking always hears "Cassidy", you could use Don't Recognize That Word from the Correction menu to turn off recognition of Cassidy. If you decide later that you do need to use the word, you can add it back using the Vocabulary Editor.

When you use the "Don't recognize that word" command or Don't Recognize That Word from the Correction menu to turn off recognition of a word, you will be presented with one of the following messages to confirm a deletion of the word:

Are you sure you want to delete the following word from the Vocabulary?

This message is displayed when you use the "Don't Recognize That Word" command to delete a word or phrase from the Vocabulary.
The following word can only be removed from the Vocabulary using the Vocabulary Editor.
This message is displayed when you use the "Don't Recognize That Word" command to try to delete a custom word or frequently used word such as "the" from the Vocabulary. You can use the Vocabulary Editor to delete the word.

The following word can't be deleted because it does not exist in the Vocabulary.
This message is displayed when you use the Don't Recognize That Word command to try to delete a word or phrase that is not in the Vocabulary.

For more information, see the Correction menu.
Managing Vocabularies

This section contains the following topics:

About Vocabularies .................................................................................. 258
Opening Vocabularies .............................................................................. 259
Adding a Vocabulary to a User Profile .................................................. 260
Deleting Vocabularies .............................................................................. 261
Renaming Vocabularies ............................................................................ 261
Importing Vocabularies ........................................................................... 262
Exporting Vocabularies ........................................................................... 262

About Vocabularies

Dragon NaturallySpeaking uses one or more Vocabularies with your User Profile to help it to recognize words and phrases correctly, based not only on the sound of the words and phrases, but also on their context.

When you create a new User Profile, you select a Base Vocabulary that Dragon then updates as it adapts to your speech. When you create a new User Profile or add a Vocabulary to an existing User Profile, Dragon bases the new Vocabulary on an existing Vocabulary.

Language

The languages available for your Vocabulary. Some editions of Dragon support multiple languages.

Vocabulary type

In most cases your User Profile will be based on the General Vocabulary, a large Vocabulary providing excellent recognition accuracy for general, business, and professional dictation.

The following specialized Vocabularies are also available:

- Legal (Dragon Legal Edition)
  A large Vocabulary providing excellent recognition accuracy for legal terms.
- Medical (Dragon Medical Edition)
  A set of specialized large medical Vocabularies providing excellent recognition accuracy for medical terms. The Vocabulary names are: General, Cardiology, Emergency, Gastroenterology, General Practice, Medical, Mental Health, Neurology, Obstetrics/Gynecology, Oncology, Orthopedics, Pathology, Pediatrics, Radiology, and Surgery.

Advanced

On the Review Your Choices screen of the New User Profile wizard, you can click the Advanced button to display the Advanced Choose Models dialog box. On this dialog box you can choose a different speech model and Vocabulary Type. Dragon NaturallySpeaking automatically determines the best speech model and Vocabulary Type for your computer when you create a User Profile, so you do not generally need to change these options.
Speech model

You can associate speech models with your Dragon Vocabulary, depending on your accent and the type of computer you are using.

For a list of supported devices, including handheld and Bluetooth microphones, see the Hardware Compatibility list on the Nuance Web site.

Vocabulary Type

If you click the Advanced button, you can specify a different Vocabulary type from among the following choices.

Note

Some Dragon NaturallySpeaking editions or add-on products may install additional Vocabularies.

Opening Vocabularies

Use the following procedure to open another Vocabulary associated with your User Profile. You can have only one Vocabulary open at a time. See Adding a Vocabulary for more information.

To open a Vocabulary

1. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the New DragonBar or Classic DragonBar.
2. On the Manage Vocabularies dialog box, select the name of the Vocabulary you want to open and click Open. If you made changes to the current Vocabulary, the system prompts you to save your speech files before the selected Vocabulary opens.

To open a recently used Vocabulary

Use the following procedure if you have one or more Vocabularies associated with your User Profile and you want to switch to the most recent one you used.

- Say "Open Recent Vocabulary" or click Vocabulary > Open Recent Vocabulary on the New DragonBar or Classic DragonBar. Dragon opens the most recent Vocabulary associated with your User Profile.

Notes

- Any phrases you add to a Vocabulary are available in that Vocabulary only, but custom voice commands are always available no matter which Vocabulary you are using.
- Switching Vocabularies has no effect on the text in the document window. It does, however, close any open dialog boxes, such as General Training and Vocabulary Editor.
- Vocabularies that you have created and opened appear in the Profile menu on the Open Recent Vocabulary submenu. You can quickly switch between Vocabularies by selecting the appropriate Vocabulary name from this submenu.
Adding a Vocabulary to a User Profile

With Dragon Professional, Legal and Medical editions, you have the option of creating new Vocabularies and adding them to your existing User Profile to improve recognition accuracy. This may be helpful if you use specialized terminology when you dictate into documents and e-mails. You can only have one Vocabulary open at a time.

Note

Creating a Vocabulary can take from 5 to 30 minutes depending on the options you select, the speed of your processor, the amount of RAM in your system, and the amount of e-mail and data to be scanned. Progress bars display the time remaining in this procedure. If you include the E-mail option, it is best to create new Vocabularies only when you are not using your computer for other purposes.

To add a Vocabulary to a User Profile

1. Do one of the following:
   - Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the New DragonBar or Classic DragonBar.
   - Say "Switch to DragonBar," then "Profile," then "Add Vocabulary to Current User Profile," or on the New DragonBar or Classic DragonBar click Profile > Add Vocabulary to Current User Profile. Go to step 3.

2. On the Manage Vocabularies dialog box, click New.

3. From the Based On list in the New Vocabulary dialog box, select the name of a Vocabulary on which you want to base the new Vocabulary.

   All available Vocabularies are listed. Those beginning with the word "Base" are the unmodified Vocabularies shipped with Dragon NaturallySpeaking. The Vocabulary you select will be copied to the new Vocabulary and supplemented with words from your documents, emails, and added to your User Profile.

4. Enter a descriptive name for the Vocabulary.

   A Vocabulary name can contain up to 128 characters, including spaces.

5. Click OK to create the Vocabulary. The Let Dragon search for words tool opens and prompts you to allow Dragon to improve recognition accuracy by adapting the Vocabulary based on e-mail messages and documents.

6. Make your selections and click Start to begin the optimization.

   Note: If you need to save time, you can deselect E-mail adaptation and run it later. See Let Dragon search for words tool for details.

7. Optionally, before using the Vocabulary, you can personalize it further using the Accuracy Center. For more information, click See Also below.

Notes

- Any Vocabularies you create are saved along with the files that are part of your User Profile.
Keep in mind that creating many specialized Vocabularies can make it difficult to keep track of which words are available when you dictate.

Also keep in mind that each new Vocabulary uses hard-disk space.

Deleting Vocabularies

Additional Vocabularies can improve recognition accuracy in Dragon NaturallySpeaking, but multiple Vocabularies can take up a lot of disk space. If you no longer need a Vocabulary, use the following procedure to delete it.

To delete a Vocabulary

1. On the Vocabulary menu of the New DragonBar or Classic DragonBar, click Manage Vocabularies.
2. On the Manage Vocabularies dialog box, select the Vocabulary you want to delete and click Delete.
3. Click Close on the Manage Vocabularies dialog box.

Notes

- Deleting a Vocabulary cannot be undone.
- You cannot delete the Vocabulary that is currently in use. To remove it, you must first open a different Vocabulary.
- Always use the Delete button to delete Vocabularies. Do not remove Vocabulary folders from Dragon NaturallySpeaking Users directory on your hard disk.

Renaming Vocabularies

If you have multiple Vocabularies, you should give them descriptive names that help you identify their purpose.

To rename a Vocabulary

1. Say "Manage Vocabularies" or click it on the Vocabulary menu of the DragonBar.
2. On the Manage Vocabularies dialog box, say or choose the name of the Vocabulary you want to rename.
3. Click or say "Rename."
4. On the Rename Vocabulary dialog box, enter a new name and click or say "OK."
5. On the Manage Vocabularies dialog box, click or say "Close."

Note

A Vocabulary name can contain up to 128 characters, including spaces.

Importing Vocabularies

You can share Vocabularies among different User Profiles by first exporting a Vocabulary from one Profile and then importing it to another Profile. If you have exported a Vocabulary from another Profile (for example, if you have created a Profile with a custom word list), use the following procedure to import it.
Chapter 18: Improving recognition accuracy

To import a Vocabulary

1. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the DragonBar.
2. On the Manage Vocabularies dialog box, click or say "Import."
3. Use the Open dialog box to locate and open the folder containing the Vocabulary you want to import (it must be a Vocabulary that was exported).
4. Select the desired Vocabulary (.TOP) file and click or say "Open."
5. In the Import Vocabulary dialog box, enter a name for the imported Vocabulary.

To import the Vocabulary so that it replaces an existing Vocabulary, enter the name of the existing Vocabulary. To import the Vocabulary as a new one, enter a new name that you have not used before.

A Vocabulary name can contain up to 128 characters, including spaces.

6. Click or say "OK" to save the Vocabulary.
7. Click or say "Close" on the Manage Vocabularies dialog box to close it.

Notes

- An exported Vocabulary consists of six files with the same name but different extensions. These six files must remain in the same directory. To import the Vocabulary, you specify only the file with the extension .TOP. Dragon NaturallySpeaking then imports all six files that together make up a Vocabulary.
- You may want to keep a master copy of an imported Vocabulary and create a copy of it to work with.
- Vocabularies can be shared only by exporting and importing them using the procedures described here. It is not possible to share Vocabularies by copying Vocabulary folders from one Profile to another.
- Creating and personalizing a Vocabulary with documents you choose as representative of your writing style may be more effective than using a Vocabulary created by someone else.
- If you create a Profile on a dual-core machine that uses a custom vocabulary, make sure that the Profile uses the BestMatch V speech model (BestMatch V has the greatest recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select the Advanced button on the Creating a User Profile screen of the New User Profile wizard and make sure that BestMatch V is selected.

Exporting Vocabularies

You can share Vocabularies among different User Profiles by first exporting a Vocabulary from one User Profile and then importing it to a new User Profile. Use the following procedure to export a Vocabulary.

To export a Vocabulary

1. Create a folder in which to save the exported Vocabulary files (this step is optional).
2. Open the User Profile and the Vocabulary(s) you want to export as follows:
   i. Click Profile > Open User Profile on the New DragonBar or Classic DragonBar.
ii. Select the User Profile you want to export and click Open.

3. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the New DragonBar or Classic DragonBar.

4. On the Manage Vocabularies dialog box, select the Vocabulary you want to export and then click or say "Export."

5. Locate and open the folder where you want to save the file and then click or say "Save." Dragon gives Vocabulary files the extension ".Top."

6. Click or say "Close" on the Manage Vocabularies dialog box to close it.

Notes

- Vocabularies can be shared only by exporting and importing them. It is not possible to share them by copying Vocabulary folders from one User Profile to another.
- When the Vocabulary is imported, it can be renamed.
- Exporting a Vocabulary creates a copy of the six files that make up the Vocabulary in the new location. All six files have the same name but different extensions. When importing a Vocabulary, select only the Vocabulary file with the extension .TOP.
Chapter 19: Using the Command Browser

This section contains the following topics:

- About the Command Browser ............................................................... 264
- Opening the Command Browser ......................................................... 265
- Finding commands in the Command Browser ....................................... 266
- Training commands in the Command Browser ....................................... 268

About the Command Browser

The Command Browser is a window where you can locate voice commands that Dragon NaturallySpeaking recognizes, including commands that are provided with the software as well as any commands that you or your system administrator might have added (custom commands). The Command Browser is the most comprehensive place to see the commands that are available in each application.

You use the Command Browser to:

- View and train commands
- Create and modify commands
- Import and Export commands
- Change the availability of custom commands

Some commands are not available in Dragon Premium and lower editions.

Command Browser modes

Browse

Browse mode allows you to search for a specific command. For more information see the topic Finding commands in the Command Browser.

Script

Script mode allows you to create new commands and select commands to delete, edit, copy, or preview.
Manage

Manage mode allows you to import, export, delete, or edit the properties of selected custom commands. (Some of these functions are available in only Dragon NaturallySpeaking Professional, Legal, and Medical editions.)

To make the Command Browser appear always on top

- Say "Mode > Always On Top," or on the Mode menu, click Always On Top.
- On the Command Browser shortcut menu, click Always On Top.
- Click on the Command Browser icon on the left side of the Command Browser or right-click anywhere on the Command Browser to open the Command Browser shortcut menu.

Note

When you set the Command Browser to "Always On Top" it will cover secondary Dragon NaturallySpeaking windows, such as the DragonPad and Help screens. In these cases, you will have to turn off the "Always On Top" state or move the windows around so that they are not obscured.

Opening the Command Browser

The Command Browser displays commands that Dragon NaturallySpeaking recognizes in the current context, whether you are working in a specific program or on the Windows Desktop.

To open the Command Browser

- Say "Open Command Browser" or "Start Command Browser" or, on the Tools menu of the New DragonBar or Classic DragonBar, click Command Browser.

You can also open the Command Browser from the Accuracy Center.

Some commands are not available in Dragon Premium and lower editions.

Global Commands

When the Command Browser first opens, it displays a list of Global Commands available in every application.

But if you want to view commands for individual applications, Dragon shows only commands applicable in that context. Use the Context box to select a specific application and Dragon displays only the commands that work in that application. If you were viewing commands for the Dragon NaturallySpeaking Learning Center (as shown), initially a subset of commands that apply only to the Learning Center appear. See Finding commands in the Command Browser for details.
To display Global Commands for a specific application

Select the Global Commands checkbox to include Global Commands, in the current display, i.e. present them together with the commands that work just in the selected context.

In the Command Browser, say "Include Global" or, on the Command Browser Ribbon Bar, click Include Global.

Finding commands in the Command Browser

If a command exists for a specific application or context, you can use the Command Browser to find it.

To find a specific command

1. Use the list in the Context box to select the application context you want to see commands for.

2. Select the Include Global checkbox.
When the Include Global checkbox is selected, the Command Browser displays all the commands available in the current command context, including any commands available in all (global) contexts. Note that the Command Browser initially opens with Global Commands selected in the Context list box so that the Include Global checkbox is not active. You must select a different command context to make the Include Global checkbox active.

3. Click Keyword Filter to display the Keyword Filter dialog box.
4. Say or type a letter or word of the command you are looking for in the Choose word box. The list below the box scrolls to the first instance of that letter or word in the list. (If the letter or word exists, it is selected. If the letter or word does not appear, then there is no command in the current context that uses them.)
5. Double click on the word in the list or click Add to add the word to the Current list of filter words box.
6. If necessary, continue to enter words into the Choose Word box and add them to the Current list of filter words box until you have added as much of the specific command as you can.
7. Click or say "Done." The Command Browser displays the commands containing the words you entered, if any command containing all of those words exists.

Example

To see if there is a command that changes a font to bold in Microsoft Word 2010:

1. Select Microsoft Word 2010 from the Context list box.
2. Click or say "Keyword Filter."
3. Say or type the word "Bold" and then say "Add" or click the Add button to add it to the Current List of Filter Words box.
4. Say or type the word "Set" and then say "Add" or click the Add button to add it to the Current List of Filter Words box.
5. Click or say "Done."

The Command Browser displays all the commands that will turn text bold in Microsoft Word 2010. For example,
Chapter 19: Using the Command Browser

Some complex commands may not be fully visible at first. See the topic Expanding commands for information on how to view all parts of a command.

Note: Previous command searches appear in the Keyword Filter list.

You can select a previous search from this list to automatically display the results of that search, without having to open the Keyword Filter dialog box and set up the search criteria again.

Training commands in the Command Browser

If Dragon NaturallySpeaking consistently misrecognizes a specific voice command (for example, it hears "Paste That" as "Paste dot"), you can train it to better recognize your pronunciation of the command.

To train a command

1. Open the Command Browser (say "Command Browser" or click Command Browser on the Tools menu of the New DragonBar or Classic DragonBar).
2. Select the command context from the "Context" list.
3. Locate the command you want to train and select it. See the topic Finding Commands in the Command Browser for information on how to find a specific command.
4. Click or say one of the following buttons on the Command Browser task pane:
<table>
<thead>
<tr>
<th>Button</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Train]</td>
<td>Lets you immediately train the selected command. Follow the directions on the Train Words dialog box that appears.</td>
</tr>
<tr>
<td>![Train Later]</td>
<td>Adds the command to a list of commands of the Train List for later training. By selecting Train Later, you activate the Train List button.</td>
</tr>
<tr>
<td>![Train List]</td>
<td>Displays the Train Words dialog box with a list of commands to be trained. If you have untrained commands in the Train List when you close the Command Browser, Dragon offers you the choice to train them before you exit.</td>
</tr>
</tbody>
</table>
Use this glossary for a list of terms specific to Dragon.

.DRA files (definition)
Dragon Recorded Audio (DRA) files. If your edition supports it, Dragon automatically saves audio and text transcripts of your dictation in the DRA files.

Dragon Accuracy Center (definition)
Offers a central location for tools you can use to personalize your vocabulary, improve acoustics, find or manage commands, or get more information about improving your accuracy. Click the links to open the related Dragon tools.

To open the Accuracy Center, say “display Accuracy Center” or click Help > Improve My Accuracy on the New DragonBar or Classic DragonBar.

Accuracy Slider (definition)
A sliding control that Dragon uses to adjust speed relative to accuracy as it performs speech recognition. A higher accuracy setting means that Dragon may take longer to display your text, while a higher speed setting means that Dragon displays the text more quickly.

Accuracy Tuning (definition)
A process Dragon can use to adapt to your usage. Once you have been dictating for a period of time, Dragon uses Accuracy Tuning to automatically refine your User Profile, analyzing your dictation, corrections, commands, and any other acoustic training you have done. Accuracy Tuning uses two of Dragon’s accuracy tools, the Acoustic Optimizer and the Language Model Optimizer, and you can schedule them to run automatically.

Acoustic and Language Model Optimization (definition)
Increases User Profile accuracy based on

- accumulated acoustic data from your corrections and any additional training you have performed
- commonly used word sequences extracted from your User Profile’s .DRA files.
Acoustic Optimizer (definition)

Looks for any corrections you have made or additional training you may have performed since you created your User Profile or ran the optimizer. Optimization enhances recognition accuracy and helps predict words most likely spoken in a given context by a speaker (the language model).

Active vocabulary (definition)

A list of about 150,000 words that Dragon loads into your computer's random access memory for immediate use during dictation. These are the words that Dragon NaturallySpeaking is most likely to recognize on the first try, without requiring you to do anything extra such as correcting the words with the Correction menu.

The number of words in the active vocabulary always remains the same. When new words are added, words that have not been used recently are removed from the active vocabulary, but remain on the computer's disk in the backup dictionary.

Advanced Scripting (definition)

Supports using programming languages such as Microsoft® VBA to create commands that can perform virtually any function on the computer with voice commands.

AutoTranscribe Folder Agent (definition)

A feature of Dragon Professional, Legal and Medical editions which automatically detects and transcribes recordings copied to a specified directory. Use the AutoTranscribe Folder Agent to specify which Dragon User Profile to use for transcribing the recordings found in the specified directory, and to specify where to put the text files created from the recordings.

Base Vocabulary (definition)

The initial Vocabulary a User Profile is based on. Vocabularies can be the following sizes. Specialized medical and legal vocabularies are also provided in the Dragon Medical and Legal editions.

Backup dictionary (definition)

A store of about 150,000 additional words in Dragon's vocabulary. A typical large Dragon vocabulary consists of about 300,000 words and Dragon loads about half of those it understands that you are more likely to dictate into your computer's random access memory for immediate use. The list of words Dragon loads into memory is called the "active vocabulary."

You can move frequently used words from the backup dictionary into the active vocabulary or add new specialty words, proper names, acronyms, and unusual abbreviations using any of the following methods:

- Add new or frequently used words and teach Dragon about how frequently you'll use them with the Learn from Specific Documents, Learn From Sent E-mails, and Import lists of words or phrases tools
- Use the Correction menu to correct the error
- Correct dictation errors using the mouse or keyboard (the microphone can be on, off, or asleep)
- Use the Spelling window to spell the word

Remember to save your User Profile to keep your changes.

**Command Browser (definition)**

A window showing voice commands that Dragon recognizes, including commands that are provided with the software as well as any commands that you or your system administrator might have added (custom commands). The Command Browser is the most comprehensive place to see the commands that are available in each application.

**Command Mode (definition)**

A restricted recognition mode that causes Dragon to interpret everything you say as a command and nothing is interpreted as dictated text. Say "Start Command Mode" or "Command Mode On."

**Correction menu (definition)**

Shows Dragon’s best guess for alternatives to words you dictated and selected. Choose the correct word from the Correction menu by saying “Choose” and the number next to your choice.

**Correction-only mode (definition)**

Enables transcriptionists to play back a Dragon user’s dictation without having their User Profile loaded. Note that dictation is disabled if you select this option.

Dictation is not available in Correction Only Mode.

**Custom word (definition)**

A new word you add to the base Vocabulary using the Train command or the Add command in the Vocabulary Editor. You can also add words to the Vocabulary using the Spelling Window or the Add New Word or Phrase command on the Vocabulary menu.

In the Vocabulary Editor, a red cross + next to a word indicates that it is a custom word that has been added to the Vocabulary.

**Data Collection (definition)**

Helps to improve the accuracy of future versions of Dragon NaturallySpeaking and Dragon Medical. By enabling Data Collection, you can allow Dragon to collect up to 500 MB of acoustic data and text from your dictation sessions. If you agree, the data can be sent to Nuance at a time scheduled by your network administrator. Data Collection does not include any personal data, and participation is completely voluntary.
Data Distribution Tool (definition)
Enables developers to interactively create new words, customized Vocabularies or commands, and to make them available to all User Profiles on a particular Dragon NaturallySpeaking installation.

Dictation Box (definition)
Provides full support for dictating and editing text in an unknown text field. The Dictation Box supports voice commands like Delete, Correct, and Insert, and custom commands as well. When you are finished, the content is transferred to your cursor position when you opened the Dictation Box.

Dictation commands (definition)
Commands typically said in the process of dictating. They include "new line," "new paragraph," "numeral <number>" , "all caps <word>" and "cap <word>" .
Important: these commands can be seen in the Vocabulary Editor, not in the Command Browser.
(Also referred to as "in-line commands," Dictation commands do not require pausing before and after saying them, unlike other commands.)

Dictation Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as dictation and only Dictation Commands are recognized. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate without looking at the words Dragon transcribes. Say "Start Dictation Mode" or "Dictation Mode On."

Dictation Source (definition)
An audio input device or multiple devices associated with a User Profile. For example, you can select a headset microphone at one computer and a portable recorder or another style of mic at other computers. This way, Dragon supports users who need to move, or "roam", from computer to computer regardless of the microphone type or differences in ambient noise.

Direct Editing commands (definition)
Voice formatting and correction commands such as “italicize <XYZ>” or “bold <XYZ>”. Direct Editing commands (formerly called Quick Voice Formatting commands) are faster than conventional commands, because they tell Dragon to go to other places in your document, apply formatting there, and return the cursor back to where you are working.

DragonPad (definition)
Dragon’s built-in word processor, optimized for dictation and includes basic text formatting features as well as the ability to save and print documents.
**Dragon Templates with Voice Fields (definition)**

A special kind of custom form available to paste into applications by voice, providing fields for common variable information that you can fill in by voice.

**Dragon Voice Shortcuts (definition)**

Dragon voice shortcuts collapse common multi-step tasks into direct voice commands that you can say at anytime, no matter what is active on your screen.

For example, you can immediately switch to and start a new task, such as search the Web or your computer, or compose an e-mail or set up an appointment.

**Field (definition)**

A field, also referred to as a variable field, is an alphanumeric string enclosed by text delimiters. For example, the following sentence appears in the Dragon CCU fellow admit template included in Dragon Medical: The patient was seen in conjunction with Dr. [ProviderName]" In the example, "[ProviderName]" is the variable field, the square brackets are the default delimiters, and the text string "ProviderName" is the variable that the Dragon User Profile will replace with a provider name when using the template to complete a report.

**Full Text Control (definition)**

Refers to the level of dictation support available in Web and desktop programs and windows when Dragon fully supports creating, editing, and formatting content. When a program or part of a program has Full Text Control, you can move the cursor reliably – for example, to the beginning or end of a line or paragraph. You can also select, format, and revise text as needed using Direct Editing commands, the Correction menu, or the Spelling Window.

For supported Web applications, Full Text Control is activated using the Dragon web extension in supported browsers.

When the cursor is in a text field for which Dragon has Full Text Control, the Text Control Indicator on the Classic DragonBar [✓] or the New DragonBar [●] is green when all of Dragon's selection and dictation capabilities are supported.

**Hidden Mode (definition)**

Absent from non-medical editions, this mode allows Dragon to send all recognized text to the Dictation Box, which is active but does not display. All recognized text is added to the Dictation Box, regardless of the cursor location. Hidden Mode is often used by healthcare providers who are dictating medical reports to be sent to a medical transcriptionist/editor. Say "Start Hidden Mode" or "Hidden Mode On".

**Language Model (definition)**

Contains statistical information that predicts which words are most likely to occur in the context of the user’s speech.
Language Model optimization (definition)
Updates the language model of the current Vocabulary. Language Model Optimization uses text Dragon extracts from the .DRA files that are created when you correct words. Based on the speech data collected, Language Model Optimization applies modifications to the language model to reflect your word usage.

Language Model Optimizer (definition)
Performs Language Model Optimization from the Accuracy Center. Any Dragon user with administrator privileges can schedule Dragon to perform optimization periodically.

Natural Language Commands (definition)
Provide greater flexibility in the wording you use to perform common actions in a variety of applications such as Microsoft Word, Internet Explorer, and Mozilla Firefox. Instead of requiring users to memorize specific commands, such as "bold that," the Natural Language Commands give you a wide range of words you can say to execute a command. For example, "make that bold," "bold the last paragraph," "set font bold" all do the same thing, as do many more conversational commands. To know which commands work in an application, open the application and say “What Can I Say?”.

Normal Mode (definition)
Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from words, numbers, and commands by analyzing what you say between pauses. Say "Start Normal Mode" or "Normal Mode On."

Nothing But Speech (definition)
Suppresses recognition of non-word fillers like “ums” and “ahs” that you don’t normally intend to include in your dictation.

Numbers Mode (definition)
A restricted recognition mode that causes Dragon to recognize only numbers. If you are dictating only numbers (including currencies), working in this mode increases recognition accuracy. Say "Start Numbers Mode" or "Numbers Mode On."

Performance Assistant (definition)
A resource available from the Help menu that offers suggestions for optimizing Dragon’s speed on your computer. As you click or say the corresponding links to answer questions about how you normally use Dragon, the Performance Assistant provides suggestions and methods for optimization.

Press <key> command (definition)
Used to make keystrokes by voice. To type characters by voice, say "Press," "Press Key," or "Type" followed by the name of the key or keys you want to press. For example, say “Press
Escape” or “Press Enter”, or “Press Ctrl Right”.

QuickStart (definition)

Allows Dragon NaturallySpeaking to load in the background when you start your computer or log in to your operating system, depending on your version of Windows. When Dragon is launched in QuickStart mode Dragon is available for use more quickly than when you start in normal mode. The microphone icon appears in the system tray.

Recognition Modes (definition)

By default, Dragon functions in Normal Mode, distinguishing dictation from words, numbers, and commands, and analyzing what it hears between pauses. Dragon also offers restricted recognition modes for dictating only commands, numbers, characters (Spell Mode), or words (Dictation Mode).

Results Box (definition)

A floating display box that Dragon can provide as it listens to you and processes your speech. You can set options to move the Results Box anywhere on the screen, keep it in one place, change its color and font size, or make it disappear after a recognition.

See About the Results Display for details.

Results Display (definition)

The on-screen feedback that Dragon NaturallySpeaking displays during dictation. While Dragon NaturallySpeaking listens, the Recognition in Progress icon displays. When you pause, Dragon NaturallySpeaking finishes processing your speech and enters dictation into the document or executes your command. When recognition is complete, the Dragon idle icon displays. See also Results Box.

The Dragon Web Extension (definition)

Enables page element commands such as "Click Link" and "Click Button" and Full Text Control in supported browsers and Web-based applications. With the Dragon Web Extension installed and enabled, you can dictate content and use commands just as you would in a desktop program. Without the extension, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

Roaming User Profile (definition)

See Master Roaming User Profile.

Say What You See (definition)

"Say What You See" means that you can say whatever commands you see labeled on your screen to control applications by voice. For example, you can say the names of menus,
menu commands, or items in a dialog box. To display the Insert menu in Microsoft Word or Microsoft Excel, you would say "Insert," and then say the name of any of the available commands, as required. Another example is the ability to open a Desktop item (a folder, for instance), by saying "open" followed immediately by its name.

**Scripting (definition)**

Dragon scripting language extensions provide a set of tools for creating voice commands. Creating scripting commands requires familiarity with the Microsoft Visual Basic programming language.

**Unknown text field (definition)**

An editable window or field that does not support all of Dragon's selection and correction capabilities. When the cursor is positioned in an unknown text field, the New DragonBar or Classic DragonBar displays the message "Unknown text field; consider using 'show Dictation Box' - See Help." In those cases, Dragon's Full Text Control indicator is grey. You can usually select, correct, and use various commands in unknown text fields, but if you have trouble, use the Dictation Box and transfer text from it into the application.

**Windows shortcut (definition)**

You can use Windows Shortcuts and command lines to [open User Profiles and Vocabularies directly](#).

**Spell Mode (definition)**

A restricted recognition mode that causes Dragon to recognize only letters, numbers, commands, and punctuation. Spell mode is useful for dictating unpronounceable alphanumeric strings, such as part numbers and license plate numbers, and other terms you anticipate Dragon won't know, such as Web addresses, words in a foreign language, or unusual product names. Say "Start Spell Mode" or "Spell Mode On." You can still use commands while in Spell Mode.

**Spoken Form (definition)**

Refers to words that are spoken one way but written a different way (the Written Form). This feature lets you add a word that, for example, types your phone number whenever you say "phone number line," or automatically adds punctuation, such as "UK" or "USA," which would normally include punctuation in the written forms (U.K. and U.S.A.).

**Structured Commands (definition)**

Used to control the action of a command based on the existence of a state in the application the command is used for. For example, when you assign a state to each field in a form, the same command can perform different actions, depending on which field is activated. You can use Advanced Scripting methods to control the states within structured commands or to set the initial state from a non-structured command. You can also create structured commands that prompt the user to select values from a predefined list. Structured Commands are available only in Dragon Professional, Legal, and Medical editions.
Text Control Indicator (definition)

The check mark icon (✓) on the Classic DragonBar or the circle icon (◯) on the New DragonBar. The Text Control Indicator changes color to show the level of dictation support in your current application. The Text Control Indicator is green (✓ or ◯) when all of Dragon's selection and dictation capabilities are supported and gray or disabled (◯ or ◯) when the insertion point is in a window that has less support for dictation.

User Profile (definition)

A User Profile is a set of files that store the following information:

- Audio system settings selected by the Check Microphone wizard
- Acoustic information about your voice gathered during initial product training, ongoing usage and when you train specific words
- Ongoing adaptations to your Vocabulary words and word usage as you use Dragon and from analysis of your writing style
- Your settings in the Options dialog box
- Any custom voice commands

Utterance (definition)

Dictation or commands Dragon NaturallySpeaking recognizes between pauses in your speech.

Vocabulary (definition)

Contains all of the words that Dragon recognizes and a Language Model. The Vocabulary includes all of the words in the active vocabulary and the backup dictionary, and any words added as you customize your User Profile.

Web application support (definition)

Provides the Dragon web extension in supported Web browsers to enable commands and Full Text Control for selected browser-based applications. With the Dragon web extension installed and enabled, you can dictate content and use commands just as you would in a desktop program.

Word Properties (definition)

Word Properties specify a variety of options that can be associated with Vocabulary entries. You can specify that a word be preceded or followed by specific characters and customize properties for placement or handling. For example, question marks and exclamation marks have default properties of "Precede by (nothing)" and "Format the next word capitalized."

You can also specify one or more alternative forms for words. If the Use Printed Form 1 checkbox is selected for "meter," then when you dictate the word after a number, Dragon will enter "m" instead of "meter." If the Alternate Written Form checkbox is not selected, and you dictate "meter," Dragon types the full word, "meter."
Written Form (definition)

Specifies the word or words that Dragon enters when you dictate. The spoken form can be an easier or shorter variant or something completely different from the written form.
Index

.DRA files (definition) .................................... 270

A
accuracy ........................................... 230, 238, 240
improving ........................................... 230, 240, 254-255
using Accuracy Center .. 230, 240
using the Speed vs. Accuracy slider .. 238
Accuracy Center (definition) ...................... 270
Accuracy Slider (definition) ...................... 270
Accuracy Tuning (definition) ...................... 270
Acoustic Optimizer (definition) ................... 271
acoustics
about Acoustic and Language Model Optimizer ...................... 240
optimizing ........................................... 240
activating Dragon ................................. 31, 41
active Vocabulary (definition) .................... 271
adding
a different Vocabulary ............................ 260
contact names to the Vocabulary 254-255
contacts in Microsoft Outlook .................... 164
words from lists ...................................... 253

words to the Vocabulary ...................... 250-251, 253, 255
words with the Spelling window ................ 253
additional training .................................. 249
addresses, dictating e-mail and Web ........... 157
Advanced Scripting (definition) .................. 271
aligning text ......................................... 131
Application menu ................................... 141
applications ......................................... 210
exiting ............................................... 208
starting ............................................... 208
starting (and utilities) ............................. 211
switching ............................................ 210
Web-based ............................................ 176
Applying formatting to multiple instances of words ................ 106
Auto-Formatting
using Smart Format Rules ......................... 232
AutoTranscribe Folder Agent
definition ............................................. 271

B
Backspace ........................................... 127
backup
dictationary, viewing .............................. 271
dictionary (definition) ............................. 271
Base Vocabulary (definition) ..................... 271
basic document commands
Microsoft Word ..................................... 144
basic spreadsheet commands
Microsoft Excel ..................................... 169
Basic Text Control indicator ..................... 59
basic text dictation ................................. 77
BestMatch Technology ......................... 258
boldface
  applying with Direct Editing ..................104
  applying with multiple text matching ..................106
boldface, applying ..................................128, 131
browsers
  compatibility ......................................176
  using .............................................199
buttons, selecting by voice ..........................213
C
calendar
  and email commands ...............................158
Canadian postal codes ................................233
capitalizing text .....................................129
categories
  searching on the Web ..............................195
centering text .......................................131
characters .........................................120
  selecting ........................................120
Check Microphone
  position your microphone properly ..............68
Choose a speech device .............................67
choosing
  programs and windows .............................217
clicking, using voice commands ....................227
closing
  exiting Dragon ....................................63
  menus ...........................................213
  programs ........................................214
  the DragonBar ....................................63
  windows ........................................214-215
Coexistence with other Dragon products ... 18
Coexistence with previous versions of Dragon ..................................................18
Coexistence with the Dragon SDK Client Edition ..............................................18
combining words .....................................132
Command Browser .................................264, 266, 268
  about ..............................................264
  always on top .....................................265
  finding commands ................................266
  Include Global button .............................266
  opening ...........................................265
  training commands .................................268
Command Browser (definition) ......................272
command context
  showing ...........................................265
command line interface .............................49
Command Mode .........................................244-245
  switching to .......................................245
  using .............................................243
Command Mode (definition) .........................272
commands ..............................................45
  application control ................................208
  Command Browser .................................264-266, 268
  controlling DragonBar ..............................63
  Cut Copy and Paste ................................125
dictation ............................................80
displaying for a specific application ............265
displaying Help on ...................................63
Dragon Sidebar ........................................74
e-mail .................................................155
Firefox and Internet Explorer .......................199
for moving in windows ..............................215
forcing recognition of ................................45
hot key for ........................................ 45
if not recognized .............................. 102
Internet Explorer 7 .......................... 204
Internet Explorer and Mozilla Firefox .................................... 199
Microsoft Excel .......................... 168-169, 173
Microsoft Outlook .......................... 162-165
Microsoft Word .......................... 144, 152
Mozilla Firefox .................................. 204
Mozilla Firefox and Internet Explorer .................................... 199
OpenOffice Writer .......................... 152
scrolling ......................................... 215
training ......................................... 247
web applications .......................... 182
Web applications .................................. 176
windows control .................................. 210
compound words
joining by voice .................................. 132
context
showing commands for current .................. 265
controlling .................. 63, 194, 213, 224-225
applications .................................. 210
DragonBar .................................. 63
Internet Explorer .................................. 194
menus ......................................... 213
the mouse .................................. 224-226
windows ......................................... 210
Copy command .................................. 125
copying ......................................... 262-263
using Direct Editing .................................. 104
using multiple text matching .................. 106
copying Vocabularies .................................. 261-262
Correcting text .................................. 79, 100, 125
by spelling .................................. 82
correction list .................................. 79
deleting text .................................. 125
handling multiple text matches ........ 104, 106
methods .................................. 96
quick reference .................................. 100
using Direct Editing .................................. 104
using multiple text matching .................. 106
when incorrectly selected .................. 123
workflow .................................. 96
Correction-only mode (definition) ........ 272
Correction menu .................. 43, 45, 101
choosing correct text in .................. 101
hot key for opening .................. 45
Correction menu (definition) ........ 272
creating .................................. 253, 262
new Vocabularies .................................. 253, 261
currency .................................. 84
dictating .................................. 84
cursor
moving back to last location .................. 118
moving the insertion point .................. 114
moving to specific words .................. 117
custom words
definition .................................. 272
Customer Service and Support ........ 51
customer support ........ 51
Cut command .................................. 125
cutting
using Direct Editing .................................. 104
using multiple text matching .................. 106
D

Data Collection (definition) .................................. 272
Data Distribution Tool (definition) ......................... 273
dates
  dictating ..................................................... 84
Default Installation directories .......................... 30
Default Installation folders ................................. 30
deleted words
  restoring to your Vocabulary ............................. 256
deleting .......................................................... 256, 261
  characters, words, lines, paragraphs ................. 126
last words you dictated ..................................... 125
text ............................................................... 118, 126
text (replacing what you last dictated) .................. 118
using Direct Editing ......................................... 104
using multiple text matching .............................. 106
Vocabularies .................................................. 261
words from the Vocabulary ................................ 256
Desktop
  commands .................................................. 210
dialog boxes .................................................. 214
controlling by voice ........................................ 213
selecting tabs by voice .................................... 214
dictating
  basic techniques ......................................... 77
dictating the word "select" ................................. 123
e-mail and Web addresses ................................. 157
in Excel with Full Text Control ......................... 168
Military time ................................................ 237
numbers ....................................................... 84
time .............................................................. 237
dictating text in non-standard windows ............... 88
dictation ......................................................... 45, 49, 77, 80, 84, 96, 157
correction workflow ........................................ 80
Dictation Box .................................................. 96
forcing recognition of ...................................... 45
hot key for ...................................................... 45
resuming ......................................................... 118
source (microphone) ......................................... 67
source (recorder) .............................................. 67
starting .......................................................... 49
switching modes .............................................. 245
switching to Dictation Mode .............................. 245
using Dictation Mode ........................................ 243
Dictation
  Dictation mode (using) ..................................... 243
Dictation Box .................................................. 88
  about .......................................................... 88
  commands .................................................... 88
Dictation Box (definition) .................................. 273
Dictation Mode (definition) .............................. 273
Dictation Source (definition) ............................ 273
digital audio recorder
  using with Dragon ........................................ 68
Direct Editing commands
  using ........................................................... 104
Direct Editing commands (definition) ................. 273
directories
  Dragon default ............................................. 30
disambiguation
  formatting or editing multiple words ................. 106
documents
  opening ...................................................... 208
selecting lines and paragraphs in .................. 122
switching between ................................. 217
Don’t recognize that word
using .............................................. 256
DRA files (definition) ............................... 270
dragging
the mouse ........................................ 226
the mouse pointer ................................. 228
Dragon
exiting ............................................. 63
system requirements .............................. 18, 42
Dragon Accuracy Center (definition) ........... 270
Dragon Learning Center ......................... 43, 45, 71
using ............................................... 45, 71
Dragon Sidebar
tabs ............................................... 74
Dragon Templates with Voice Fields
(definition) .......................................... 274
Dragon Voice Shortcuts
definition .......................................... 274
Desktop searches ................................. 216
e-mail and calendar commands ............... 158
Web searches ..................................... 195
Dragon Web Extension
about ............................................... 176
browser requirements ............................. 176
determining whether enabled .................... 182
installing and enabling ............................ 177
troubleshooting .................................... 190
DragonBar ......................................... 53, 60
about ............................................... 53
controlling by voice ............................... 63
modes .............................................. 63
using ............................................... 60
DragonPad ......................................... 64, 94
about ............................................... 94
starting by voice .................................. 63
DragonPad (definition) ............................. 273
E
e-mail .................................................. 155
and calendar commands ......................... 158
dictating addresses ............................... 157
supported applications ......................... 155
working in ........................................ 155
e-mail basics ...................................... 43
editing
resuming dictation ................................. 118
ing text
revising multiple instances of words .......... 106
Electronic Medical Records restriction ....... 50
EMR restriction .................................... 50
Enter key
adding new lines by voice ....................... 132
errors ............................................... 79, 82, 100
correcting .......................................... 79
correcting by spelling ............................ 82
correction (quick reference) ....................... 100
Excel .............................................. 168-169, 173
basic spreadsheet commands .................... 169
commands for ...................................... 168-169, 173
formatting text .................................. 173
scrolling in ........................................ 139
working with ...................................... 168
working with content ............................ 173
Exit
Dragon ........................................... 65
exiting
programs ................................... 208
exporting
Vocabularies .............................. 262
extensions
Dragon Web Extension .................. 177

Field (definition) .......................... 274
files
default directories .......................... 30
Firefox
commands .................................. 199
switching between frames ............. 199
five ............................................. 43
folders
default setup .............................. 30
opening ..................................... 211
fonts
setting face, size, and style .......... 131
formatting
all caps ....................................... 105
applying to multiple words .......... 106
Auto-Formatting .......................... 232
bold ........................................... 105
commands .................................. 128
in Microsoft Excel ....................... 173
italics ......................................... 105
multiple instances of words .......... 106
numbers ..................................... 130
text ........................................... 128
text in Microsoft Word ............... 152
underlining ............................... 105
fractions
dictating ...................................... 84
frames
switching
Internet Explorer and Firefox 199
Full Text Control (definition) ........ 274
Full Text Control indicator .......... 59

General Training
running again .............................. 249
Global Commands ....................... 265
Go Back command ....................... 118
Go to
and "Move to"commands
quick reference 114
commands ................................. 117
Google
searching with I'm Feeling Lucky ...... 195
Google Desktop
using voice commands with ........... 216

handheld or smartphone
using as recorder .......................... 68
handling multiple text matches ....... 106
Help
using by voice ............................. 44
Hidden Mode (definition) .............. 274
hot keys ...................................... 45
hyphenating words ....................... 132
icons
   selecting and opening ......................... 215
importing ........................................ 261
Vocabularies ...................................... 261
improve my accuracy ............................. 230, 240
Include Global button ........................... 266
increasing accuracy .............................. 254-255
inserting text ...................................... 114, 117
insertion point ..................................... 114, 117
Insertion point
   moving ........................................... 114, 117
installation
   default directories ............................. 30
Installation and profile creation ............... 17
Installing Dragon to a custom location ......... 18
Internet Explorer ................................ 194, 204
   and Firefox commands ......................... 199
   commands ...................................... 199
controlling by voice .............................. 194
switching between frames ........................ 199
italics ............................................. 129, 131
   applying ........................................ 128
   applying with Direct Editing .................. 104
   applying with multiple text matching ...... 106
   applying ...................................... 131
Joining words .................................... 132
Keys
   controlling the keyboard ....................... 222
pressing by voice ................................ 222
   keystrokes ...................................... 222
   sending by voice ................................ 222
Language model .................................. 250, 253
   modifying ...................................... 250, 253
   optimizing ...................................... 240
Language Model optimization (definition) ..... 275
Language Model Optimizer (definition) ........ 275
Learn From Sent E-mails tool ..................... 254
   Start ............................................ 254
Learning Center
   showing and hiding ............................. 45, 71
   using ........................................... 45, 71
Learning from specific documents ............... 252
left aligning text ................................ 131
lines .............................................. 132
   adding new .................................. 132
   selecting ..................................... 122
list boxes ........................................ 214
   controlling by voice .......................... 213
   scrolling in by voice .......................... 215
Listing
   open Dragon windows ......................... 217
   open windows .................................. 217
Mail .............................................. 155
   supported applications ...................... 155
   working in .................................... 155
Making appointments
   Microsoft Outlook .............................. 163
medical records
electronic (restriction) ..................... 50
menus ........................................ 213
controlling .................................. 213
hot key for Dragon ......................... 45
microphone .................................. 45
hot key for .................................. 45
multiple dictation sources ............... 68
positioning handheld ..................... 68
positioning headset ....................... 68
Microsoft
Outlook E-mail and Calendar commands .......................... 158
Microsoft Excel ................................ 168-169, 173
   basic spreadsheet commands .......... 169
   commands for ............................ 168-169, 173
   formatting text .......................... 173
   scrolling in ................................ 139
   working with ............................. 168
   working with content .................. 173
Microsoft Office
   scrolling in ................................ 139
   using the ribbon ........................ 140
Microsoft Outlook .......................... 162-165
   adding contacts ......................... 164
   commands for ............................ 162-165
   Email and Calendar commands ....... 158
   making appointments .................. 163
   reading and sending e-mail .......... 162
   scrolling in ................................ 139
   working with ............................. 162
   writing notes ............................ 165
Microsoft PowerPoint
   scrolling in ................................ 139
Microsoft Windows
   system requirements .................... 18, 42
Microsoft Word ............................. 144, 152
   basic document commands ............ 144
   commands for ............................ 144, 152
   formatting text .......................... 152
   selecting text in ......................... 152
   working with ............................ 144
Military time ................................ 237
minimum system requirements .......... 18, 42
misrecognized commands ................ 102
mobile device
   choosing a speech device .............. 67
modes
   recognition
      definition 276
      using 243, 245
   recognition (using) ...................... 243
mouse
   clicking .................................. 226
mouse pointer ............................. 224-225
   dragging ................................. 226
   moving .................................... 224
   moving with MouseGrid ................. 225
MouseGrid .................................. 225
   using to position the mouse pointer ... 225
Move to
   commands ................................ 117
moving ........................................114, 224-225
around a document
quick reference 114
the cursor ..................................114, 117
the mouse pointer .......................224
the mouse pointer with MouseGrid ...225
to the beginning or end of a document or line .........................117
Mozilla Firefox
commands .....................................199
switching between frames ............199
multiple text matches
correcting and editing ...............106
Multiple text matching commands
applying to multiple words ..........106

N
naming ..............................................261
Vocabularies ..................................261
Natural Language Commands ....51, 142
definition .......................................275
navigating .......................................213-215
between windows .......................212
buttons and dialog box options ....213
going back to your last location ......118
icons ............................................215
in documents ................................117
menus .........................................213
opening programs and documents ..208	
tabs in a dialog box .....................214
Web applications commands ........176
Windows Desktop commands ..........210
new words .....................................250, 253
adding a list of to the Vocabulary ....18
adding to the Vocabulary ...............250
adding with the Spelling window ....253
Non-standard (definition) ..........277
Non-standard windows ..............88
dictating text in .........................88
Normal Mode ..................243, 245
switching to .........................245
using ........................................243
Normal Mode (definition) ..........275
Nothing But Speech (definition) ....275
numbers .................................84, 130
changing format ......................130
dictating .................................84
forcing recognition of ............84
Numbers Mode ..................244-245
switching to .........................245
using ........................................243
Numbers mode (definition) ..........275

O
Office
scrolling (in Microsoft) ..........139
using the ribbon .....................140
Office ribbon
using Microsoft .....................140
online Help
opening and using by voice ........44
opening
a different Vocabulary ..........259
icons by voice .......................215
menus ....................................213
programs (and exiting) .................. 208
the Command Browser .................. 265
OpenOffice.org Writer
commands for .................................. 152
selecting text in .................................. 152
optimizing
   acoustics and language model ............ 240
Outlook ........................................... 162-165
   adding contacts ......................... 164
   commands for ............................. 162-165
E-mail and Calendar commands ........... 158
making appointments ...................... 163
reading and sending e-mail .............. 162
scrolling in ..................................... 139
working with .................................. 162
writing notes .................................. 165

P
paragraphs ........................................ 132
   adding new ................................. 132
   selecting .................................. 122
Paste command ................................ 125
Performance Assistant (definition) ...... 275
personalizing Vocabularies .............. 250, 253
phrases
   correcting and editing multiple
      matches .................................. 106
pointer ........................................... 224-225
   moving with mouse commands ........... 224
   moving with MouseGrid ................. 225
positioning
   text in a document ....................... 131
 postal codes ..................................... 233
dictating ........................................ 84
postcodes ....................................... 233
PowerPoint
   scrolling in .................................. 139
Press <key> command ....................... 222
Press <key> command (definition) ........ 275
programs
   exiting ........................................ 208
   starting ..................................... 208
   switching ................................... 210
   switching between open programs
      and windows ........................... 217
Q
Quick Voice Formatting commands
   (definition) .................................. 273
QuickStart (definition) ..................... 276
R
Read text to train Dragon to your voice .... 249
reading and sending e-mail
   Microsoft Outlook ......................... 162
   Windows Live Mail ....................... 160
recognition ................................... 230, 238, 240
   accuracy ..................................... 230, 240
      improving .............................. 230
      using the Speed vs. Accuracy slider 238
   accuracy: improving ..................... 230, 240
   modes ........................................ 243
      using ................................. 243
recognition errors ......................... 79, 82, 100
   correcting by spelling ................... 82
   correction (quick reference) ........... 100
recognition modes .............................. 276
switching ....................................... 245
using ............................................. 243
recommended system requirements .......... 18, 42
removing ....................................... 128, 132, 256, 261
spaces between words ......................... 132
text formatting .................................. 128
Vocabularies ..................................... 261
words from the Vocabulary .................. 256
renaming ........................................ 261
Vocabularies ..................................... 261
requirements
minimum and recommended system for Dragon .......... 18, 42
resizing windows ................................ 214
restoring ........................................ 128
plain text ....................................... 128
Results Box (definition) ....................... 276
Results display (definition) .................... 276
resuming dictation ............................. 118
resuming editing .............................. 118
revising text .................................. 110, 118, 125
deleting text .................................. 125
quick reference ............................... 110
replacing what you last dictated ............... 118
revising multiple instances of words .......... 106
ribbon
using Microsoft Office ....................... 140
right aligning text ............................ 131
Roman numerals
dictating ....................................... 84

S
Sample Commands
using ............................................ 45, 71
Say What You See (definition) ................ 276
Scratch That command ........................ 125
Scripting (definition) ......................... 277
scrolling
in Microsoft Office programs ................ 139
in popular programs .......................... 139
in windows and lists .......................... 215
searching
the online Help by voice ..................... 44
the Web ........................................ 195
your Desktop .................................. 216
Select Again command ....................... 123
selecting ....................................... 213-215
buttons by voice .............................. 213
icons by voice ................................. 215
menus .......................................... 213
tabs in a dialog box ........................... 214
selecting text .................................. 120-121, 123
again .............................................. 123
characters and words .......................... 123
correcting incorrectly selected text .......... 123
handling multiple text matches .............. 104, 106
in Microsoft Word ............................ 152
in OpenOffice.org Writer .................... 152
lines and paragraphs ........................ 122
quick reference ............................... 120
specific words ................................. 121
using Direct Editing .......................... 104
using multiple text matching ................. 106
set up
  default directories .................................. 30
sharing ................................................. 261-262
  Vocabularies with other people .................. 261-262
shortcuts
  see Dragon Voice Shortcuts
    (definition) ........................................ 274
Shortcuts
  Dragon Voice, Desktop searches ............ 216
  Dragon Voice, e-mail and calendar
    commands ............................................ 158
  Dragon Voice, Web searches .................. 195
Sidebar
  tabs ................................................. 74
sites
  searching .......................................... 195
size
  setting font ..................................... 131
Smart Format Rules
  disabling display ................................ 232
  using .............................................. 232
spaces
  removing between words ......................... 132
special folders
  opening .......................................... 211
speech device
  choosing .......................................... 67
speed .................................................. 238
  increasing recognition ........................... 238
Speed vs. Accuracy slider ....................... 238
Spell Mode .......................................... 244, 246
  switching to ...................................... 245
  using .............................................. 243
Spell Mode (definition) ............................ 277
Spelling window ..................................... 81, 101, 253
  adding words ..................................... 253
  choosing correct text in ......................... 101
  typing the correct text into .................... 81
Spoken Form (definition) ......................... 277
Start menu, using ................................... 208
starting programs ................................... 208
supplemental training ................................ 249
support
  technical ........................................... 51
  switching .......................................... 259
    between open programs and windows ............ 217
    between windows ................................ 210
    to a different Vocabulary ...................... 259
system requirements ................................ 18, 42
T
tabs ...................................................... 214
  selecting in a dialog box ....................... 214
technical support .................................... 51
telephone numbers .................................. 84, 236
  dictating .......................................... 84
text ..................................................... 100, 125-126, 128, 131
  aligning .......................................... 131
  capitalizing ...................................... 129
  correcting ........................................ 79
  correcting (quick reference) .................... 100
correcting and editing multiple matches .................................. 106
cutting and pasting ......................................................... 125
deleting ................................................................. 126
formatting ................................................................. 128
selecting ................................................................. 120, 152
Text Control indicator ................................................... 59
Text Control Indicator (definition) .................................... 278
text wrapping ............................................................. 94
The recognizer has encountered an utterance that is too long to process .............................................. 239
time ................................................................. 86
dictating ................................................................. 84
Tips
in the Learning Center ........................................... 45, 71
using word processors ........................................... 142
Top 5 Ways ...................................................................... 43
training ...................................................................... 247-248
additional ................................................................. 249
commands ................................................................. 247
supplemental ................................................................. 249
training individual words and phrases ...................................... 248
Tray Icon only mode ..................................................... 64
troubleshooting
with Dragon Web Extension ........................................... 190
Type <key> command .................................................... 222
Upgrading to Windows 7 or Windows 8 .......................... 18
User Profiles
  creating recorder-based ........................................... 67
default directories .................................................... 30
using online directories ............................................. 44
utilities
  starting ................................................................. 211

V
variants
  correcting or formatting variants .................................. 106
Vocabularies ......................................................... 250, 253, 260-261
  adding ................................................................. 260
  adding individual words to ........................................... 251
  base ................................................................. 271
  creating new .......................................................... 253, 261
  deleting ................................................................. 261
  exporting ................................................................. 262
  importing ................................................................. 261
  opening ................................................................. 259
  personalizing ......................................................... 250, 253
  renaming ................................................................. 261
  restoring words to ................................................... 256
  sharing with other people ...................................... 261-262
  types of ................................................................. 258
voice commands
  Dragon Sidebar ......................................................... 74
Voice Shortcuts
  Desktop searches ..................................................... 216
e-mail and calendar commands .................................... 158
Web searches ............................................................. 195

U
UK postcodes ............................................................. 233
underlining ................................................................. 129
  applying with Direct Editing ...................................... 104
  applying with multiple text matching ......................... 106
undoing actions ........................................................... 78
Index

W

Web ........................................... 157, 194, 204
  applications ...................................... 176
  browser compatibility .......................... 176
  commands ....................................... 176
  controlling Internet Explorer .............. 194
  dictating addresses ............................ 157
  Firefox commands ............................. 199
  Internet Explorer commands .............. 199
  Mozilla Firefox commands .............. 199
  searching ........................................ 195
  searching by voice ............................ 195
  switching between frames .................. 199

Web application support (definition) ....... 278

web basics ...................................... 43

web browsers
  installing the Dragon Web Extension ... 177
  requirements for the Dragon Web Extension .......... 176

windows
  navigating between ........................... 212
  switching between open programs and windows .......... 217

Windows
  controlling ..................................... 210
  Desktop commands ............................. 210
  moving in ....................................... 215
  open special folders .......................... 211
  resizing and closing .......................... 214
  scrolling in by voice ........................ 215
  switching between ............................ 210
  system requirements .......................... 18, 42

Windows 7
  searching by voice ........................... 216
  working with ................................... 212

Windows Live Mail
  commands for .................................. 160
  reading and sending e-mail ..................... 160

Windows shortcut (definition) ............ 277

Word ........................................... 144, 152
  basic document commands .................... 144
  commands for .................................. 144, 152
  formatting text ................................ 152
  scrolling in .................................... 139
  selecting text in ............................. 152
  working with .................................. 144

word categories
  adding ........................................... 251

word processors ............................... 142
  tips for using .................................. 142

Word Properties
  creating ......................................... 133

Word Properties (definition) .............. 278

words ............................................ 19, 120-121, 132, 250-251, 253
  adding to the Vocabulary ..................... 251
  adding with the Spelling window ............ 253

alternate written forms
  creating .......................................... 133

correcting and editing multiple matches ................. 106

deleting from the Vocabulary .................. 256

formatting ....................................... 104, 106

hyphenating .................................... 132

joining ........................................... 132

restoring to the Vocabulary .................. 256
revising ........................................ 104, 106
selecting ........................................ 120-121
spelling ........................................ 82
word properties
    creating 133
workflow ........................................ 96
    correcting text ................................ 98
working with content
    Microsoft Excel ................................ 173
working with Microsoft Excel .............. 168
working with Microsoft Outlook .......... 162
working with Microsoft Word ............. 144
wrapping
    text ........................................ 94
writing notes
    Microsoft Outlook ......................... 165
Written Form (definition) .................. 279

Z

Zip codes
    dictating .................................. 84